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Editor's note: We have combined the Windows and Macintosh versions of the Manual.  This is 
evident when referring to keyboard keys.  Control on Windows corresponds with Command on the 
Macintosh.  Older Macintoshes referred to the Alt key as Option.  In some cases separate paragraphs 
are written for each operating system. 

This document describes Lime 9.0n.  It has not yet been updated. 
A separate addendum document describes the additional features in 

Lime 9.18 (9.15, or later) and any interface changes. 
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What's New in Version 9.15 (9.17) 
Main changes from 9.0x (amongst over 1000 enhancements and fixes) are: 
• New file format to support the new annotation anchoring capabilities.  The new format can be 

read and converted back to the previous format by 9.14.9 but not anything earlier. 
• New, flexible annotation anchoring capabilities, including bar lines and the right of the page.  

Also supports right justified text. 
• Right-Click replaces Alt-click for selecting and manipulating annotations.  Alt-click is still 

needed for the ‘Extended Alt-Click’ option.  N.b. on Macs, Ctrl-click is tantamount to a right-
click. 

• Command-period (Ctrl-period on windows) replaces command/ctrl-H for invoking the hear 
option.  However, if you want, you can still set command/ctrl-H as a short cut. 

• Major improvement in MusicXML import.  However, export is still very basic. 
• Batch update facility, enabling multiple files to be updated to the new format or to be changed 

to templates. 
• Truly high quality printing on Intel Macs (without postscript). 
• New backslash expressions for editing annotations; includes \>> and \<< which replace \1 and 

\2 which are now used for MARL numeric symbols. 
• Ctrl-Alt-letter is now available on Windows to provide 26 additional user settable short-cuts.  

On Macs, Command-Alt-letter replaces Ctrl-letter. 
• On Macs, pressing Ctrl while selecting a menu item can be used instead of Shift (this replaces 

the use of Alt, which is no longer available). 
• White on Black and Black on Yellowy display options. 
• Improvements to Lime Lighter, including full screen display, ticker tape & autocue contexts, 

automatic scrolling, go to bar touch screen navigation, and a Low Vision parameter template 
set for display. 

With the exception of annotation anchoring, the use of Lime 9.15 and later is by and large upwards 
compatible with earlier versions. 

This document has not yet been updated to 9.15 or later 

Please see the Documentation Addendum for a description of all changes and new features, etc. 
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What You Need to Run Lime™ 
Lime 9.15 – 9.17 will run on all IBM compatible machines that will run Windows™ 2000, XP, 
Vista, 7, 8 and 10/11.  After 9.17, support for Windows 2000 is deprecated. 

Lime will run on all computers that run Macintosh® software using OSX version 10.4 (Tiger) or 
later; it has been tested up to Mojave (10.14).  Lime will run on 10.8 (Mountain Lion) and later, but 
is not yet signed; however you can bypass the initial Gatekeeper check by right clicking on the Lime 
application and choosing the "Open" command.  Once it has been opened one time, Gatekeeper no 
longer has any control over it.  

Apple have announced that the last system to support 32 bit applications, such as Lime, is MacOS 
10.14 (Mojave).  If you wish to continue using Lime, 

do not upgrade to MacOS 10.15 or later. 

Some form of MIDI synthesizer is required (to make sound), either the internal, software synthesizer 
that should be available on all systems that support Lime, or an external synthesizer. 

A MIDI keyboard (even just a little, simple one) is recommended for use with Lime, but is not 
essential.  

Clearly a good quality printer is needed for high quality output.  On Macintoshes, PDF files can be 
created using the standard print facilities; on Windows, a 3rd party tool, such as DoPDF 
(https://www.dopdf.com) or Adobe’s Acrobat is needed to create PDFs. 

This manual assumes you are familiar with Windows™ or Macintosh®.  It assumes you know how 
to use the mouse and know what “click,” “double-click,” “right-click1,” “Shift-click,” “Alt-click” 
(on older Macs, “Option-click2

 

”), and “click-drag” mean.  It also assumes you know how to use 
menus; in this manual, a phrase such as “using menu Main->Sub’ means use Sub from menu Main. 

                                                

1 Note that, on Macintosh® systems, Ctrl-click has the same effect as Right-click. 

2 Throughout this manual, “Alt-click” is always used. 

https://www.dopdf.com/�


Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 14 of 206 

How to Install Lime™ 

How to Install Lime™ for Windows™ 

Copy the Lime self-extracting archive (Lime9xxx-win.exe, where 9xxx represents the version 
number, e.g.  Lime9160-win.exe) to the hard drive. 

Expand Lime9xxx-win.exe by double clicking on its icon.  

This will create a folder (the default folder is the folder from which it is run) containing the Lime 
Manual and the Lime program with all its associated folders, fonts and files.  Note that on Vista or 
later, you will need administration capabilities to install into C:\Program Files or, (on a 64 bit 
system, as Lime is a 32 bit program) C:\Program Files (x86); a suitable alternative is the  
AppData\Local\Programs  folder in your account.  It is recommended that it is installed into 
C:\Program Files\Lime\ or equivalent as that will be the location used by a future automatic installer. 

The Marl and Tufa fonts should be in the same directory as the executable Lime file.  Leave all 
these files together in one directory.  If you have administration capabilities, it is recommended that 
these fonts also be installed so that they can be used by other programs. 

After you are done, LimeInstall9xx.exe is no longer needed. 

To add Lime to the Start menu, first locate the Lime.exe file and drag it onto the Start button 
(typically, C:\Program Files\Lime\Lime 9.xx\Lime.exe).  You can also create a shortcut by creating a 
short-cut to the Lime.exe file on the desktop.  

Use the MIDI Input and MIDI Output menus under the Hear menu to choose the appropriate 
MIDI devices, whether internal or external.  
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How to Install Lime™ for Macintosh OSX 

Copy the Lime archive (Lime9xxx-osx.zip, where 9xxx represents the version number, e.g.  
Lime9160-osx.zip) to the hard drive. 

1) Extract the Lime files.  Lime is stored in a compressed file called Lime9xxx-osx.zip (where 9xx 
represents the version number).  Double-click on Lime9xxx-osx.zip and it should be expanded 
automatically into a local folder.  Copy this folder to /Applications or wherever you want to run 
it from.  It is recommended you copy it to /Applications/Lime™/Lime™9.xx as that will be the 
location used by future automatic installers. 

2) Install TrueType fonts.  It is recommended that the Marl and Tufa fonts are installed by double 
clicking the Marl.ttf and Tufa.ttf files to install them (into your ~/Library/Fonts folder).  This is 
not essential as they are also embedded in the application; however installing them makes them 
available to other programs. 

3) Configure  MIDI.  Use the MIDI Input and MIDI Output menus under the Hear menu to 
choose the appropriate MIDI devices, whether internal or external; the default output device will 
be QuickTime. 

High quality printing is supported on all Macintosh® systems, whether Intel or PowerPC.  OSX’s 
print facilities support creating PDF files directly3

 

. 

Apple have announced that the last system to support 32 bit applications, such as Lime, is MacOS 
10.14 (Mojave).  If you wish to continue using Lime, 

do not upgrade to MacOS 10.15 or later. 

 

                                                

3 Even on PowerPC Macs, the old convoluted technique of post-processing post-script files is not necessary; you can 
create PDFs whether or not PostScript printing is used. 
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Using Midi Synthesizers 

Some form of MIDI synthesizer is required (to make sound), either an external one or an internal, 
software synthesizer that should be available on all systems that support Lime: 

Windows users: Microsoft’s Wavetable provides a basic synthesizer. 

Macintosh users: Apple’s QuickTime provides a basic synthesizer. 

 

If you have problems with an external MIDI connection: If you have real MIDI cables, rather 
than USB, check the cabling to your synthesizer, and check synthesizer settings.  The “out” cord 
should be connected to the synthesizer MIDI In.  The “in” cord should be connected to the 
synthesizer MIDI Out.  Make sure you have MIDI Transmit enabled on your synthesizer.  Make sure 
your synthesizer's Receive Channels are set properly.  If you select Local Control Off on your 
synthesizer, you will need to select Make Sound for MIDI Input in Preferences under Lime's Edit 
menu. 
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Part I: Getting Started 

A Step-by-Step Example 
To teach you how to use Lime, this manual will begin with instructions for opening and editing a 
simple piece, the first four bars of “Lullaby of Birdland” (B.  Y.  Forster, George Shearing) shown 
below.  You will want to read this manual as you sit at your computer, so you can follow the step-by-
step instructions given here. Blind users who use the Lime Aloud access method should refer to the 
step-by-step example given in the Lime Aloud Guide which installs with Lime Aloud.  
 

 

For this example we will use a Template (Stationery Pad), which is a document that has all the 
parameters set (such as number of voices, layout, titles), but contains no music; when opened a new 
document is created.  If you would like to create a piece from scratch, see Creating a New Piece 
below. 

Open the File 
- Either navigate to the “Stationery folder” and double click on the file “First Piece.lim”; 
- Or launch Lime, invoke menu item select Open Template under the File menu, navigate to the 

stationery folder and double click on the file “First Piece.lim”. 

You will see a blank page with a title, staff, key, and blank measures.  

A Template is simply a starting point for a new piece.  You may want to make some initial changes 
to accommodate the piece you are working on.  In this example we will enter a melody in the key of 
A-flat.  To insert a key signature of four flats, click on the first rest in the piece (it will flash), then 
select Key Signature under the Symbol menu.  Specify four flats and click OK.  

It is possible to create your own template copies of layouts that you use often.  If, for example, you 
plan to do a series of melodies in A-flat major, you can save this newly modified file as 
“Single Voice-A-flat Major.lim” and use it as a template.  Many users find it useful to set up a layout 
with all the voices, instrument names, staff arrangements, format, numbering format, etc., but no 
music.  When saved as a template (File->Save as Template…), the file is then a “Template” to be 
used over and over, but saved as a separate file after music has been entered (a result of this exercise 
can be found in  Examples\from FirstPiece.lim). 

Mac users: Though the “Stationery Pad” capability also works (use the Finder to select the new file, choose Get Info 
under the File menu and check “Stationery Pad”), it is not required. 
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Note Entry 

Before entering notes you must identify the edit point or insertion point.  In this example we will 
begin entering notes in the first measure: Double click on the rest in the first measure or choose Note 
Entry (under the Voice menu).  A flashing box should appear around the rest.  This is called a “note-
entry cursor.”  

At the bottom of the screen is the “Piano Window.” It has a drawing of a piano, plus a rest bar and 
other symbols.  (The Piano Window may be relocated by dragging the lower right-hand corner.  In 
these examples the Piano Window has been relocated just below the music to conserve space.)  This 
piano can be used with the mouse if you do not have a MIDI keyboard.  Before you click on a piano 
key, choose the note value you need by clicking on the appropriate symbol just below the piano.  For 
this example we will use an eighth note.  (Clicking again on the eighth note symbol will select a 
dotted eighth; a third click gives a doubly dotted eighth.)   

 

 

The middle C key on the screen is specially marked4.  Now click on the C key above the middle C 
and watch the screen.  After a short time5

 

 the display will show your eighth note C, followed by an 
eighth rest and three beats of rest and then three more measures of rest.  The note-entry cursor has 
moved to the eighth rest. 

                                                
4 This mark will move when Keyboard Shift is used.   
5 On 21st century machines the update time is negligible.  On older, slow systems, at first, you may see the mouse cursor 
momentarily turn into an arrow-watch (Windows) or a hollow arrow (Macintosh) to indicate that the screen is not up-to-
date yet, and the four-measure-rest symbol turn gray, to indicate that it has been changed. 
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Now play the rest of the notes for Lullaby of Birdland by clicking6

You can replace a wrong note by double-clicking on it and playing a new note.  If you replace a half 
note with a quarter note, then you will also get a quarter rest.  Similarly, if you replace a quarter note 
with a half note, then the quarter note and the quarter note after it will be replaced. 

 on the Piano Window.  When 
you get to a quarter note, remember to click the quarter note symbol in the piano window; then, after 
you play the quarter note remember to click the eighth note symbol before you go on.  (The next note 
will be an eighth note.) 

If you want to delete a single note, click on the note, and hit the Delete key.  It is possible to select a 
group of notes and delete them (see Note Group Select below), but if you intend to replace the notes 
with new music it is just as fast to enter the new music over the existing notes.  

In this little sample piece we don't have any chords.  You can play chords with the mouse by clicking 
on all the notes in the chord while holding the Shift key.  It is much easier to use a MIDI keyboard if 
you have one.  In this case, simply play all the notes in the chord simultaneously.  A single voice can 
contain a chord with any number of notes.  A chord on a single staff can be the result of several 
voices, one note per voice, or a single voice containing chords.  

The next pitch in the example is an eighth note tied to a quarter.  There are two methods for adding 
ties, slurs, dots, accents, etc.; selecting the symbol before entering the note, or using the Edit Cursor 
to add the marking after entering the notes.  We will demonstrate the first method here.  

To enter the tied eighth, first click on the “tie” in the piano window.  Check to make sure the eighth 
note symbol is still selected.  If not, select it.  (Do not select it again.  This will change it to a dotted 
eighth; a common error among beginning users.) Click on the D-natural.  It is not necessary to select 
the natural symbol in the piano window.  Lime will enter the pitch with the correct accidental.  (Use 
the accidental symbols to force an accidental other than the default, or to change to an enharmonic 
pitch such as A-flat instead of G-sharp.)  

                                                

6 Entering notes with the mouse as described here is the easiest and most intuitive method, but it is also the slowest.  
Using the computer keyboard, Piano Window Keys or a MIDI piano keyboard, are described below.   
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The tie is deselected automatically, but you must select the quarter symbol before entering the next 
quarter note D-natural.  Enter the eighth F and E-natural tied to the quarter E-natural.  To enter the 
eighth rest, first select an eighth duration by clicking on the eighth symbol.  Then click on the rest 
symbol at the end of the piano keyboard drawn on the screen or on the narrow gray strip just below 
the keys on the piano.  For more details, see the Piano Window section below.  

Edit Cursor 

When you have finished entering all the music, you can return to the “edit cursor” (single note 
flashing) by clicking (single click) on any note or by deselecting Note Entry (under the Voice 
menu).  With this cursor you cannot enter new notes, but you can change the appearance of piece by 
adding slurs, ties, dots, keys, clefs, time signatures, etc.  Any of the items in the Piano Window and 
any item in the menus that are not gray are available for editing when using the edit cursor.  Most 
editing features that are available with the edit cursor are also available with the note entry cursor. 

Position the edit cursor on the quarter note F.  Click on the accent symbol in the piano window to 
add an accent.  

Note Group Select 

Lime provides a “Note Group Select” feature that allows you to select and manipulate a group of 
notes.  Normally, just one note or rest is selected, and it flashes continually.  When Note Group 
Select is used, a whole set of notes is selected; the selected notes are highlighted.  Go to the 
beginning of the piece, and select all the notes in the first measure by dragging the mouse (click and 
press the mouse button as you drag the mouse).  

When you complete the drag and let up the mouse button, the notes are highlighted and the music 
symbol at the bottom left of the screen will be gray.  To select additional notes (add more notes to 
the selected group) use the Shift key while dragging a box around the new notes.  Go to the second 
measure in the piece, and select three more notes by Shift-dragging.  These notes are selected in 
addition to those notes you already have selected.  (If you Shift-drag around notes that were already 
selected, they are deselected.  If you drag over new notes without pressing the Shift key, those notes 
will be selected and the previously selected notes will be deselected.) Do not select the quarter note 
E-natural.  
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Now click on the word “slur” in the Piano Window.  Note that the final E is included in the slur.  
This is because a slur extends from the selected note to the next note.  For this reason, when adding a 
slur, you must not include the last note to be contained under a slur.  Click on the staccato symbol in 
the Piano Window; this makes all the selected notes staccato; click again for staccatissimo.  Select 
Stem up or Stem down (or No Stem) under the Stem menu.  Any of the symbols in the Piano 
Window that are not shaded and menu items that are not gray may be applied to the selected notes.  
A selected group of notes can also be deleted by hitting the Delete key. 

To end Note Group Select, just click on a single note in your music; this will select just that note, 
and end Note Group Select.  Finally, to get rid of the staccato dots you just added, Note Group 
Select the same notes, and click on the staccato symbol to remove its shading; then click on one of 
your notes to end Note Group Select again.  You can also use Undo (under the Edit menu) to 
remove the markings.  In fact, you can continue choosing Undo to revert back to the beginning of the 
editing session. 

Piano Window Shading and Menu Check Marks 

Lime shows which edits have been applied to each note with a dark shading in the Piano Window 
and a check mark in the menus.  Click on just one of the notes you have just changed then one of the 
notes that has not been changed and notice how the shading in the Piano Window changes.  Click on 
the Stem menu and notice the check marks on each of the notes.  When a group of notes are selected 
and there is a mix of edit options (in the example above some notes have ties, some do not, some 
have accents, others do not), the Piano Window item is shaded, not dark.  The menu item has a 
grayed check (Windows) or dash (Macintosh) rather than a regular check. 

If you need to change the length of individual notes you should reenter the music using the correct 
note lengths.  If you select Enable Duration Edits (under the Edit menu), it is possible to change 
the value of the note indicated by the edit cursor (including tuplets) by clicking a length in the Piano 
Window.  This operation is available for correcting errors in scanned music, imported MusicXML or 
in or imported MIDI files.  It should not be used when doing standard copy since the length of the 
measure is changed along with the note length.  Conflicting measure sizes will result, particularly in 
multiple voice works, if this option is used incorrectly. 

If you select Enable Duration Edits, the Kill symbol is also used to correct errors in scanned music.  
It removes unwanted notes without preserving the size of the measure.  Likewise, Kill should be used 
with care or conflicting measure sizes will result.  Normally the Delete key is used to replace notes 
with rests.  

Adding Lyrics 

Now click on the first note in the piece.  You may have to use the scroll bars to bring the first note 
onto your screen.  

There are four symbols at the left of the Piano Window.  The top symbol is for entering music, the 
bottom three are for various kinds of annotations: text (and other symbols found in fonts), lines, and 
curves.  Select Text (under the Annotation menu) then Lyric.  This will highlight the text symbol 
(letter A) at the left of the Piano Window; this allows you to type lyrics under your note. 
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Now type the word “Lull-” (include the hyphen).  It will appear underneath the first note.  Then press 
Tab to move to the next note.  Type "a-", press Tab, then type "by".  Continue to type the lyrics 
using Tab7

If you make a mistake, select the incorrect lyric by pressing Right-clicking near the beginning of the 
lyric.  Then use Clear Annotation (under the Edit menu) or press the Delete key, and re-type your 
text.  You can also select Previous or Next Annotation (under the Annotation menu) to move 
through annotations for modification.  Similarly you can press Alt (or Option on older Macintoshes) 
and the left or right arrow keys to move between annotations.  

 to move to each new note and typing each part of the lyric underneath each note.  There 
are two useful features already selected in the Annotation, Style menu that will make entering lyrics 
easier.  Center Hyphen centers the hyphen if it is the last character in an annotation.  (So type “la-“ 
and “Bird-” for this example.) And Extend Underline replaces an underscore, if it is the last 
character in the annotation, with a line.  (So type “that’s_” and “I_” under the eighth note D and E.)  

Once an annotation is selected you can hit Enter or Return to position the cursor at the end of the 
annotation for editing.  You can also select a section of the text after it has been selected to delete or 
edit.  When you have finished, click the notes symbol (the top symbol) at the bottom left of the 
screen.  You can also exit Annotation Mode by pressing the Esc key.  For more details on lyrics, see 
the description of Annotation Mode and Annotation menus below. 

If you have two lines of lyrics, you can type the first line for all the notes on the page (using Tab 
between notes); then you can click on the first note, and type the second line for all the notes on the 
page.  

Some users find it easier to use the space bar to advance to the next annotation when entering lyrics.  
There is an option (Preferences under the Edit menu) that will allow you to swap the function of the 
tab key and space bar.  With this preference engaged, the space bar will advance to the next note and 
the tab key will type a space.  

While still in Annotation Mode click on the first note in the example.  Choose Text, Chord Symbol 
under the Annotation menu.  Choosing Chord Symbol has no apparent effect on the annotation 
when they are entered.  But chords that have this designation will automatically transpose with the 
music if you change keys, providing they are well constructed.  

                                                

7 Shift-Tab can be used to go back to the previous note if you inadvertently skipped over it. 
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To reposition the cursor Control (Windows) or Command (Macintosh)-click above the note at the 
position where you want the chord symbol to appear.  Use the Text Assistant (under the Annotation 
menu) and choose Chord Symbol to create each chord.  Use Tab to move to the next note where a 
new chord symbol is used.  It is possible to type in chord symbols without the Text Assistant.  
Special characters such as sharps and flats can be entered using the backslash convention described 
in the sections that follow. 

It is important to remember that each annotation is assigned to a note.  In this example, each lyric 
and each chord symbol should be attached to the note with which it corresponds.  This allows Lime 
to maintain the relationship between the annotation and the note if the note is moved to another 
location, such as the next system. 

You can also change existing annotations; for example the title or tempo markings in a template file.  
You can press Alt and click to select the annotation.  Then position the cursor to delete or change 
existing text.  You can also use Clear Annotation (under the Edit menu) and reenter the title from 
scratch.  

Copy, Paste, and Multiple Paste 

Lime has a variety of copy and paste capabilities.  To copy notes select the notes you want to copy 
with Note Group Select, and use Copy Music (under the Edit menu).  Alternatively, you can click 
on the first note you want to copy and use Copy Measures… (under the Edit menu).  After you use 
Copy Music or Copy Measures… click elsewhere in the piece and use Paste Music (under the Edit 
menu). 

You can use the scroll bars to scroll around the page.  Alternatively, you can press Alt and Control 
(Windows) or Option and Command (Macintosh) while you move the mouse to the edges of the 
music window; this is called “Magic Scrolling.” 

Lime also allows you to copy and paste annotations.  Select the annotation by pressing Alt 
(Windows) or Option (Macintosh) and clicking next to it.  Then use Copy Annotation (under the 
Edit menu).  Now you can click elsewhere in the piece and use Paste Annotation (under the Edit 
menu).  Alternatively, you can do a “Multiple Paste:” select several notes using Note Group Select 
and then use Paste Annotation.  Your annotation will automatically be pasted to all the notes that 
are selected. 

Multiple Paste is an economical method of annotating a large score.  For example, a score may call 
for  throughout a piece.  Start by entering all the notes.  Then, click on the first note which needs a 
, select the text symbol, select 12-point Marl font, type the  (press the 8 key; Marl font charts 
are in the back of the manual), and use Alt-drag to adjust its position.  (You may find it simpler to 
add the trill using the Text Assistant in the Annotation menu, or typing the backslash expression \tr 
in a text font; both these approaches are described later in this manual.)  Once you have the  on the 
first note, you can easily copy and paste it to other notes using Multiple Paste.  Alt-click on the , 
use Copy Annotation, use Note Group Select to select all the other notes on the page that need the 
 symbol, and use Paste Annotation. 
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You will find that proper use of the annotation anchoring (Placement under the Annotation menu) 
will help you make good use of Multiple Paste.  For a , set horizontal anchoring on the note-head.  
Vertically anchor the  as a fixed chord ornament if you want the  to move up and down 
depending on the pitch of the note to which it is pasted, but not overlap the staff.   Alternatively you 
could anchor it to the staff middle if you want the  pasted the same distance from the staff line 
wherever it is pasted. 

Experiment 

After learning the basics of Lime you will probably want to experiment.  Most of the menu items, 
such as Hear, Print, Key Signature, etc., are self-explanatory.  Open each one and read the options.  
If a menu item is unclear, you will want to read about them in the manual.  You might also glance 
through the Hints and Examples section and try to reproduce some of those examples.  It will be 
constructive to experiment for a while before you transcribe your first piece.  As you gain experience 
and become more familiar with the Lime environment, your speed of music transcription will 
increase dramatically. 

When you begin working on your first serious transcription, use Save and Save As (under the File 
menu) frequently.  This way you will be able to use Revert (under the File menu) to go back to the 
most recently saved version of your piece if you make changes you do not like.  It is always a good 
idea to Save just before an operation that may drastically change the look of the piece (such as 
Systems changes, Layout, or Part Extraction).  There is a preferences option to prompt you to save 
before such operations.  

Part Extraction 

Once you have completed a score, you can print out the score using Print (under the File menu).  If 
you also want to print out individual parts, Lime has a mechanism called “notation contexts” to help 
you.  Your piece starts off with only one notation context, the score notation context.  Use Part 
Extraction… (under the Context menu) to create more notation contexts: one notation context for 
printing each individual part.  The notation contexts keep track of printing information for the score 
and parts.  

It is best to complete the score before you create the notation contexts for the parts.  After you make 
all the parts notation contexts, changes you make in one notation context will be reflected in the 
other notation contexts.  For example, if you correct a note in the flute notation context, the 
correction will automatically appear in the score notation context as well. 

Shortcut Keys, MIDI entry. 

So far we have entered notes, selected duration values and menu items using the mouse and the piano 
window on the computer screen only.  This method is intuitive and user friendly, but very slow.  It is 
much faster to use keyboard shortcuts and a MIDI piano.  Keyboard equivalents take a little time to 
learn, but it is a worthwhile investment in the long run.  There is a complete list of shortcuts at the 
back of the manual.  Most shortcuts can be customized.  Here are a few. 



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 25 of 206 

• Pitches, chords, and rests can be entered using an external MIDI keyboard.  To enter a rest press 
three adjacent keys on the piano keyboard (e.g.  C, C-sharp, and D).  

• Many commonly used menu items have keyboard equivalents.  The keyboard equivalents are listed 
on the right side of each of the menus.  

• Most items in the Piano Window can be engaged using the computer keyboard.  Piano Window 
equivalents can be customized using Shortcut Keys… under the Edit menu. 

• The second and third rows (a, s, d, and q, w, e) are set to pitches beginning with C4.  The [ and ] 
keys are set to keyboard shift.  

• The numbers on the keypad of an extended keyboard have been set to commonly used durations.  
With one hand on the computer keypad and one hand on the MIDI keyboard music can be entered 
as fast as one would type or play in real time; this is an alternative to real-time MIDI entry with 
Record… under the Edit menu. 
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Creating a New Piece 
In this section we describe how to create a piece from scratch.  Start Lime by double clicking on the 
Lime icon.  

Under the File menu, select New.  This is used to make a new piece.  

 

 

 

Initial Time Signature, First Part, and Number of Measures 

When you create a new piece, you are asked how many measures you want to start with, the starting 
time signature for your piece, a name for the first part and how many beats you want in each 
measure.  If the piece you are working on uses changing time signatures, or different time signatures, 
they may be specified later.  You can also insert more measures later; you will have to do this if the 
number of beats in a measure varies in your piece.  (For example, if you are in 4/4 time but you have 
a 1-beat pickup measure, you will want to start by specifying the total number of 4/4 bars.  Once the 
page of 4/4 measures appears you can click on the first note or rest and insert one measure of 1/4 for 
a pickup.)   
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You are also asked for the number of measures per system, and the number of systems per page.  If 
your music is very dense, you will want few measures per system; if you have a large score, you will 
want only one system per page.  For solo pieces, where each system has only one staff, you may 
want to put 10 or 15 systems per page.  You will be able to change the number of measures on each 
system and page turns later, if you think certain systems are too crowded or too sparse, or if page 
turns are at bad places. 

Parts and Voices 

Lime uses a hierarchy of parts and voices that allows great flexibility when creating a score.  The 
term “part” is used for a single musical instrument.  The term “voice” is used to describe a line 
(usually indicated by stem direction) within a part. 

When you create a new piece, it always starts off with one part.  You can choose Single Staff or 
Grand Staff.  If you choose Single Staff, your piece will start off with one part consisting of one 
voice printed on one staff per system.  If you choose Grand Staff, your piece will start off with one 
part consisting of two voices printing on two staves per system.  

Often several parts of several voices are combined on a single staff and appear as chords.  But a 
single voice can also contain a mixture of melodic lines and chords.  

Once you have created your piece, you can use Parts and Voices (under the Voice menu) to create 
more parts and to arrange them on the score.  If you are creating an orchestra score and you want two 
flute parts to print together on one staff, you should create two parts for the flutes; flute 1 and flute 2.  
Parts and Voices will let you specify that the flute parts print together on one staff in the score.  If 
you are transcribing Bach's three part inventions, you will probably use three voices for the piano 
part.  See the section on Parts and Voices for more information. 

Clefs and Key Signatures 

You can change the key signature and clef by using Key Signature and Clef under the Symbol 
menu.  If your piece has several staves in each system, you can change keys or clefs on more than 
one part or voice at a time using Note Group Select: Shift-click the first note on each of the staves, 
then use the Key Signature or Clef menu options. 

If you want to print a score with transposing instruments, specify this using Key Signature.  Use 
Current Staff Only in Key Signature to specify a key signature for each individual part.  You also 
have to specify how many half steps to transpose in Key Signature.  For example, an instrument in 
b-flat has a concert pitch two half steps down from the printed pitch, so specify “-2.” An instrument 
in f plays 5 half steps above printed pitch or 7 half steps below printed pitch, depending on the 
octave of the instrument. 
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The New Piece 

Once you have made any changes to the key, clef, number of measures or voices, you can begin to 
enter music, as explained in the previous section.  You can use the scroll bars to scroll around the 
page.  Alternatively, you can press Alt and Control(Windows) or Alt and Command (Macintosh) 
while you move the mouse to the edges of the music window; this is called “Magic Scrolling.” 
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Part II: Reference Manual 

Piano Window 

  
  

  

The piano keyboard drawn on the screen, together with the other symbols drawn below the keyboard, 
are called the “Piano Window”.  

If the piano keyboard is not visible, select the music symbol (the topmost of the four symbols) at the 
left of the window. 

Edit Cursor, Note Entry Cursor 

Lime has two-note selection “cursors", an edit cursor and a note entry cursor.  

A flashing note head indicates the edit cursor.  Clicking the mouse near a note head in the music 
selects that note with the edit cursor.  Rests are selected in a similar way.  With the edit cursor, the 
note that is flashing can be changed using Piano Window symbols and menu options.  

A flashing box around a note head or rest indicates the note entry cursor.  Double clicking the mouse 
near a note or rest in the music selects that note or rest with the note entry cursor.  Use the note entry 
cursor when you want to enter notes from the music keyboard; your new notes will replace old notes 
and rests starting at the flashing box. 

When the edit cursor is engaged, the duration symbols (whole note, half note, etc.) in the Piano 
Window are not available.  When the note entry cursor is engaged, the symbols are available.  

With the edit cursor (flashing note head) you can perform most editing operations such as adding 
slurs, ties, key or time signatures, changing stem direction, moving staves or notes using Chord 
Drag… etc.  But you are not able to enter new notes.  To enter new notes, engage the note entry 
cursor (flashing box around a note head) by double clicking on a note or rest.  With this cursor you 
can enter new notes by choosing durations and clicking on the keys in the Piano Window or by 
using the computer keyboard or a MIDI keyboard.  You can also select most of the editing options 
available with the edit cursor for the notes you are entering. 
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Notes, Rests, and Note Lengths 

With the note entry cursor you can enter single notes by clicking on the screen’s piano keyboard with 
the mouse; hold down the Shift key at the same time to play chords (see the introduction for more 
information).  This method of specifying notes can be used in place of a MIDI keyboard, but a MIDI 
keyboard will be easier to use.  For information on real-time input of music, see Record (under the 
Voice menu). 

When you enter notes on the keyboard, always play concert pitch, even if your score is transposed.  
Lime will automatically transpose the notes according to your specifications in the Key Signature 
(under the Symbol menu).  To specify a rest, click on the rest at the end of the keyboard, or on the 
thin gray strip just below the keyboard keys.  If you have a 3/4 time signature and you specify a 
dotted half rest, Lime will notate a whole rest.  When you create a rest by clicking on the rest or the 
gray strip, the rest will automatically have Don't Combine Rest checked (under the Note menu).  
This means Lime will not combine the rest you create with neighboring rests; for details, see the 
description of Don't Combine Rest. 

If you want to delete a note, position the cursor and hit the Delete key.  If you intend to enter a new 
note, it is faster to enter the note over the existing music.  If you want to delete a group of notes, use 
Note Group Select and hit the Delete key.  (If you want fewer beats in a measure use Insert 
Measures under the Page menu to make a measure with fewer beats.) You can change the position 
of the cursor using mouse clicks, or using Previous Note and Next Note (under the Voice menu), or 
the left arrow and right arrow keys. 

Note lengths for notes you are entering are selected by clicking on the note length in the Piano 
Window.  Clicking once on a note length selects that length; clicking again adds a dot; clicking yet 
again adds another dot.  To select triplets, click on the triplet symbol.  To change the triplet to some 
other tuplet, double-click on the triplet.  Triplets are normally “3 in the time of 2”; if you want 
duplets, double-click on the triplet, then specify “2 in the time of 3”.  Examples of different types of 
tuplet groupings are given in the back of this manual.  

After you enter a note, it is possible to change its played note length without changing its notated 
note length using the options under the Hear menu.  

Accidentals, Enharmonics 

Accidentals for new notes are chosen automatically.  If possible, new notes are represented without 
accidentals (either because of the key signature or because of a previous accidental in the measure); 
if this is not possible, the accidental is chosen according to a list of “default” accidentals for each 
pitch.  This list is initially set according to the key signature; you can modify the list by using 
Default Accidentals (under the Note menu).  Sometimes you may want to use the enharmonic of the 
Default Accidentals settings (e.g.  G# rather than Ab); you can override the Default Accidentals by 
clicking on the accidentals in the Piano Window before you play your chord.  You can also select an 
existing note with an accidental and click on the enharmonic accidental to change it.  For example, if 
you select a G# and then click the flat icon in the Piano Window it will change it to an Ab.  In even 
rarer cases–for example, if you have both a c flat and a c sharp in the same chord–it may be 
necessary to use the Add feature discussed below.  
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In general, Lime will not print reminder accidentals automatically.  You can ask Lime to print 
reminder accidentals by using Show Accidental (under the Note menu).  

You can change the accidentals on notes you previously played.  Select a note (click on that note) or 
a group of notes (drag around those notes, or Shift-click to add notes to the group)) and then click on 
an accidental in the Piano Window to change the notes.  For example, to change an existing b 
natural note to a c flat, click on the b natural then click the flat in the Piano Window.  See the 
description of Default Accidentals (under the Note menu) for another way of changing accidentals 
on existing notes; see the description of Key Signature (under the Symbol menu) for transcribing to 
different keys. 

If you are printing microtonal music, use Special Accidentals (under the Note menu) to select 
microtonal accidentals for the notes.  See the section on Special Accidentals for more details. 

Staccato, Tenuto, Tie, Slur, Fermata, Accent, Tremolo 

The staccato, tenuto, tie, and slur symbols in the Piano Window can be selected before the notes are 
played using the note entry cursor.  Select the tie and slur when you play all but the last note in a tie 
or slur.  Click on the symbol once to select it; again to turn it off.  

You can use Note Group Select together with the staccato, tenuto, tie, and slur symbols to change 
many notes at once.  In Note Group Select, click on the symbol once to select it for all the selected 
notes, and click on the symbol twice to deselect it for all the notes.  Often it is fastest to play all the 
notes on the page without specifying staccatos, tenutos, ties or slurs, then, after all the notes are in, 
add the symbols using Note Group Select.  

The staccato, tenuto, tie and slur symbols affect the playback of the music; for more information, see 
Defaults under the Hear menu. 

The fermata, accent, and tremolo symbols can be selected before you enter notes on the keyboard; 
click repeatedly on the accent to cycle through the types of accents; click repeatedly on the tremolo 
to cycle through varying numbers of tremolo slashes.  (The tremolo symbol is for tremolos on one 
pitch; to make a tremolo between two pitches, see the section on Tremolo Beam under the Stem 
menu.) Often it is faster to first play all the notes, then add the fermatas, accents, or tremolos using 
Note Group Select.  Click on the correct symbol to add fermatas, accents, or tremolos for the 
selected notes.  To remove fermatas, accents, or tremolos, click on the symbols repeatedly to deselect 
them. 

Grace Notes, Cue Notes, Parentheses, Glissando, and Special Note Heads 

The grace note symbol is used to add grace notes (with the note entry cursor).  First play the main 
chord; then select the grace note and play the grace note(s); the grace notes will be inserted before 
the main chord.  Be sure you select the note value you want used for notating your grace notes.  The 
playback of grace notes can be controlled by Defaults under the Hear menu. 

To delete a grace note, select it and hit the Delete key. 
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If you click on Cue before you play a note, this indicates it will be a cue-size note with cue-size 
stems and beaming.  Unlike grace notes, cue-size notes are like regular notes except for their size.  
You may use Note Group Select then click once on Cue to make the selected notes cue-size, or 
click twice on Cue to make them normal-size.  If you want to make a whole staff of cues, you should 
use Parts and Voices (under the Voice menu) to do this; see the example in the back of this manual 
for more information. 

If you click on the Parentheses before you play a note, the note will print within two parentheses.  
Click repeatedly on the Parentheses to cycle through all parentheses options, left only parenthesis, 
or right parenthesis.  You may use Note Group Select then click once on the Parentheses to apply 
both, left, or right parentheses to the selected notes.  

If you click on the Gliss before you play a note, a glissando line will be drawn between it and the 
next note.  You may use Note Group Select, then click once on Gliss to create a glissando line 
between the selected note and the next note.  You may use Note Group Select to apply glissandi to a 
group of notes.  A glissando line will be interpreted as a “piano” glissando during playback.  

If you click repeatedly on the note-head symbol before you play a note, you can cycle through a list 
of alternative note heads (including no note head at all).  This may be used in Note Group Select.  

If you want to use other note-head symbols, Parameters under the Symbol menu can be used to 
change the set of note-head symbols that you can choose from.  For more information, see the 
description of Parameters.  There are several alternative ways to make new note-head symbols: you 
can either design new symbols using a font editing application (which you purchase separate from 
Lime), you can use symbols from an existing font, or you can combine symbols from existing fonts 
(using Annotation Mode and Multiple Paste).  

Add 

Chords are specified by holding down the Shift key while clicking on the music keyboard drawn on 
the screen, or by playing several notes at once on a MIDI keyboard.  Alternatively, you can build up 
a chord several notes at a time; play the first part of the chord, select a note in the chord, select Add, 
and play the next notes of the chord.  This can be used if you need to specify different accidentals for 
same note name in the chord (for example, if the chord contains both a c flat and a c sharp) or if the 
chord includes different note lengths.  Remember that you need a note entry cursor whenever you 
enter notes.  A word of caution: Add is very often overused; in most cases, it is better to use several 
voices on one staff than it is to use Add.  You should not be using Add to print several parts (say for 
example, two flute parts) on one staff.  See Parts and Voices (under the Voice menu). 

Keyboard Shift 

The up and down arrows at the right of the piano keyboard are used to shift the keyboard up and 
down.  When the keyboard has been shifted the mark that indicates middle C will move accordingly.  
Keyboard Shift is useful when entering notes on the computer keyboard or with a MIDI keyboard 
that is not full length.  
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Moving the Piano Window 

You can move the Piano Window by dragging the grey or light green shaded area on the right of the 
window.  

Resizing the Piano Window 

You can resize the Piano Window by selecting an appropriate standard size from the Window-
>Piano Zoom menu.  Alternatively: 

Windows: Drag any portion of the piano window border.  If a corner is used, then resizing is both 
vertically and horizontally. 

Macintosh: Drag the little striped resize handle on the bottom right of the piano window. 
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Annotation Mode 
In Lime, any text, symbols, lines, or curves which you add to the already existing graphics and 
symbols generated by Lime are called “annotations.”  “Annotation Mode” is used to add 
annotations to your music.  Lyrics, texts, tempo indications such as “Allegro,” and rehearsal marks 
are common types of annotations. 

Every annotation is associated with a note.  When you add an annotation, it is important to have the 
proper note selected.  The annotation will stay with this note if the page layout is changed, or if notes 
preceding it are changed.  It will also stay with the note when you print the parts for a score. 

To enter Annotation Mode, select a note, and then click on one of the three lower symbols on the 
left of the Piano Window.  This will let you add annotations for that note.  If the note symbol on the 
left of the Piano Window is highlighted, you are not in Annotation Mode; the three lower symbols 
indicate Text, Line, or Curve Annotation Mode.  

There are many styles of text and lines required in music notation.  The attributes of each annotation 
can be changed using the items available under the Annotation menu.  These are described in detail 
below.  To exit Annotation Mode, select the music symbol (the topmost of the four symbols). 

Two useful items in the Annotation menu are the Text menus8

 

 and the Text Assistant.  The Text 
menu allows you to automatically set attributes for lyrics, titles, and other standard annotations.  The 
Text Assistant menu creates complex annotations for you.  These are annotations that can be created 
without the assistant by typing special combinations of characters for chord symbols, guitar chord 
grids, tempo marking, and MIDI commands.  

When one of the Text menus or Text Assistant is used Lime automatically selects items from the 
Annotation menu that are appropriate for that type of annotation.  For more information on each 
item, see the Annotation menu section below. 

All Notation Contexts, Only in Score, Not in Score 

If you are working on an orchestra score (or any other kind of multi-part score), Lime allows you to 
edit and print out the score.  If you also want to print out individual parts, Lime has a mechanism 
called “notation contexts” for part extraction.  (See the introduction section on Part Extraction and 
Notation Contexts.)  All Notation Contexts, Only in Score, Not in Score, and In This Notation 
Context Only (under the Annotation menu) are part of the notation contexts mechanism.  They 
allow you to control if an annotation should be printed whenever the part is printed (independent of 
notation context), or only when this part is printed in the score notation context, or only when the 
part is printed in one of the other notation contexts.  

                                                

8 In previous versions of Lime, there was a single Text Category menu.  This has been replaced by two menus, which 
behave identically except for which font will be used for some categories. 
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If you select an annotation while editing the score and you chose Not in Score, then the annotation 
will disappear from the screen: the annotation will only be visible when you edit the another notation 
context which includes the part.  Similarly, if you select an annotation while editing an individual 
part’s notation context, and you chose Only in Score, then the annotation will disappear from the 
screen: the annotation will only be visible when you edit the score.  

Care must be taken selecting attributes for any annotation if it is to be copied and pasted.  If, for 
example, you copy an annotation that has Only in Score selected and paste it into a notation context 
other than the score notation context, it will not appear in that notation context, but only in the score.  
For more details on these options, see the section on Part Extraction (under the File menu) and on 
Duplicate In Every Context (under the Edit menu). 

Drawing Lines  

To draw a line, select the associated note (often the note nearest the beginning of the line).  Next 
choose Line (under the Annotation menu), choose the line width (Line and Curve Style menu 
under the Annotation menu), then move the mouse to the position on the page where you want to 
begin the line.  Press Control (Windows) or Command (Macintosh) and hold down the mouse 
button.  Move the mouse to the end point and let up the mouse button and the Control or Command 
key.  (This is called Control-drag, or Command-drag.) 

Three different widths of lines may be selected by clicking Thin, Regular, or Thick.  Line Width 
(under the Annotation, Line and Curve Style menu) can be used to specify any other line width.  A 
line width of 1 corresponds to one point (1/72 inch); a line width of 1.5 corresponds to one and a half 
points.  The fractional part of the line width makes a noticeable difference on high-resolution laser 
printers.  

In Lime, all lines have two clip points associated with them.  These clip points allow you to clip parts 
of the line; the clipped portions of the line will not be visible.  The initial positions of these clip 
points are chosen for you automatically, so that none of the line is clipped.  For instructions on 
moving the clip points, see the section on Moving and Editing Annotations below. 

Dashed… (under the Annotation, Line and Curve Style menu) is used to specify the dash length 
and the gap between dashes for dashed lines and curves.  To draw dashed lines, use Dashed…, and 
then draw the lines.  When you want to go back to drawing undashed lines, use Dashed… and 
specify a dash length of 0. 

Controls Specifically for Curves 
 

To draw a curve, click the curve symbol, choose Curve Up or Curve Down (under the Annotation, 
Curve menu), and then press Control (Windows) or Command (Macintosh) as you drag the mouse.  
(This is called Control-drag or Command-drag.) 
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Lime uses the Bezier method for drawing curves.  You change the shape of the curve by moving 
around the curve’s control points; the curve slope at each end point is in the direction of that end 
point's control point.  After you have created the curve, press Alt (Windows) or Option (Macintosh) 
and click on the curve to select it, and drag the curve's two control points.  The initial position of 
these control points was chosen for you automatically.  With practice you will be able to make many 
shapes of curves. 

Dashed… (under the Annotation, Line and Curve Style menu) is used to specify the dash length 
and the gap between dashes for dashed lines and curves.  To draw dashed curves, use Dashed…, and 
then draw the curves.  When you want to go back to drawing undashed curves, use Dashed… and 
specify a dash length of 0. 

Moving and Editing Annotations 

When you type lyrics, Tab is used to move on to the next note.  You can use the Switch Tab and 
Space in Lyrics option (Preferences under the Edit menu) to switch the meaning of the space bar 
and the tab key.  

If you want to make a new annotation (text, line, or curve) associated with different note than the one 
that is currently flashing, select the new note by clicking on it.  (Clicking can be used to select a new 
note no matter which of the four mode symbols is highlighted.) 

To select an existing annotation, click the mouse near an end point of the annotation while you press 
Alt (Windows) or Option (Macintosh).  The selected annotation will then be indicated by two small 
squares at its end points.  If you selected a line or curve, there will be two smaller squares to indicate 
the clip points (for lines) or the control points (for curves). 

If you are not in Annotation Mode and you press Alt (Windows) or Option (Macintosh) and click 
to select an annotation, Annotation Mode will be started for you automatically. 

You can also select and move through each annotation using Next and Previous Annotation (under 
the Annotation menu).  You can also select and move through each annotation using Alt (Windows) 
or Option (Macintosh) and the left or right arrow keys. 

Once a text annotation is selected, pressing Enter or Return will allow you to edit, change, or enter 
new text. 

Once you select an annotation, you can delete it (by using Clear under the Edit menu or by hitting 
the Delete key).  You can change its control parameters (by using the items under the Annotation  
menu), and you can drag it (by pressing Alt or Option while you drag the mouse).  While you drag 
an annotation, the coordinate of the annotation end point nearest the cursor will be shown in the 
Piano Window.  The coordinates are in point units; each point is 1/72nd of an inch on the printed 
page (if you print without enlargement or reduction).  After you start dragging the annotation you 
can press Shift (in addition to Alt or Option which is already pressed) to move the annotation with 
ten times the precision; this is normally not necessary.  
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To change the font and style of a text annotation, select it (by pressing Alt or Option near an end 
point of the annotation) and use the Font and Style (under the Annotation menu).  If you want to 
change the font and style for some characters in the text annotation but not all, select the annotation, 
then drag the mouse on the characters you want to change (make them black) and use the Font and 
Style menus (under the Annotation menu).  

If you have selected a line or curve annotation, you may drag the end points.  When you drag the end 
points, the clip points (for lines) and the control points (for curves) will be recomputed 
automatically.  You may drag the clip points of a line to change what parts of the line are visible, and 
you may drag the control points of a curve to change its shape.  For more information on control 
points, see the section on Annotation Controls Specifically for Curves above. 

When you want to add a new annotation, you might want to use the same parameters as an existing 
annotation.  You can do this by selecting an existing annotation; press Alt (Windows) or Option 
(Macintosh) and click on the annotation before you create the new annotation.  For example, if it is a 
text annotation, the text style, point size, and font, for a new annotation will be preset by selecting an 
old annotation first.  After you select the old annotation, select the note for the new annotation (by 
clicking on the note) and type your new annotation. 

 

 

Rulers  

To make rulers appear in Lime, select Rulers in Layout (under the File menu).  The rulers measure 
from the top left of Lime’s printable area on the page.  The rulers are marked in eighth inches; since 
there are 72 points to the inch, an eighth inch is the same as 9 points. 

To set a guide, click on a ruler.  Once you set a guide, annotations will “stick” to the guide when you 
drag them near the guide.  
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Control Annotations 
There are several types of text annotations that act as special instructions that control the way Lime 
represents the music on the page, or plays back the music.  These annotations require special 
characters and specific wording to be effective.  There is a Text Assistant available (under the 
Annotation menu) that will create these annotations by way of an item selection dialog.  See Text 
Category and Text Assistants above for a discussion of this feature.  You can create Control 
Annotations (dynamic markings and tempo markings) to change the volume and speed at which 
Lime plays the music.  These are usually intended to be printed with the music, but can also be 
entered as hidden annotations.  You can create MIDI messages to change the settings on your 
synthesizer.  These are usually hidden, but can be entered as regular annotations.  Parameters are 
also represented as Control Annotations.  The Parameters allow you to change which symbols are 
used when music is printed, the positioning of each symbol, and many other details of printing 
music.  Parameters are usually hidden text.  The following sections will describe Control 
Annotations in greater detail. 

Many Control Annotations are hidden text.  You can make hidden text display on the screen using 
Hidden Text (under the Symbol menu). 

Backslash Characters  

Annotations created in Lime are often a mixture of musical symbols and text, such as  = 120.  Lime 
allows you to enter musical symbols using the combination of a backslash and a text character.  This 
combination is translated into a musical character when editing is complete.  A complete list of 
backslash characters can be found at the end of the manual. 

Examples: “Allegro \q = 100” will become Allegro  = 100, and “Play in rotation: \ppp \ff \mf \p” will 
become Play in rotation:    .  

The backslash convention can be used when creating chord symbols.  A sharp or a flat may be 
included in a chord symbol by typing “\+” or “\-.” A sharp or flat that is slightly smaller and 
superscript is made by typing “\alt+” or “\alt-.” Other text can be made superscript by preceding it 
with “\u.”  

Example:  “C\+\u7” will become C7.  “C\+\u7\--9” will become C7 9.  The attributes of the 
backslash characters for chord symbols can be changed using Parameters under the Symbol menu. 

Dynamic Markings  

While in Text Annotation Mode, type \pppp, \ppp, \pp, \p, \mp, \mf, \f, \ff, \fff, or \ffff in any font.  
When you are finished editing the annotation will automatically be converted into dynamic markings 
(in the Marl font) and may affect playback. 

Alternately, dynamic markings can be created using the Marl font.  The characters range from to 
(the bottom row of keys on the keyboard: z, x, c, v, .  .  .  through “/” in the Marl font).  The 
annotation can include other characters, but must begin with the dynamic for Lime to recognize it as 
a dynamic.  If an annotation begins with anything but a Marl z-/, it will not have an effect on 
playback volume. 
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A dynamic marking only effects the notes on the voice that has the dynamic marking; if you have 
several voices printing on a staff, you should specify a dynamic marking for each of the voices.  You 
can use the Hidden text annotation control with dynamic markings you do not want printed.  In some 
cases you may have several of the same dynamic marking on a single staff; one printed, the others 
hidden.  The printing dynamic marking visually applies to all voices, but effects the playback of only 
the voice with which it is associated.  The hidden dynamic markings will affect the other voices on 
the staff. 

If a dynamic marking is to be interpreted for playback, the annotation window will indicate this 
when you press Alt (Windows) or Option (Macintosh) and click on the annotation.  This allows you 
to check if Lime understands your dynamic marking.  

If you need a different dynamic level on a repeated section of music, use two dynamic markings 
separated with a dash: \p - \ff, or  -  

You can choose the volume levels associated with each dynamic marking.  For details see Dynamic 
Levels under the Hear menu.  

Dynamic markings that affect playback can be copied and pasted to other notes.  See Copy and 
Paste Annotations below. 

Tempo Markings 

While in Text Annotation Mode, type \w, \h, \q, \e, or \s (which represent , , , , or  ) in any font 
followed by " = " and the number of beats per minute.  When you are finished editing the annotation 
will automatically be converted into a tempo marking using a combination of the Marl font and the 
original font.  Any annotation containing a Marl character representing a duration (, , , , or ) 
followed by " = " and a number will affect the playback tempo.  To indicate a dotted value, type a d 
or dd after the characters w, h, q, s, or t.  Here are some examples of tempo markings created using 
this method: "\q = 120" would translate into  = 120, or "quarter equals 120 beats per second", "\hd = 
60" will translate into .  = 60, or "dotted half equals 60 beats per minute."  

You can use the Hidden text annotation control with tempo markings that you do not want printed.  
Sometimes you will add two tempo markings; one that will be printed but does not affect playback, 
and another that will not be printed (with Hidden selected) but does affect playback.  

If a tempo mark is to be interpreted for playback, the annotation window will indicate the tempo 
when you press Alt (Windows) or Option (Macintosh) and click on the annotation.  This allows you 
to check if Lime understands your tempo marking.  

A tempo marking in one voice has effect on all other voices in that notation context.  A tempo 
marking is only effective in the notation contexts where it appears (hidden or printed).  Use 
Duplicate in Every Context to insert a tempo marking in other notation contexts. 
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MIDI Messages 

You can use text annotations to send MIDI messages such as patch changes, program changes, MIDI 
channel changes, MIDI note definitions, or raw MIDI data to your MIDI synthesizer.  You will 
probably want to keep MIDI messages hidden, though they don't need to be.  These annotations can 
be in any font or style, but must begin with one of the following words (in lower case): program, 
control, pressure, midi, note, or channel, followed by the MIDI values.  

A MIDI annotation that begins with “program” or “pressure” must be followed by a number between 
0 and 127 (e.g.  “program 4").  The number represents a program change message to the synthesizer.  
The program number on the synthesizer will change when the note to which the annotation is 
attached is played.  

The MIDI annotation “control” must be followed by two numbers between 0 and 127 (e.g.  “control 
12 120").  The numbers represent a control message to the synthesizer.  The control will change 
when the note to which the annotation is attached is played.  

The MIDI message “channel” must be followed by a number between 1 and 16 (e.g.  “channel 2").  
This number represents the channel on which that voices notes will be played.  The channel will 
change when the note to which the annotation is attached is played.  

A number between 1 and 127 must follow the MIDI message "note." This value corresponds to a 
MIDI pitch.  The MIDI number 60 corresponds with middle C, 61 is C# above, 62 is D and so on.  
This message is provided for mapping percussion patches.  Percussion parts are often only two or 
three pitches and they do not usually correspond to a synthesizer's percussion program.  A snare 
sound on a percussion patch may be A3 (MIDI 57), but if you are notating a percussion part with 
snare only, you would use the single middle line of a percussion clef.  The pitch that normally plays 
with this line is middle C, or MIDI 60.  If the midi message "note 57" is assigned to middle C then 
the midi value 57 (A3) will be sent to the synthesizer when middle C is encountered during playback.  

The MIDI message “midi” is followed by raw MIDI data in hexadecimal (base 16) values. 

Any number of MIDI control changes, patch changes, or other MIDI controls may be associated with 
each note in your piece.  If you are playing several voices through the same MIDI channel (see Voice 
on Channel under the Voice menu), be aware that any of the voices can cause patch changes or 
other MIDI changes on that channel. 

Parameter Changes 

Parameters (under the Symbol menu) allows you to change which symbols are used when music is 
printed, the exact positioning and spacing between symbols, the length and thickness of lines used in 
printing, and many other details of printing music.  You can make these changes at any point in the 
music, and the changes can be for one voice or for all voices, for one notation context or all notation 
contexts. 
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Parameter changes are made using the Parameters dialog, but also appear as Control Annotations 
if you have selected that option in Hidden Text (under the Symbol menu).  The hidden text for each 
parameter contains different numbers of values depending on the parameter, but they follow the 
general form of “param{parameter number:staff size, values} description.”  The hidden text 
“param{198:5,13} normal length of note stems” shows that the parameter for note stem length on a 
staff size of 5 has been set to 13.  The hidden text “param{112:5, 2,24,0,y,0,-5} treble clef character 
at start of staff” shows that the parameter for the treble clef character on staff size 5 uses font “2” at 
24 points, the character “y", with an x and y location of 0 and -5.  Any of the values can be changed 
in Text Annotation Mode.  Changes in the description (everything that follows the “}") have no 
effect. 

It is often convenient to Copy and Paste the hidden text for parameter changes in Text Annotation 
Mode.  It is also possible to modify the parameter text in Text Annotation Mode, but normally it is 
more convenient to use Parameters (under the Symbol menu). 

Copy and Paste Annotations 
You can select an annotation (text, line, curve, or hidden text) by pressing Alt (Windows) or Option 
(Macintosh) and clicking on the annotation.  Once selected, you can copy it (Copy under the Edit 
menu), select another note (click on the note), and paste the annotation to the new note (Paste under 
the Edit menu).  Alternatively, you can select the annotation, Copy, Shift-click on several notes 
(Note Group Select), then Paste to all the selected notes at once (this is called “Multiple Paste”).  
With practice and creative use of the Annotation Controls, the Copy and Paste features can be used 
for many different notational purposes: adding trills, fingerings, bowings, experimental music 
symbols, glissando marks, etc.  Special paste options are available for printing staff names in a score 
(see the section on Duplicate At Each System under the Edit menu) and for printing tempo 
indications in the score and in all the parts (see the section on Duplicate In Every Context under the 
Edit menu). 

The following is an example of an advanced use of the Copy option together with the notation 
context controls.  Say you are editing the score notation context, and you wish to change the font size 
of an annotation in the score, but not in the parts notation context.  Do this by making two copies of 
the annotation, one for the score notation context, and one for the parts notation contexts.  Select the 
annotation, use Copy (under the Edit menu), choose Not in Score; use Paste (under the Edit menu), 
choose Only in Score, and choose the new font size (under the Annotation, Style menu) for the 
score.  

Annotation Group Select 
 

 
Use Align (under the Edit menu) .  .  . 
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Lime provides an “Annotation Group Select” feature that allows you to select and manipulate a 
group of annotations.  Normally, just one annotation at a time is selected, and the selected annotation 
is indicated by small squares at its end points.  When Annotation Group Select is used, a whole set 
of annotations is selected; the selected annotations are indicated by small x’s at their end points.  

To select a group of annotations, hold down Alt (Windows) or Option (Macintosh) and drag a 
rectangle around the annotations.  You can add to the group of selected annotations by clicking on 
more annotation while pressing Alt-Shift or Option-Shift.  If you click on an already selected 
annotation while pressing Alt-Shift or Option-Shift, or if you Alt-drag or Option-drag a rectangle 
around annotations that are already selected, they will be deselected. 

Once you have selected the annotations, you can modify the annotation style using items under the 
Annotation menu.  Use Align (under the Edit menu) to change the alignment of the annotations.  
You can drag the annotations by pressing Alt (Windows) or Option (Macintosh) while you drag the 
mouse near an end point of one of the annotations.  You can also delete or copy the annotations; see 
the section on Clear Annotations and Copy Annotations (under the Edit menu) for details. 

To exit Annotation Group Select, select a single annotation by pressing Alt or Option and clicking, 
or click on one of the symbols to the left of the Annotation Controls. 
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Staff Drag 
Press Control (Windows) or Command (Macintosh) then click on a staff and drag the mouse.  Do 
not to hold the mouse over a note when you drag the staff; this is used for Chord Drag (see below).  
An outline of the staff will move with your mouse; when you release the mouse button, the staff and 
all of its notes will be redrawn at the new location.  

Staff Drag should not be overused.  It should be used as an exception to the default separation 
between systems and voices.  To set the default separation between systems and staves use 
Parameters under the Symbol menu.  Locate the heading STAFF LINES, MARGINS, NOTE 
SPACING in the upper window, and in the lower window locate default vertical distance between 
systems and this voice and next.  Change these values to adjust the default separation between 
systems and staves.  Staff Drag can then be used in crowded orchestral scores to avoid occasional 
overlaps of notes or symbols between staves.  

Three types of staff drag are available in Lime.  In the first type, the dragged staff will relocate only 
in the system where it is dragged.  In the second type, the dragged staff will relocate in the system 
where you drag it and in all subsequent systems for the rest of the piece.  In the third type, the 
dragged staff, as well as the staves below it in the system, will relocate; the third type of staff drag 
does not affect subsequent systems.  Staff Drag… (under the Voice menu) allows you to choose 
between the three types of Staff Drag. 

Care must be taken when using the second type of staff drag since staves later in the piece will also 
be relocated.  If, for example, staff 3 has already been relocated to a higher position on page 8 and 
Relocate Staff for Remainder of Piece is selected in staff drag.  Then when dragging staff 3 on 
page 2, staff 3 on page 8 will be moved an additional amount (the two drag distances will be 
summed). 

It is possible to drag a staff so that it coincides exactly with another staff; the result is that the two 
staves look like a single staff.  This is rarely used; to print voices together on one staff, Parts and 
Voices (under the Voice menu) is normally used.  You can change the horizontal position of the 
staves by using Layout under the File menu; more detailed control is available using Parameters 
(under the Symbol menu). 

To undo the effects of Staff Drag, you can either drag the staff back to its original position, or you 
can select a note on the staff and use Clear Staff Drag (under the Edit menu).  Clear Staff Drag 
may also be used with Note Group Select. 
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Chord Drag, Rest Drag, and Neighborhoods  
Press Control (Windows) or Command (Macintosh) and click a chord (or single note) and drag it to 
a different horizontal position on the screen.  The note heads in the chord will move with your 
mouse; when you release the mouse button the chord and its accidentals and annotations will be 
redrawn at the new location.  Chord Drag is not used to change the order of notes; it is used to 
change the position at which notes are drawn and control notational neighborhoods. 

In music engraving, the amount of horizontal space given to a note depends on the note's duration.  
Half notes have more space after them than quarter notes.  Note spacing also has to take into account 
special symbols that might be present.  Accidentals and clef changes may require increased spacing 
between notes.  If a system has too many notes on it, it may not be possible to leave more space for 
longer note durations, and unattractive sheet music will result.  

The ideal amount of space given to a note or duration may vary in a piece.  A neighborhood is a span 
of music in which the ideal amount of space associated with each note or duration remains constant.  
The size of a neighborhood depends on the music; it may be shorter than a measure, or it may be 
several measures long.  In Lime, the ideal spacing in a neighborhood is modified using Chord Drag.  
To increase the ideal spacing, drag the first note in the following neighborhood to the right; to 
decrease the ideal spacing, drag the first note in the following neighborhood to the left.  (The ideal 
spacing formulas may also be modified using Parameters under the Symbol menu.) 

Chord drag should not be overused.  Lime employs complicated algorithms to adjust the spacing of 
notes in the music.  For example, annotation controls should be used to allow for adequate space 
under a note to accommodate the size of the annotation.  Chord Drag should be used as an exception 
when Lime's normal functions to not allow for a particular situation.  If you want to make space for 
text or other symbols in your music, you can choose the Leave Space annotation control (see 
Annotation Mode above).  To change the general density of notes, you can change the Note 
Spacing Constant, the Page Size, and the margins (in Layout under the File menu).  You can also 
change the number of measures per system using options under the Page menu. 

Two types of Chord Drag are available in Lime.  In the first type of Chord Drag, the music to the left 
and to the right of the dragged chord is relocated.  For example, if you drag a chord to the right, the 
music to the left of the dragged chord will be drawn more spread out, and the music to the right of 
the chord will be drawn more compressed.  In the second type of Chord Drag, only the dragged 
chord is relocated, and all the other music is drawn at its original position.  This type of Chord Drag 
does not preserve vertical alignment between staves on a system.  Normally vertically aligned notes 
occur at the same time; only in the rare cases where this is not desired should this kind of Chord 
Drag be used (see Guitar Music in the Hints and Examples section below).  Chord Drag… (under 
the Note menu) allows you to choose between the types of Chord Drag and rest drag. 

To drag a rest to a different vertical position on the screen, choose Chord Drag… (under the Note 
menu) and select Change Vertical Position of Rests.  Move the mouse onto a rest, then click and 
drag the mouse vertically.  The rest will move with your mouse; when you release the mouse button 
and wait for the screen to update, the rest will be redrawn at the new location.  
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To undo the effects of Chord Drag, you can either drag the chord or rest back to its original position, 
or you can use Clear Chord Drag (under the Edit menu).  Clear Chord Drag may be used with 
Note Group Select. 

Accidental Drag 
Lime automatically places accidentals when several accidentals appear before a chord.  In some 
cases you may want to modify the accidental placement; you can do this using Accidental Drag.  
Press Control (Windows) or Command (Macintosh) and move the mouse onto the accidental, then 
drag the mouse.  The accidental will move with your mouse; when you release the mouse button, the 
accidental will be redrawn at the new location.  If you want to change the placement of all 
accidentals in your piece (for example, if you want all accidentals to be placed closer to the note 
heads), you can change the accidental placement parameters in Parameters (under the Symbol 
menu). 

To undo the effects of Accidental Drag, you can either drag the accidental back to its original 
position, or you can use Clear Chord Drag (under the Edit menu).  Clear Chord Drag may be 
used with Note Group Select.  

Rectangle for Exporting Graphics 
Lime allows you to drag a rectangle on the screen, then copy and paste the contents of the rectangle 
to a word processor or other application, Windows users also have the option of exporting an EPS 
(Encapsulated PostScript) file. 

Define a rectangle by holding down the Alt, Control, and Shift keys (Windows) or the Option, 
Command, and Shift keys (Macintosh) and dragging the mouse.  Then use Copy Rectangle (under 
the Edit menu) or Print (under the File menu).  See the descriptions of Copy Rectangle and Print 
below. 

If you prefer to use PDF format graphics, please use the Print menu option (under the File menu) 
together with Acrobat Distiller® or a similar product; see the Print description below. 
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File Menu 
The File menu allows you to create new files, read files from disk, save files to disk, print music on 
paper, import and export to other file formats, and change the layout.  

Some operations in the File menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these File 
menu operations. 

File: 
New 

New under the File menu is used to create a new piece.  See the Creating a New Piece section in the 
introduction. 

File: 
Open 

Open under the File menu is used to start editing a piece that was previously stored on disk.  After 
you choose Open, you will need to choose the piece.  If you see the piece name listed, click on the 
piece name and click on the Open button.  

You may not immediately see the piece you want to Open.  If there is a long list, you may need to 
use the scroll bars to see your piece; or the piece may be in a different folder or on a different disk.  
Once you select a piece name (by double clicking or by clicking on the piece name and then clicking 
on Open), you will begin editing the piece. 

Note:  Lime will let you edit more than one piece at a time.  If you use Open while you are editing a 
piece, Lime will ask you if you want to close that piece before you begin editing the new piece (see 
Close below).  

Open can be used to open Macintosh Lime files on the Windows platform, and to open Windows 
files on the Macintosh platform.  When porting to the Windows platform you should name all files 
with a .lim extension so that Windows recognizes them as Lime files.  When porting to the 
Macintosh platform you should set PC Exchange control panel to recognize the .lim extension.  
Alternatively, you can hold down the Shift key when you select Open to list all files, including files 
that the Macintosh does not recognize as Lime files. 
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File: 
Import NIFF 

 

Import NIFF is used to read standard NIFF9

NIFF import was primarily to import from the SharpEye Music Reader®, which at the end of the 
20th century was one of the most sophisticated OMR programs available, and it creates NIFF files 
that can be opened in Lime.  (OMR stands for Optical Music Recognition, technology used for 
interpreting scanned sheet music).  SharpEye is still available from 

 files.  NIFF (Notation Interchange File Format) is a 
binary-based standard designed to allow data interchange between programs that use common music 
notation.  

http://www.visiv.co.uk/; 
however it is a very old program and has been superseded by Neuratron’s PhotoScore 
(http://www.neuratron.com/photoscore.htm), which has further developed the SharpEye scanning 
engine.. 

File: 
Import MusicXML 

Import MusicXML is used to read standard MusicXML files.  MusicXML is a text-based standard 
designed to allow data interchange between programs that use common music notation.  Other 
notation and sequencing programs may allow you to export a MusicXML file that can then be 
opened by Lime using Import MusicXML.  The Dolet plugin (available from 
http://www.recordare.com/) allows you to create MusicXML from Finale® or Sibelius® (Sibelius® 
7 and later offers native export); then you can use Lime’s Import MusicXML menu option to open 
those files.  PhotoScore also uses MusicXML. 

 

                                                

9 A discussion of the NIFF standard was in Computer Music Journal, Vol 20, No 4, pp.  33-43, Winter 96.   

http://www.visiv.co.uk/�
http://www.neuratron.com/photoscore.htm�
http://www.recordare.com/�
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File: 
Import MIDI 

 

 

Import MIDI is used to read standard MIDI files.  Import MIDI reads one voice at a time; if there 
are several voices you want to import, use Import MIDI once for each voice.  

Before you use Import MIDI, make sure your piece has the proper key signature and time signature, 
and has enough empty measures to accommodate the notes you want to import.  Import MIDI 
works just like Record (under the Voice menu), except that the notes come from a standard MIDI 
file rather than from the keyboard.  Before you try Import MIDI, you may want to experiment with 
Record. 

When you are ready to import MIDI notes, select the starting note on the destination voice in your 
piece, then choose Import MIDI.  You will see the dialog above.  Select the metronome beat and the 
shortest duration (quantize).  The metronome beat does not have to match your time signature; often 
an eighth or sixteenth metronome beat works well for importing 4/4 time.  Indicate which MIDI 
channels and which track should be transcribed to your Lime voice.  There are three types of MIDI 
files; which type of file you have will determine how you choose your channels and track, as 
described below. 

Type 0 MIDI File: All the information in the file is stored in one track (track 0).  Choose a range of 
MIDI channels that corresponds to the notes you want to import to your Lime voice. 

Type 1 MIDI File: The information in the file is stored in several tracks; choose the track number 
that contains the notes you want to import to your Lime voice.  Lime will show you the highest 
possible track number.  (Do not read from track 0; that track usually contains no notes, only timing 
information.)  You will also need to choose a range of MIDI channels that corresponds to the notes 
you want to import to your Lime voice; often you can choose the complete range of channels (1 to 
16) because the track you have chosen only contains information for one voice. 
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Type 2 MIDI File: The information in the file is stored in several tracks; choose the track number 
that contains the notes you want to import to your Lime voice.  You can choose any track between 0 
and the highest track number; Lime will show you the highest track number.  You will also need to 
choose a range of MIDI channels that corresponds to the notes you want to import to your Lime 
voice; often you can choose the complete range of channels (1 to 16) because the track you have 
chosen only contains information for one voice. 

File: 
Import OMR of Image File, Import OMR of Scanner, Select Twain Source 

These three menu options are available if you purchase and activate integrated OMR (Optical Music 
Recognition) for Lime.  Without integrated OMR, you run a sheet music scanning program 
separately from Lime, and then import the scan results into Lime.  If you use the integrated scanning 
feature, SharpEye Music Reader® OMR technology is directly integrated into Lime – you bypass the 
SharpEye editor and correct all scanning errors within Lime.  This is an advantage for blind users 
because SharpEye’s editor does not lend itself to use by the blind; blind and low vision users can 
purchase an accessible version of Lime (Lime Aloud or Lime Lighter, from Dancing Dots and do all 
their scan editing within Lime.  Integrated OMR capabilities are available through Dancing Dots at 
http://www.dancingdots.com/; non-integrated SharpEye is available at http://www.visiv.co.uk/.  See 
section III: Hints and Examples for a description of features and techniques for correcting errors in 
scanned music. 

If you have purchased and activated the integrated scanning feature, the OMR of Image File menu 
option lets you create a Lime piece by doing OMR on a pre-existing scanned image bitmap file of a 
page of music.  If your piece has multiple pages, each page must already be scanned into an OMR 
image file.  Then use this menu option multiple times; first for the first page, then for the second 
page (when it asks, say to Yes to append to the piece that is already open), etc. 

OMR of Scanner is the same as OMR of Image File, except that it will ask you to scan the music 
after you select this menu option.  Lime's scanning process uses the TWAIN interface to your 
scanner.   Select Twain Source allows you to choose a scanning device for the OMR of Scanner 
menu option.  . 

File: 
Close 

Close under the File menu is used when you have finished editing a piece.  If you have made any 
changes to the piece, you will be asked if you want to save the changes on disk.  If it is a new piece 
that has never been saved, you will be asked for a name for the piece and you will be able to choose 
which folder and what disk should be used for the piece.  Choosing the folder and the disk is the 
same as choosing the folder and disk for Open (see the description above).  

http://www.dancingdots.com/�
http://www.visiv.co.uk/�
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File: 
Save 

Save under the File menu is used to save your piece on disk while you are editing the piece.  If it is a 
new piece that has never been saved, you will be asked for a name for the piece and you will be able 
to choose which folder and what disk should be used for the piece.  Choosing the folder and the disk 
is the same as choosing the folder and disk for Open (see the Open description above). 

It is a good idea to use Save often when you are editing your piece.  This way, if you make a big 
mistake, you can always use Revert (described below) to get back to your most recently saved 
version of the piece. 

There is a preference option to specify that whenever a file is saved, the previous version is retained 
in the same directory with its name preceded by a tilde (~). 

File: 
Save As 

Save As under the File menu is like Save, except that it makes a new copy of your piece on disk.  If 
you use Save, it will update the piece which you selected with Open; if you use Save As, it will 
leave the piece you opened alone; it stores a new copy of your piece with a new name you specify.  

File: 
Save As Template 

Save As Template under the File menu is like Save As, except that the file will be marked as a 
template.  If it is opened, a new piece will be created, based on the template. 

File: 
Graphic Save, Graphic Save As 

Graphic Save is not intended for most users.  Independent private developers who write programs 
that display, animate, and play Lime pieces use this feature.  For more information, contact the Lime 
authors.  

Lime normally stores only essential information about a piece.  Such details as stem direction or note 
location are calculated and fleshed out from this skeleton each time Lime generates a page.  Graphic 
Save and Graphic Save As are used to create a file with a more complete description of what the 
music actually looks like on the page, such as coordinates for a note head.  To use Graphic Save, 
hold down the Shift key and select the Save menu option.  

File: 
Export MusicXML 

Export MusicXML is used to write a standard MusicXML file.  MusicXML is designed to allow 
text-based data interchange between programs that use common music notation.  

Note that Lime’s ability to export MusicXML is still very, very basic. 
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File: 
Export MIDI 

Export MIDI is used to write a standard MIDI file.  Lime always writes Type 0 MIDI files (see 
discussion above); and Lime always writes all voices in your notation context. 

When exporting a MIDI file Lime uses the Voice on Channel information (not Parts and Voices) to 
determine MIDI channel assignment.  If there are four voices in your piece, each assigned to a 
different staff, but to the same MIDI channel, they will be written to one channel in the standard 
MIDI file.  If you want each voice in a Lime score to be on a separate channel in the MIDI file, use 
Voice on Channel to make each voice's channel assignment.  If you want the voice to switch to a 
different MIDI channel at some point in the piece, use a Control Annotation; see the section on 
MIDI Messages in Control Annotations for details. 

Standard MIDI files created by Lime include time signature information (if your piece has time 
signatures) and tempo information (if your piece has tempo markings).  It will also include text 
information (if you have lyrics or other text annotations). 

File: 
Revert 

Revert is used when you make changes and then decide you don't like the results.  Revert allows 
you to go back to the most recently saved version of your piece.  All the modifications you made 
since the last Save or Save As will be discarded.  See also Undo (under the Edit menu). 

File: 
Layout 

 

 

Layout under the File menu allows you to choose how large your Lime page size should be, how 
large your margins are, and various other layout parameters.  Some of the parameters in Layout are 
in units of “points” and others are in inches; a “point” corresponds to the size of the smallest dot (one 
pixel) on the screen, and there are 72 points per inch.  



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 52 of 206 

A large Lime page size allows you to put more music on one page, but there are two things you 
should keep in mind.  First, a large page size will use more memory and might limit your piece size 
if your computer does not have much memory.  Second, if you use a very large page size, you will 
need to use a percent size reduction when you print your page and this may affect the readability of 
your music.  If you have a lot of memory, and if you have access to a printer with a large page size, 
then neither of these problems are serious considerations.  

When you change the page size of your Lime piece, the staves will move closer or farther apart from 
each other.  For this reason, it is advisable to choose your final page size as early as possible in the 
editing process; then the staff spacing you see is really what you will get on the print.  

Minimum default line width allows you to specify the default thinnest line that Lime uses to 
generate graphics on the screen.  Changing this single value will affect all lines on the score: staff 
lines, stems, bar lines, ledger lines, hairpins, etc.  To change the thickness of an individual type of 
line (such as bar lines), use Parameters under the Symbol menu.  It is common to increase the 
Minimum default line width when you use a large page size and greatly reduce the size for 
printing.  A larger Minimum default line width will result in sheet music with thicker lines that 
photocopy well. 

Layout also provides an Editing Zoom.  The Editing Zoom affects only how the music is displayed 
on the screen.  Unlike page size, Editing Zoom will not affect note spacing, staff spacing, or printing 
in any way.  Also, Editing Zoom does not affect how music is printed.  The Editing Zoom allows you 
to enlarge your music on the screen; this will show you a smaller part of your page, in more detail.  
The Editing Zoom also allows you to reduce your music on the screen; this will show you more of 
the page, with less detail.  

Layout allows you to turn rulers on and off.  Rulers are drawn with 8th inch marks; since there are 
72 points to the inch, an 8th inch corresponds to 9 points.  Clicking on the rulers will set guides, 
which can be used to help move annotations.  See the section on Rulers and Guides for more 
information. 

Parameters (under the Symbol menu) can be used to control margins and page layout with more 
detail than Layout, but in most cases Layout will do what you need. 

Layout will tell you what percentage of the available memory your Lime piece uses.  If you are 
running out of memory, you have several ways you can solve the problem.  If you have very large 
pieces, you can break them into smaller pieces, but the best solution is to have more memory 
installed.  

Layout information is kept separate for the score notation context and the parts notation contexts.  
This means you can specify different page sizes and margins for each notation context.  

Macintosh users: Thinnest Line (PostScript Pixels) is used to set the width of the thinnest lines on 
a postscript printer.  If you set a this value to 2 (2 pixels independent of the printer resolution) it will 
be 150th of an inch wide on a 300 dots per inch printer, and a 300th of an inch wide on a 600 dots 
per inch printer.  See also the description of Minimum default line width above. 
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File: 
Print (Windows) or Page (Macintosh) Setup 

Print (Windows) or Page (Macintosh) Setup is used to set parameters for the Print option (under 
the File menu).  You can choose if you want the music printed horizontally (“landscape mode”) or 
vertically (“portrait mode”) on the paper; you can also choose the percent size reduction when your 
music is printed.  The amount of reduction you choose will depend on your Lime page size (which 
you set with Layout under the File menu) and how large the paper is for your printer.  See section 
III: Hints and Examples for a chart that illustrates the page sizes and amount of reduction required 
for various paper sizes and orientations.  If lines are too thin in your sheet music, you can increase 
the thinnest line width using the Layout menu option. 

Lime will remember the values you specify in Print or Page Setup; you do not need to use Print or 
Page Setup unless you want to change to different values.  Setup information is kept separate for the 
score notation context and the parts notation contexts.  This means you can specify different page 
sizes and margins for the score and the parts. 

File: 
Print 

Print is used to print a hardcopy of your music.  Print will print the current notation context.  To 
print other notation contexts, see Print Multiple below. 

Mac OSX users: If you would like to use Lime’s Print menu option to make high-quality PDF file, 
go through the following steps when you have completed your piece: 

1) While your piece is open in Lime, select Print, then Output Options, the Save as File, then PS 
(not PDF!), and type .eps as an extension on the file name you choose. 

2) Using the OSX Finder, double-click on the .eps file you made.  After the file opens in OSX’s 
Preview program, use Save As PDF. 

If you would like to make a high-quality EPS file, you must do an additional step: 

3) Open the PDF in GraphicConverter, and save as EPS. 

 

Windows users: If you would like to produce high-quality PDF files, we suggest you install the 
Adobe Acrobat Distiller®.  The Acrobat Distiller will be listed as a printer, just like your other 
printers in the Print menu. 

You can use Print to export EPS (Encapsulated PostScript) files from Lime.  Before you decide to 
use EPS files, read about the related feature Copy Rectangle (under the Edit menu).  Copy 
Rectangle allows you to define a rectangle and copy, then paste it into a word processor or other 
application.  Copy Rectangle is usually more convenient than EPS files.  

This is the procedure for exporting an EPS File (Windows): Define a rectangle by holding down the 
Alt, Control, and Shift keys and dragging the mouse.  Then choose the Print menu option and 
specify Print Selection, Print to File, and Encapsulated PostScript (under the options tab). 
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In some cases you may have to change the word processor’s options or do a customized installation 
to insure the word processor has the correct EPS filter.  For example, to make Microsoft Word 5.0 
recognize EPS files, open the setup program and choose the following items/buttons: Custom, 
Converters…, Change Option, Graphics Filters, Change Option, Encapsulated Postscript 
Import, OK, OK, Continue.  

File: 
Print Multiple 

Print Multiple allows you to choose and print any combination of notation contexts. 

File: 
Launch GOODFEEL, Launch in Manual Mode 

These two menu options are available if you have installed an authorized copy of GOODFEEL 
Braille Music Translator from Dancing Dots Braille Music Technology, L.P.  at 
http://www.dancingdots.com/.  These menu options allow you to emboss Braille music from your 
Lime piece.  For sighted users wishing to learn Braille or wishing to prepare Braille scores, Dancing 
Dots offers Lime with a Braille Window, so you can see Braille as well as standard notation as you 
edit.  For blind and low vision users wishing to prepare Braille, magnified or standard notation files, 
Dancing Dots offers GOODFEEL, Lime Lighter and Lime Aloud.  Contact Dancing Dots for more 
information. 

File: 
Exit (Windows) or Quit (Macintosh OS 9) 

When you have finished using Lime, use Exit (Windows) or Quit (Macintosh OS 9).  If you are 
editing a piece and have not saved your changes, then you will be asked if you want to save the 
changes before you exit Lime; for details, see the description of Save above. 

http://www.dancingdots.com/�
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Edit Menu 
Lime allows you to copy and paste notes, measures, staves, graphics, annotations, parameters, and 
parts of text strings.  Copy and Paste work differently depending on what type of things you are 
copying and pasting; the following sections will describe the various uses of Copy and Paste. 

The keyboard equivalent for Copy is Control-c (Windows) or Command-c (Macintosh); for Paste 
it is Control-v or Command-c.  In some situations the Shift key has special meaning for Copy, so 
you may use Control-Shift-c or Command-Shift-c instead of Control-c or Command-c. 

In addition to Copy, Paste, and Duplicate, the Edit menu allows you to align annotations with one 
another; and to set Lime editing and playback options. 

Some operations in the Edit menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these 
Edit menu operations. 

Edit: 
Undo, Redo 

If a command or operation does not have the results you expected, or if you make an error such as 
inadvertently entering notes while practicing, you can use Undo to remove the command or 
operation.  Redo will restore the operation if you inadvertently use Undo.  See also Revert (under 
the File menu).  

Lime supports multiple undo commands.  This means you can choose Undo from the Edit menu 
several times in succession.  Lime will progressively move back through the previous series of 
actions with each Undo.  The number of possible edits that can be undone is only limited by the few 
actions that cannot be undone and the amount of memory available on your computer.  For example 
a page turn cannot be undone.  You can undo hours of work if all of those actions fall into the 
category of actions that can be undone. 

Edit: 
Copy Music, Paste Music 

Copy Music and Paste Music are used to copy notes within Lime.  

To copy a single note, click once on the note, and select Copy Music under the Edit menu.  Then 
click on the destination note or rest, and select Paste Music under the Edit menu.  The destination 
note or rest will be replaced with the note you copied. 

To copy several notes and rests, select the group of notes and rests by dragging the mouse (see the 
description of Note Group Select in the introduction) and select Copy Music; then click on another 
note or rest and select Paste Music.  All of the notes you select for Copy Music should be from one 
voice. 
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Lime is capable of copying notes that are not contiguous.  That is, a group of notes from measure 
once can be copied along with a group of notes in measure six with one action.  They will be pasted 
as contiguous notes. 

If you have several voices printing on one staff, you may want to use Highlight Voice (under the 
Voice menu) before you select your group of notes to avoid selecting notes from other voices.  For 
more details, see the description of Highlight Voice. 

If you want to copy reminder accidentals, annotations, parameter changes (made with Parameters 
under the Symbol menu), and MIDI messages along with your notes, hold down the Shift key as you 
select Copy Music under the Edit menu. 

Edit: 
Cut Annotation, Copy Annotation, Paste Annotation 

To copy several annotations at once, use Annotation Group Select by Alt-dragging (Windows) or 
Option-dragging (Macintosh) around the annotations.  To add annotations to an already selected 
group, Alt-Shift-click or Option-Shift-click near an endpoint the annotations (see the description of 
Annotation Group Select for more information).  It is possible to select a group of annotations for 
editing regardless of which notes they are attached to.  But when using Copy Annotation all the 
annotations you copy at one time must be associated with the same note. 

If you want to copy an annotation and at the same time remove the original annotation, use Cut 
Annotation instead of Copy Annotation. 

To paste an annotation onto each note in a group of notes, use Note Group Select by dragging the 
mouse around the notes, or Shift-clicking on individual notes, then use Paste Annotation.  This can 
be very useful in helping you print music with many special symbols or extended music notations; 
this requires careful use of the annotation controls.  For more information, see the section on Note 
Group Select. 

If the annotation is a Control Annotation (dynamic, tempo, MIDI message, or Parameter change), 
that control will be in affect at each of the destination notes. 

To remove an annotation, press Control (Windows) or Command (Macintosh) and click near its 
endpoint to select it then use Clear Annotation.  You can remove many annotations at one time with 
Annotation Group Select.  Select a group of annotations then use Clear Annotation or the Delete 
key. 

If you want to label the score and all the parts with a tempo marking or some other indication, see the 
description of Duplicate In Every Context below.  If you want to label a staff with its instrument 
name in a score, see the description of Duplicate At Each System below.  

Edit: 
Copy Rectangle 

Copy Rectangle is used when you want to copy music from Lime into another application such as a 
word processor, database, or paint program. 
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Press Alt, Control, and Shift (Windows) or Option, Command, and Shift (Macintosh) and define a 
rectangle by dragging the mouse; then choose Copy Rectangle under the Edit menu.  Now you can 
paste the rectangle into another application.  (When printing a word processor file, such as Microsoft 
Word, which contains music copied from Lime; be sure Unlimited Font Downloading is off.) 

After you paste music from Lime into your word processor, you may want to change the size of the 
music.  Most word processors allow you to do this; look in the manual for your word processor for 
instructions on re-sizing graphics pasted from other applications.  Alternatively, you can change 
Lime’s Editing Zoom (in Layout under the File menu) to affect the size of music before you use 
Copy Rectangle.  (Note that the reduction/enlargement you specify in Print or Page Setup is for 
printing only and does not affect Copy Rectangle.) 

Mac users: Copy Rectangle will copy a mixture of PostScript® and QuickDraw™ to describe your 
music.  To avoid using any PostScript, hold down the Shift key while selecting Copy Rectangle.  
This will use less memory, but will also reduce the quality of the printed output on a high-resolution 
printer. 

Windows users: Copy Rectangle uses Windows Metafiles to represent your music.  Word 
processors and other programs with extensive support of Windows Metafiles will work best with 
music copied from Lime.  Microsoft Word users must use Paste Special, not Paste, to paste the music 
into their Word document. 

Edit: 
Clear (Note, Text, Annotation, At Each System, On Each Page, In Every Context, Staff Drag, 
Chord Drag, Accidental Drag, Graphical Alignment, Invisible Notes) 

If you want to remove a note, annotation, an annotation that has been duplicated at each system or in 
every part, Staff Drag, Chord Drag, Accidental Drag, MIDI message, or parameter, first select the 
thing you want to remove, and use Clear… under the edit menu.  

Clear… can be used when a group of notes or annotations are selected (Note Group Select and 
Annotation Group Select). 

Clear… Graphical Alignment is used with OMR (Optical Music Recognition) of scanned music 
files.  Lime uses special information provided by some OMR scanner programs to decide where to 
put red rests.  The SharpEye Music Reader® gives Lime information on the graphical alignment of 
note symbols on the original page of music; this information is used to make red rests.  You can use 
Clear Graphical Alignment (under the Edit menu) to turn all red rests into black rests – but do not 
do this until you are certain you have completed all duration corrections you wish to make, otherwise 
your piece may have bars with too many or too few beats.  See section III: Hints and Examples for a 
description of features and techniques for correcting errors in scanned music. 

Clear… Invisible Notes will search for any notes that do not appear in any notation context.  If such 
notes are found a dialog box appears offering to remove these notes. 

Edit: 
Copy Measures  
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If you want to copy several measures of music, click on the first note to be copied, and use Copy 
Measures.  Then click on the first note of the destination and use Paste Music. 

You have three options when copying measures.  First, you can copy measures only from the 
currently selected voice.  Even if there are several voices or parts on that staff, only the notes that 
belong to the current voice will be copied.  

Second, you can copy and paste all voices or parts that are assigned to the currently selected staff.  
This option will copy all the notes in all the voices or parts on that staff. 

Third, you can copy and paste all voices and parts from all staves.  This will copy all notes on all 
voices and parts.  

Care must be taken when pasting measures that were copied using either All Voices on Staff, or All 
Staves.  The number of parts or voices on the target staff must match the staff where the music 
originated.  Otherwise, Lime will print an error message and the paste will not work.  It is also 
important to remember that some voices or parts may be hidden on the original staff or the target 
staff.  

Normally when copying measures you will want all annotations, MIDI messages, and parameter 
changes to be copied and pasted along with the notes.  If, however, you were copying music from the 
first measure, you would not want annotations such as titles and voice names to be copied, so you 
can select For All but the First Note.  In some cases you would only want the notes copied, and you 
would select For None of the Notes.  If you use For None of the Notes then any annotations that 
are already present in the destination will be retained; just notes will be replaced. 

Edit: 
Align Annotations 

Align Annotations is used to align several annotations with each other.  It is most commonly used 
for text annotations, but it can also be used with line and curve annotations.  Before you use Align 
Annotations, you must select a group of annotations using Annotation Group Select.  Read the 
section of the manual on Annotation Group Select if you are not familiar with it. 
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Align Annotations gives you the choice of 5 different types of alignment; be careful to choose the 
correct type of alignment before you click OK!  If you choose Align Top, all of the selected 
annotations will be moved so that they are at the same vertical location as the topmost selected 
annotation.  If you choose Align Bottom, all of the selected annotations will be moved so that they 
are at the same vertical position as the bottom most selected annotation.  Both Align Top and Align 
Bottom are often used to move lyrics.  For example, if you want to move a whole line of lyrics up: 
Alt-drag (Windows) or Option-drag (Macintosh) one of the lyrics up, then use Annotation Group 
Select to select all the lyrics including the one you dragged up (Alt-drag or Option-drag around 
them) and use Align Top. 

Align Left moves all the selected annotations so their left ends have the same horizontal location as 
the leftmost selected annotation.  Align Right moves all the selected annotations so their right ends 
have the same horizontal location as the rightmost selected annotation.  Align Middle (of Top 
Annotation) moves all the selected annotations so they are centered relative to the topmost selected 
annotation.  Align Left, Align Right, and Align Middle are often used to align duplicate annotations 
at each system.  Annotations which use the Centered annotation control cannot be moved 
horizontally (they are always centered under a note or in the middle of a page). 

Edit: 
Duplicate Annotation At Each System 

Duplicate At Each System is used when you want to label a staff with its instrument name in a 
score.  You should be familiar with text annotations and the text annotation controls before you use 
Duplicate At Each System.  

To label a staff with its instrument name, select the first note on the staff, enter Text Annotation 
Mode (click the text symbol at the bottom left of the screen), and select the Horizontal Lock and 
Vertical Lock annotation controls, and select Only In Score.  Then type the staff label to the left of 
the staff.  Finally, press Alt (Windows) or Option (Macintosh) and click on the staff label and select 
Duplicate At Each System under the Edit menu. 

This copies and pastes the staff label onto the first note for this voice on all subsequent systems.  
(After you use Duplicate At Each System, you can still use the options in the Page menu to split 
and combine systems; Lime will automatically remove or add staff labels as needed.)  You might 
need to use Layout (under the File menu) to make more room to the left of the staves, so that you 
have enough room to type your staff labels. 

If you print large scores, you will often have two voices, such as clarinet 1 and clarinet 2, print on 
one staff.  You will want the staff label to list the names of both instruments; for example, your staff 
label might be “Clar I, II.” Use Parts and Voices (under the Voice menu) to specify that both 
clarinet voices print on one staff.  It is simplest to choose Uniform Stem Directions and Stems Up 
in Parts and Voices for the first voice on the staff, Stems Down for the second voice on the staff.  If 
instead you turn off Uniform Stem Directions, or if you use Start Voice and End Voice, you need 
to make identical staff labels for each voice on the staff.  Create the staff label on the first voice, use 
Copy and Paste Annotations to copy it to the second voice, select the labels on both voices using 
Annotation Group Select (Alt-Shift-drag or Option-Shift-drag around the labels) and use 
Duplicate At Each System.  
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[These are the technical details for labeling both voices identically.  During processing of Duplicate 
At Each System, Lime decides which staff label to use for a certain staff.  It looks at the first chord 
on the staff, sees which voices contribute to that chord, and labels the staff with the staff labels 
specified for each of the voices.  In this clarinet example, Lime sees that two voices print on the staff, 
and it uses the staff labels specified for both voices.  However, it may happen that in the first chord 
of the staff, only one of the voices is printed.  So to ensure that Lime labels the staff with “Clar I, II”, 
label both voices (not just one) with “Clar I, II”.  When both voices are printing, Lime prints two 
identical labels on top of each other.  This is no problem.] 

When an annotation has been duplicated for staff labels, the annotation window will indicate this 
when you select the annotation (Alt-click or Option-click).  This allows you to check if Lime 
understands your Duplicate At Each System command.  

If you want to remove the annotations that have been duplicated at each system, select the annotation 
using Alt or Option-click, then use Clear At Each System.  This will remove all the duplicate 
annotations from this voice starting after the annotation you selected until the end of the piece; it 
does not remove the annotation you selected.  If you want to change a duplicate annotation, you need 
to use Clear At Each System, change the annotation, and then use Duplicate At Each System 
again. 

Annotation Group Select may be used with Duplicate At Each System and Clear At Each 
System, so that you can duplicate and clear duplicates for many voices at one time.  

Edit: 
Duplicate Annotation On Each Page 

Duplicate At Each Page is used when you want to duplicate the same annotation on every page in 
the score.  You should be familiar with text annotations and the text annotation controls before you 
use Duplicate On Each Page.  

To duplicate an annotation at the top of every page in the score, select the first note on the page, 
enter Text Annotation Mode (click the text symbol at the bottom left of the screen), and select the 
Horizontal Lock and Vertical Lock annotation controls, and select Only In Score.  Then type the 
annotation at the top of the page.  Finally press Alt (Windows) or Option (Macintosh) and click on 
the annotation and select Duplicate On Each Page under the Edit menu. 

If you want to remove the annotations that have been duplicated on each page, select the annotation 
using Alt or Option-click, then use Clear On Each Page.  This will remove all the duplicate 
annotations associated with this voice starting after the annotation you selected until the end of the 
piece; it does not remove the annotation you selected.  If you want to change a duplicate annotation, 
you need to use Clear On Each Page, change the annotation, and then use Duplicate On Each 
Page again. 
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Edit: 
Duplicate Annotation In Every Context 

Duplicate In Every Context is used when you want a tempo marking, rehearsal mark, or some other 
annotation to appear only once in the score notation context, but you also want it to appear in each of 
the parts notation contexts when you print the parts individually.  You should be familiar with 
annotations and with Part Extraction before you use Duplicate In Every Context. 

For example, you might type an annotation “Vivace” associated with a note on the top staff in the 
score notation context.  After you type the annotation, select it by pressing Alt (Windows) or Option 
(Macintosh) and clicking, then use Duplicate In Every Context.  This duplicates the Vivace 
annotation onto all the voices, but it will not change the appearance of the score notation context: 
Lime knows to print annotation only on the top staff of each part notation context.  Later, when you 
make notation contexts for each of the individual parts, the “Vivace” will appear in each part 
notation context.  You may want to move the annotation to a different position in the parts notation 
contexts; selecting and moving the annotation in the part will not affect its location in the score 
notation context. 

When an annotation has been duplicated in every part, the annotation window will indicate this when 
you select the annotation.  This allows you to check if Lime understands your Duplicate In Every 
Context command.  

If you want to remove an annotation that has been duplicated in every part, select the annotation, 
then use Clear In Every Context.  This will remove all the duplicate annotations from all the voices 
at the current chord.  If you want to change a duplicate annotation, you need to use Clear In Every 
Context, change the annotation, and then use Duplicate In Every Context again. 

Annotation Group Select may be used with Duplicate In Every Context and Clear In Every 
Context, so that you can duplicate and clear several duplicates at one time.  

The Duplicate In Every Context and Clear In Every Context operations are not enabled unless 
you are editing the score notation context.  

Edit: 
Extend Line to Here 

Extend Line to Here allows you to connect and extend the ending point of lines such as hairpins and 
8va indications to another note.  The line will then automatically extend to that note and will resize 
automatically if the position of the first or last note associated with the line changes.  When creating 
the line make sure the note where the line should begin is selected, and then draw the line or hairpin.  
If you plan to use Extend Line to Here the initial length of the line is irrelevant, but you can draw 
the line to the approximate position of the ending note.  After drawing the line, select the note to 
which you want the line extended and select Extend Line to Here.  You can extend lines across 
system breaks and page breaks with Extend Line to Here. 

To extend a line that has not previously been set to resize automatically first select the line.  Then 
click on the note to which the line should extend and select Extend Line to Here.  
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When copying and pasting a line that has been set to resize, the resizing feature will not be 
duplicated to the new position.  If you want the new line extended you must repeat the resizing 
commands. 

Edit: 
Allow Any Alt-Click (Windows) or Allow Any Option-Click (Macintosh) 

Allow Any Alt-Click (Windows) or Allow Any Option-Click (Macintosh), when checked, allows 
you to select any Lime generated graphic on the page by clicking near the graphic while pressing Alt 
or Option.  (These are the same keys you would use to select an annotation you created in 
Annotation Mode).  It can then be edited, modified, moved, or deleted.  Select Allow Any Alt-
Click or Allow Any Option-Click from the Edit menu again to disable this feature.  

If you want to discard any changes made using this feature and return to the original graphics, reenter 
the note, or use Undo (under the Edit menu). 

Be careful not to overuse feature.  It is better to let Lime generate as much of the music as possible.  
Clef changes, for example, could be made using Allow Any Alt-Click or Allow Any Option-Click, 
but making the change with Clef (under the Symbol menu) will give Lime the information it needs 
for correct accidental placement, playback, and transposition.  Stems could be lengthened using with 
this feature, but changing the default for stem lengths in Parameters (under the Symbol menu) will 
make the change faster, more precisely, and will change all notes at once.  Before using this feature, 
look through the menu items to see if another feature will accomplish the same thing.  

Even so, some creative results can be achieved with this feature.  Some interesting effects come from 
the fact that the logic of a graphic will remain in place even though the graphic might be changed or 
removed.  For example, you can Alt or Option click on all the bar lines in a piece and delete them.  
This is different from deleting the bar lines using the Bar Line menu option.  Even though the bar 
lines are not printed on the screen or on a hard copy, they still do exist and will be counted in bar 
numbering, repeats will be honored, and the Go To Bar… will locate the correct invisible bar.  This 
could be useful when working on non-measured musics such as plain chant, spatial, or mensural 
notation. 

Edit: 
Enable Duration Edits 

Enable Duration Edits, when checked, allows more choices in the Piano Window for modifying 
notes.  The additional options (note duration symbols, tuplet, and kill) are intended for correcting 
OMR (Optical Music Recognition) errors in scanned music.  They should not be used for most music 
editing since changing the note values or killing a note will also change the length of a measure.  
Misusing this feature is the most common source of errors in data structure and may cause 
unexplained graphics or crashes.  Select Enable Duration Edits from the Edit menu again to disable 
this feature.  
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Edit: 
Shortcut Keys  

Shortcut Keys is used to define keyboard equivalents for Lime menu options.  To set a new shortcut 
hold down the Control key (Windows) or the Command key (Macintosh) and select that menu item.  
In the dialog that appears, enter the key or number you want associated with that menu item; 
optionally you can specify that the Alt must be used as well  After you do this, you can choose the 
menu option by pressing Control or Command  (and Alt, if so specified) and typing the letter.  This 
is often more convenient than using the mouse to select the menu option.  Control Keys or 
Command Keys cannot change some of Lime's keyboard equivalents. 

To set a new keyboard equivalent for the piano window, hold down the Control key (Windows) or 
the Command key (Macintosh) and click on a Piano Window icon.  In the dialog that appears enter 
the key you want associated with that item.  You can define shifted keys separately from un-shifted.  
After you do this, you can choose that Piano Window item using the computer keyboard.  Lime 
comes with settings for Piano Window shortcuts that are described below and shown in the 
Summary of Keyboard Shortcuts at the end of the manual.  

This is a list of the unchangeable keyboard equivalents for menu items (this does not apply if the Alt 
key is also used). 

Macintosh users: 

Keys Menu Equivalent Keys Menu Equivalent 

Command-S File/Save  Command-] Page/Next Page  

Command-Q File/Quit  Command-[ Previous Page  

Command-X Edit/Cut  Arrow down Next Part or Voice  

Command-C Edit/Copy  Arrow up Previous Part or Voice  

Command-V Edit/Paste  Arrow left Next Note  

Delete Edit/Clear  Arrow right Previous Note  

Command-. Hear (period) Command-, Annotation Placement (comma) 

Command-0 through Command-9 Hear/Modify Playback  

You can also designate Control Key equivalents by checking the box Use Control Key. 
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Windows users: 

Keys Menu Equivalent Keys Menu Equivalent 

Control-S File/Save  Control-] Page/Next Page  

Control-Q File/Quit  Control-[ Previous Page  

Control-X Edit/Cut  Arrow down Next Part or Voice  

Control-C Edit/Copy  Arrow up Previous Part or Voice  

Control-V Edit/Paste  Arrow left Next Note  

Delete Edit/Clear  Arrow right Previous Note  

Command-. Hear (period) Command-, Annotation Placement (comma)  

Control-0 through Control-9 Hear/Modify Playback  
 

 

Edit: 
Options 

 

 

Options under the Edit menu allows you to control various Lime editing options.  Most of them are 
self-explanatory.  
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Windows users: The MIDI options allow you to say if your MIDI synthesizer should be used to play 
the notes.  Two related features are MIDI Input and MIDI Output under the Hear menu. 

Mac users: The first three options relate to MIDI playback.  Lime selects which option that best 
suits your setup when it launches; MIDI Manager, OMS, or QuickTime.  The selected option 
changes if you change your setup using Extensions Manager or by removing or adding these items to 
the system folder.  

Select Make Sound for MIDI Input if the computer should output sound when it gets input from 
the music keyboard.  If possible, you should set up your music keyboard so that it does not 
automatically make sound when you play a note -- instead, the music keyboard only sends MIDI 
information to the computer, and then the computer in turn requests the synthesizer to play.  This is 
called “local control off” in MIDI terminology; it lets you be sure that the computer is really 
processing your keyboard playing. 

Interpret 3 Adjacent Keys on the Keyboard as a Rest allows the user to indicate a rest on a MIDI 
keyboard by playing three adjacent keys.  This is much faster than using the mouse and clicking the 
rest bar in the Piano Window.  The user can play notes on the keyboard and rests. 

Lime will automatically put clefs, key signatures, and Duplicate At Each System annotations at 
each system break; the clefs, key signatures, and annotations are automatically removed when you 
combine systems.  You have the option of leaving clefs and key signatures at each system (this is 
most common) or removing them (you might do this if you have a system break in the middle of a 
measure, for example).  If for some reason you want no clefs or no key signatures automatically 
inserted at system breaks you can specify this using the Options dialog.  This will only affect new 
system breaks you add to the piece; you will need to use Delete in the Clef and Key dialogs (under 
the Symbol menu) to get rid of clefs and keys at existing system breaks.  

Lime automatically prints the file name at the bottom of each page.  Print File Name on Each Page 
will turn this feature on and off. 

You can turn off the automatic printing of all triplet numbers in the music (as well as all other tuplet 
numbers) by using the tuplet printing option.  See the description of Hide Tuplet (under the Note 
menu) if you want to turn off the plotting of the tuplet number on an individual note. 

Some users find it easier to use the space bar to advance to the next note when entering lyrics.  
Switch Tab and Space for Lyrics allows you to switch the meanings of the tab key and the space 
bar.  With this option checked the space bar will move the annotation cursor to the next note.  The 
tab key will type a space.  

The page numbering and measure numbering options allow you to specify the starting page number 
and the starting bar number; this is useful if this piece will be part of a larger collection of pieces.  
You may select if Lime should print a bar number at the beginning of the first system.  (To turn 
measure numbering on or off in other parts of the piece, use Bar Line under the Symbol menu.)  
Options allows you to turn off the printing of page numbers, and to turn off the printing of the piece 
name and date on the first page of your music.  
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If you have the Sonata® font installed on your operating system, and if you select Sonata in 
Options, Lime will use that font for most musical symbols.  You can use Options to switch between 
the Sonata and the Marl and Tufa fonts at any time without affecting your piece.  Some Lime users 
edit with the Marl and Tufa fonts, and switch to Sonata only when they are ready to print.  (The 
Sonata font is not distributed with Lime; if you want to use it, you must purchase them separately.)  
See the description of Parameters (under the Symbol menu) for more ways to change Lime’s fonts.  

Options also allows you to control basic note spacing parameters.  By changing the note spacing 
parameter, you control the relative amount of space left after long notes compared to the amount of 
space left after short notes.  If you use a larger note spacing parameter (the range is 0 to 1) then long 
notes will have increasingly more space left after them than short notes.  If you use a very small note 
spacing parameter, long and short notes will have about the same amount of space after them.  If you 
have too many notes on a system, then Lime has no choice but to place the notes as closely as 
possible; the note spacing parameter only has effect for less dense music.  By default Lime uses 
values which are considered standard for most printed music, but you may have a particular piece 
with different requirements.  Often sparse music (music with few notes on each system) looks best 
with a larger note spacing parameter. 

No Change to Notes is used when you are adding text or adjusting layout, but do not want to change 
any of the notes in the piece.  When you have No Change to Notes selected, the MIDI keyboard and 
the screen keyboard is disabled, and other options that would change the notes are disabled. 

Most of the Options information is kept separate for the score notation context and the parts notation 
contexts.  This means you can have different specifications for the score and the parts. 
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Context Menu 

Context: 
Previous Notation Context/Next Notation Context 

The Previous Notation Context and Next Notation Context menu allows you to switch to the 
previous notation context or next notation context without having to open the Part Extraction 
dialog.  The order of notation contexts is the same as the order in the Part Extraction dialog.  When 
Lime switches notation contexts the position of the cursor (what measure it is in) is maintained.  

Context: 
Part Extraction 

Part Extraction is used to create “notation contexts.”  Notation contexts keep track of printing 
information for the score and the individual instrument parts of your piece.  Initially, your piece will 
have only the score notation context; this notation context contains all the parts.  First input all the 
notes in the score notation context; once the score is complete, use Part Extraction to create more 
notation contexts: one notation context for printing each individual part.  

Each notation context keeps track of all its own parts.  It also keeps track of the number of measures 
in each system, page turns, staff drags, Parts and Voices information (under the Voice menu), and 
annotations.  For example, your orchestra score will have page turns in different places than the flute 
part.  In the orchestra score both clarinet parts may print together on one staff, but for the players 
there are two separate clarinet notation contexts, each with one of the clarinet parts printing on its 
own staff. 

When you choose Part extraction under the File menu, you will be shown a list of all the existing 
notation contexts on the left, and a list of all the parts on the right.  To select a notation context from 
the list on the left, just click on the notation context name.  The parts blackened on the right are the 
parts that are present in the notation context selected on the left.  Click on the names of parts on the 
right to toggle them present or not present in the notation context. 

To change the name of a notation context, click the notation context name on the list on the left, and 
then type the new name.  

Examples of notation contexts:  
 

Orchestral piece with “Flute II” notation context: 
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Orchestral piece with “Flute/Violin” notation context: 

 
 

Quartet with “score” notation context: 

 
 

To make a new notation context, click the New Notation Context button.  Do not do this until you 
have completed the score -- and until after you have studied the examples in the back of this manual.  
After you click the New Notation Context button, then you will need to type a name for the new 
notation context, and choose the parts which will be present in that notation context.  When you have 
finished choosing the parts for a new notation context, you will be asked for a preferred number of 
systems per page, and an approximate density for the music in the new notation context.  You will 
also be given the option of copying system break locations from the score notation context (using 
new page turn locations), or copying both system breaks and page turn locations from the score 
notation context.  After you create a notation context you may decide you do not like the system 
break locations or the page turn locations; you can change them using options under the Page menu.  

To edit your piece in a given notation context, click on the notation context name in the list on the 
left, then click the Done button (or press Return). 

To switch between Notation Contexts without using the Part Extraction Dialog, use Next 
Notation Context or Previous Notation Context.  When Lime switches notation contexts the 
position of the cursor (what measure it is in) is maintained.  
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Page Menu 
The Page menu allows you to change pages, set page turn locations, set the number of measures on 
each system, and Insert and Delete Measures. 

Some operations in the Page menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these 
Page menu operations.  

Page: 
Previous Page 
Next Page 

Previous Page and Next Page are show an adjacent page in the Music Window.  These menu 
options will not interrupt playback, if the Hear option is in use. 

Page: 
Go To Page… 
Go To Bar… 

Go To Page and Go To Bar are used move the cursor to a specified page or bar.  When Go To Page 
is used the cursor will advance to the first bar of that page.  If Go To Bar is used, the cursor will 
advance to the first note of that measure (the note just after the specified bar line). 

Page: 
Next Rhythm Error 

Next Rhythm Error is for use with music from SharpEye Music Reader® or other OMR (Optical 
Music Recognition) sheet music scanning programs.  When you choose Next Rhythm Error, Lime 
takes you to the next bar with a red rest.  This is a convenience, but not a substitute for careful 
proofreading of your music.  See section III: Hints and Examples for a description of features and 
techniques for correcting errors in scanned music. 

Page: 
Split Page 
Add to Next Page 

Split Page and Add to Next Page are used to split one page into two pages, or to move the 
remainder of a page to the next page.  You also use Add to Next Page to combine two pages; i.e.  
add the entire current page to the next one.  This is done when you choose Add to Next Page when 
the first note of the current page is selected.  This allows you to change where the page turns happen, 
to avoid having overcrowded pages, or to put page turns at a place convenient for the performer. 

If you want to put a page turn in the middle of a system, you must first split the system in two (using 
Split System under the Page menu), and then use Split Page. 
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Page: 
Split System 
Add to Next System 

Split System and Add to Next System are used to split a system into two systems, or to move the 
remainder of the system to the next system.  Be sure you have the proper note selected (flashing) 
before you use this.  (The note you select will be the beginning of the next system.)  You do not need 
to wait for the screen to update before you use Split System or Add to Next System.  Also, you can 
do all the split points on a page at once by using this option with Note Group Select. 

When you split a system, Lime automatically adds the clef and key signature at the beginning of the 
new system.  You can avoid this automatic action with Options (under the Edit menu).  Lime also 
automatically copies Duplicate At Each System annotations onto the new system; see the section on 
Duplicate At Each System for more information. 

When you create a piece, you are asked how many measures per system and how many systems per 
page you would like.  When you create new notation contexts to print the parts of a score, you are 
also asked questions about the systems.  It is best to wait when creating the part notation contexts 
until you have finished the score; this way Lime can analyze the note density better, and can consider 
consecutive measures of rests as wide as a single measure.  See Part Extraction under the File menu 
for details. 

Page: 
Systems 

   

 
 

Systems will change on what measures systems and pages start.  Systems starts at the top of the 
current page and goes to the end of the piece; it does not affect systems on previous pages.  
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In Systems you specify a preferred number of staves per page, and an approximate density for the 
music.  You may need to experiment to find the values most appropriate for your type of music.  

You can also specify the exact number of measures per system and systems per page by choosing 
fixed system and page breaks. 

If you are not in the score notation contexts, Systems gives you the option of copying system start 
locations from the score (with new page start locations) or copying both system and page start 
locations from the score. 

At the bottom of the dialog box is an option that allows you to specify each system and page break 
individually.  Numbers represent the measure at which the next system or page will start.  Commas 
indicate system breaks, page breaks are indicated by semi-colons.  The combination “1,5;9,13” will 
result in system breaks at bar 1 (the first system), bar 5, a page break at bar 9, and another system 
break at bar 13. 

Systems tries to keep approximately the same density of notes on each system, and the same number 
of staves from page to page.  Systems can be used to get the systems to start generally on the right 
measures; then you can correct problem spots by using the Split Systems and Add to Next System. 

Page: 
Insert Measures 
Delete Measures 

Insert Measures allows you to insert new measures, and it allows you to set the initial number of 
measures per system and number of systems per page for the new measures.  You use Insert 
Measures to create new pages also.  If you insert measures while on the last system, and choose At 
End of System, and add more measures than would fit on that system, they will be added on a new 
page.  Use Next Page to move to the new page.  Insert Measures needs to be used each time you 
want to add measures in a new time signature or if you want to add a pickup measure.  Before you 
use Insert Measures, select the note before which the insertion is to begin. 

Normally, you select All Staves when using Insert Measures.  Current Voice Only is rarely used 
with Insert Measures, but it might be used in situations where two voices in the same system are 
written in different time signatures.  If you use this, be careful with the number of measures per 
system and number of systems per page you specify -- you want to be sure that the ends of the 
systems line up for all of your voices!  A related feature is the Kill symbol and duration edits 
associated with the Enable Duration Edits menu option.  For more information, see the examples in 
the back of this manual. 

Current Voice Only in Insert Measures is not used in making pieces that have different numbers of 
voices in various parts of the piece.  In Lime, all voices must exist at all times in the whole piece.  
When a voice is not playing it should have rests, and End Voice in Parts and Voices (under the 
Voice menu) is used to stop printing the voice for parts of the piece.  See the description of Parts 
and Voices for more information. 

Time signatures are not automatically added to your music with Insert Measures; use Time 
Signature (under the Symbol menu) after you have inserted the measures to do this. 
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Delete Measures allows you to specify the number of measures you want to delete.  Before you 
select delete measures, make sure you have selected the first note in the first measure you want to 
delete (the note should be flashing). 

Be careful when you specify the number of measures to delete.  Pickup measures and unnumbered 
measures are counted as measures here. 

Normally, you select All Staves when you use Delete Measures.  If you do not choose All Staves, 
you might end up with unequal-length voices (differing in the total number of measures or beats).  

Page: 
Show OMR Image 

Show OMR Image can only be used with music from SharpEye Music Reader® or other OMR 
(Optical Music Recognition) sheet music scanning programs.  When you choose Show OMR 
Image, Lime's music window will switch to showing you the scanned bitmap image.  If you choose 
the menu option again, or click anywhere in the music, it will switch back to showing you the Lime 
music.  This can be convenient in the scanning error correction process.. 
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Voice Menu 
The Voice menu allows you to record notes from a music keyboard in real time.  It allows you to 
move forward and backwards in a part, move between voices within a part, create new parts and 
voices, delete parts, begin and end voices, rename parts, and control which staff each part prints on. 

Some operations in the Voice menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these 
Voice menu operations. 

Voice: 
Previous Part or Voice, Next Part or Voice 

Previous Part Or Voice (or the up-arrow key) is used to select a note from the previous part, or the 
previous voice on the same part.  Next Part Or Voice (or the down-arrow key) is used to select a 
note from the next part, or the next voice on the same part.  These menu options are useful when 
there are several parts (or several voices belonging to the same part) on one staff which share note 
heads or rests.  You can click on a shared note head and see which part and voice is selected by 
looking at the title bar of your music window.  You can use Previous Part Or Voice or Next Part 
Or Voice to get to the other part (or voice) which shares the note head. 

Voice: 
Record 

 
 

Record is used to record notes from a music keyboard in real time.  Record automatically 
determines the notated note lengths from your timing as you perform on a keyboard.  Record should 
be used with a MIDI keyboard; it is possible to use Record with the mouse and the keyboard on the 
screen, but it is too difficult to be practical. 
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Before you select Record from the Voice menu, select the first note or rest that is to be replaced by 
the results of the recording.  After you choose Record, you will be able to choose a metronome 
speed, and a beat for the metronome.  The metronome beat does not have to match your time 
signature; often an eighth metronome beat works well for recording 4/4 time.  Shorter beat values 
and slower metronome speeds make it easier to play accurately enough so that Lime properly notates 
your note lengths. 

If you like, you can provide the metronome beats yourself, using the space bar or a MIDI foot 
switch. 

Before you play your notes, you can specify your fastest note value, and you can specify if you have 
triplets or mixed triplets.  If your fastest note is a fourth of a metronome beat, you will have to play 
accurately; you may want to make your fastest note half of a metronome beat or a whole metronome 
beat.  If you have troubles with timing, try slowing down the metronome and using a shorter 
metronome beat value. 

Once you have selected the metronome speed and the fastest note, you can start playing.  Often 
people will play extremely staccato notes in an attempt to play accurate timing; this is not necessary 
and does not help Lime extract timing.  It is best to play normally, and just try it a few times.  After a 
little practice, you will be able to transcribe music much more quickly using Record than you can by 
playing one chord at a time (as you did when you tried the example in the introduction). 

When you use Record, Lime measures the value of a note in the following manner: The note starts at 
the instant it is struck, and ends either at the beginning of the beat after the note is let up, or when the 
next note is struck, whichever comes first.  Lime will automatically notate rests if they occur at the 
start of beats, so any rest as long as (or longer than) a metronome beat will be notated as a rest.  If 
you are using a half note metronome beat and you want to play a dotted quarter followed by an 
eighth rest, you will need to specify the rest explicitly.  You can do this by playing any three adjacent 
notes (e.g.  C, C-sharp, D) on the keyboard at the time the rest occurs.  Alternatively, you can double 
the speed of the metronome and use a quarter note metronome beat; then the rest will be notated 
automatically.  The metronome beat value does not have to match the time signature. 

When you have finished playing your notes, click the Finished Playing button or press Return.  
Once the screen finishes updating (the cursor goes back to normal) you will see your newly recorded 
notes.  You can start another Record or do other editing without waiting for the screen to update. 

Record chooses accidentals based on the key signature; you can change the accidentals it prefers by 
selecting Default Accidentals (under the Note menu) before using Record.  Also, after you have 
finished using Record and the screen updates, you can use Note Group Select to specify which 
notes are slurred, staccato, tenuto, etc.; see the introduction for more information on Note Group 
Select. 

Voice: 
Note Entry 

Note Entry engages the note entry cursor.  See the section above for more information about the 
note entry cursor. 



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 75 of 206 

Voice: 
Parts and Voices 

Lime uses a hierarchy of Parts and Voices, which allows great flexibility when designing a musical 
score.  The term “Part” is used for a single musical instrument.  The term “Voice” is used to describe 
a line (usually indicated by stem direction) within a part.  In most cases each part will have a single 
voice and correspond with a single staff.  In some cases two single voice parts will share a staff.  
Instruments capable of multiple voices are a single part, but may have several voices that print on a 
single staff, or are divided between two staves.  A trumpet on one staff is a single part, single voice, 
and single staff.  Two flutes printing on a single staff (as would occur in an orchestra score) are two 
single voice parts, on a single staff.  A guitar is a single part printing on a single staff, but will 
usually have two and sometimes three voices.  A piano is a single part spread over two staves.  It will 
have at least two voices; one voice is used for the right hand and one for the left hand.  It may have 
as many as four voices; two voices are used for the right hand, and two for the left hand, as in the 
case of Bach's four part fugues.  

 

 
 

Parts and Voices allows you to choose which staff each part should print on in the notation context 
you are editing.  It also allows you to create new parts and voices, name parts, combine several parts 
or voices on a single staff, stop and start printing parts and voices, and control overall stem directions 
on a part.  You can specify different staff sizes, the number of staff lines (for example, a single staff 
line for percussion parts), and to move a voice between the two staves of a single part that uses two 
staves (such as a piano grand staff).   

Before you select Parts and Voices, make sure your selected note (the flashing note) is at the right 
place in the music.  Lime orders the staves on the page according to their position in the left-hand 
window.  Each line is labeled by the staff number.  
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If two voices appear together, they will print on a single staff.  You can combine two staves using 
Together, or split a multi-voice staff into several staves using Separate.  You can reorder staves 
using Move.  You can get rid of changes to the staff arrangement by using the Same… button.  You 
can stop printing a part at this point in the music by choosing Don't Print.  

Uniform Stem Directions is used to force the stem directions either up or down regardless of the 
conformity of music.  In some types of instrumentation (e.g.  piano) two voices may share a stem 
when the duration of the two voices are identical (e.g.  all quarter notes).  If Uniform Stem 
Directions is not selected Lime will combine these voices on one stem when it is logical to do so, 
and will split them, one stem up, one down, when their durations differ.  For other types of 
instrumentation (e.g.  vocal parts) the stem direction should never change.  Soprano should always 
go up, Alto always down, regardless of shared rhythms.  

Uniform Stem Directions can be turned on an off at any time without compromising the actual 
pitches.  For this reason, some users find it less confusing to enter music initially with Uniform 
Stem Directions turned on.  After the music has been entered, Uniform Stem Directions can be 
turned back off so that stems can be shared as they should.  

Most staves have 5 lines; you can specify a different number of staff lines with Staff Lines.  (For 
example, 1 line is common for percussion parts.  You can enter 0 for a staff with no lines.) 

Staff Size specifies the distance between staff lines in points (1/72-inch units).  If you type a smaller 
value in Staff Size, then the staff will be drawn smaller with smaller notes; for example, a cue part 
printed above a piano part.  For a standard cue size enter the value 3.  For a standard staff size, enter 
5.  For Sonata font, enter 6. 

Choose Tab or Stem Tab for guitar tablature notation.  The number of staff lines will automatically 
change to 6, one line for each string of the guitar.  It might be easiest to enter all the notes in standard 
notation first, and then, after all the notes are in, use Parts and Voices on the part's first note to 
change to tablature notation.  In tablature notation Lime will automatically select a string for each 
note; Tablature String (under the Note menu) allows you to override Lime’s automatic algorithm 
and lets you select the string.  Parameters (under the Symbol menu) allows you to change the 
tuning of the strings.  Changing the tuning of each string and the number of lines on a staff is used to 
create tablatures for banjo, mandolin, and Chapman Stick notation.  As an alternative to tablature 
notation, you can use the guitar fret grid notation, as shown in the example in the back of this 
manual. 
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Choose Piano Tab for piano tablature notation.  This converts the standard five line staff into a 
piano tablature, a graphic representation of the piano keyboard using lines and spaces.  The spaces 
correspond to the white keys on the piano and the lines to the black keys.  To the left of the piano 
tablature is a sideways view of a piano keyboard matching keys with lines and spaces.  The Piano 
Tab has no key signature or accidentals.  It also does not require clefs.  However, there are two 
versions of the Piano Tab; one for notes found in the right-hand side of the piano keyboard (C4 to 
E5), and one for the left hand (F2 to B3).  The right-hand version of Piano tab is used when you 
choose Piano Tab RH.  If you select Piano Tab LH, then the left-hand version is used.  Ledger 
lines are used for notes that fall outside of either tablature staff.  These ledger lines follow the same 
white/black key pattern established by the right-hand and left-hand tablature.  (It is possible to drag 
these two-style tablatures close enough together to achieve a reasonable representation of a 3 octave 
contiguous piano keyboard.)  For sections of music where most of the notes fall outside the piano 
tablature, Transpose (under the Note menu) may be used to move the passage within the keyboard 
range.  A similar shift may be entered using Parameters (under the Symbol menu).  

In some cases you might want a staff with no notes or rests on it.  In such cases, assign a voice to the 
staff, and use Hide Rest (under the Note menu) to avoid plotting the voice's rests.  

Voice: 
Voice to Staff Above/Below 

Use Voice to Staff Above/Below to switch a voice between staves.  This feature is commonly used 
in piano scores when a voice moves between the treble and bass staves.  Before using this feature, be 
sure that there are at least three voices to share between the two staves.  Two of the voices must 
remain on a staff; voice one for the upper staff, voice two for the lower staff, to maintain the 
existence of that staff.  The third voice can then switch between the two staves. 

Continue Beaming can be used in conjunction with Voice to Staff Above/Below to achieve a voice 
that switches between staves but has a continuous beam. 

Voice: 
Staff Drag 

Staff Drag is usually used in crowded orchestral scores; it is an easy way to avoid overlaps of notes 
or symbols between staves.  To relocate a staff (while edit cursor is active) press Control (Windows) 
or Command (Macintosh) and click on a line in the staff and drag.  (Be careful not to click near a 
rest, note, or accidental.) 

Staff Drag should not be overused.  It is available as an exception to the default separation between 
systems and voices.  To set the default separation between systems and staves use Parameters under 
the Symbol menu.  Locate STAFF LINES, MARGINS, NOTE SPACING in the upper window, then 
find default vertical distance between systems, and default vertical distance between this voice and 
next.  Change these values to adjust the default separation between systems and staves.  Staff Drag 
can then be used for the exceptions where the default value is insufficient.  
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Three types of staff drag are available in Lime.  In the first type, the dragged staff will relocate only 
in the system where it is dragged.  In the second type, the dragged staff, as well as the staves below it 
in the system, will relocate; the second type of staff drag does not affect subsequent systems.  In the 
third type, the dragged staff will relocate in the system where you drag it and in all subsequent 
systems for the rest of the piece.  Staff Drag… (under the Voice menu) allows you to choose 
between the three types of Staff Drag. 

Care must be taken when using the third type of staff drag since staves later in the piece will also be 
relocated.  If, for example, staff 3 has already been relocated to a higher position on page 8 and 
Relocate Staff for Remainder of Piece is selected, and staff 3 on page 2 is dragged, staff 3 on page 
8 will be moved an additional amount (the two drag distances will be summed). 

Clear Staff Drag (under the Edit menu) will remove the effects of previous Staff Drags on the staff 
with the selected (flashing) note.  If Clear Staff Drag is dimmed, then the staff has not been 
dragged.  Clear Staff Drag may also be used with Note Group Select; this will remove the effects 
of Staff Drags on all the staves with selected notes.  Parameters (under the Symbol menu) offers 
another way of setting spacing between staves. 

Voice: 
Highlight Voice 

Highlight Voice will dim all notes that are not part of the same voice as the currently selected note 
(the flashing note).  This is useful when there are several voices on a staff and you want to see which 
notes belong to which voice.  It is also useful for Note Group Select; if you have Highlight Voice 
selected, then only notes from the one voice are selected with Note Group Select. 

You can see the voice name of the currently selected note by looking at the title bar at the top of your 
music window. 

Voice: 
Voice on Channel 

Voice on Channel allows you to specify which MIDI channel should be used to play the notes on a 
voice, and it allows you to specify that microtonal pitches are to be sent to your synthesizer.  Certain 
MIDI synthesizers can play microtonal pitches from Lime.  

You must select a note (make it flash) before you use Voice on Channel; Voice on Channel will 
affect the voice to which the selected note belongs.  Voice on Channel will set the initial MIDI 
channel for the voice; you can change the MIDI channel at any point in the piece by typing a 
“channel” text annotation.  See the section on Control Annotations for more information.  

Lime can play microtonal tunings (more than just the equal-tempered scale) on certain MIDI 
synthesizers.  Voice on Channel will give these choices for sending pitches to your MIDI 
synthesizer: 

Standard MIDI: No microtonal pitches from Lime.  You might be able to retune your synthesizer 
by pressing buttons on the synthesizer's front panel, but the microtonal accidentals 
and special tunings you specify in Lime will have no effect. 
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Yamaha FB-01: Lime will use the FB-01's System Exclusive capabilities to play exact microtonal 
pitches. 

Pitch Bend: You can use this option if the following conditions are met: Your synthesizer is 
set up for MONO mode (or maximum notes per channel = 1 in POLY mode).  
Pitch bend on your synthesizer affects only one channel (no “global” pitch bend), 
and if you can set the range for pitch bend to ±100 cents (±1 half step).  Lime will 
use Pitch Bend to adjust pitches on your synthesizer, so you will hear exact 
microtonal pitches. 

No MIDI: No MIDI output. 

For more information on Lime's exact pitches, see the sections on Tuning (under the Hear menu), 
Special Accidentals (under the Note menu), and Higher and Lower (under the Hear menu). 

When you use MIDI synthesizers with microtonal tunings, an increased amount of information needs 
to be sent to your synthesizer while the music is played.  Since MIDI has a limited communications 
speed, the playback tempo may stumble on fast passages with large microtonal chords.  
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Note Menu 
The Note menu gives you control over the accidentals and other parameters of individual notes and 
rests. 

Some operations in the Note menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these 
Note menu operations. 

Note: 
Previous Note, Next Note 

Previous Note (or the left-arrow key) and Next Note (or the right-arrow key) are used to move to the 
previous note and the next note in a voice.  

If your computer keyboard does not have a left-arrow key or right-arrow key, you will probably want 
to use Control Keys (Windows) or Command Keys (Macintosh) (under the Edit menu) to make a 
keyboard equivalent for Previous Note and Next Note.  

Note: 
Show Accidental 

Show Accidental is used to toggle the display of the accidental on the selected note.  Lime will 
normally not print accidentals if the accidental is present in the key signature or if it occurred earlier 
in the measure; using Show Accidental, you can make reminder accidentals.  If the accidental is 
already being displayed on the current note, Show Accidental will have a checkmark next to it; 
choosing Show Accidental will not print the accidental even if it would be required by standard 
notation rules. 

Show Accidental can be used with Note Group Select.  Select a group of notes, and then select 
Show Accidental once to show accidentals on all the notes, and again to stop showing accidentals on 
all the notes. 

Note: 
Default Accidentals 
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Default Accidentals is used to specify an accidental for each of the 12 notes in an octave.  These are 
the accidentals Lime uses when you play new notes.  Lime presets the Default Accidentals 
according to your key signature; when you edit your music, you can change the list of accidentals if 
you have unusual accidentals.  In addition, you can control exceptional accidentals on individual 
chords by using the accidental symbols in the Piano Window (see the Piano Window section for 
more details). 

Usually Default Accidentals is used before you enter notes using the note entry cursor or Record 
(under the Voice menu); it has no effect on existing notes.  If you use Default Accidentals with 
Note Group Select, then the accidentals of the selected notes will be changed to their default 
accidentals. 

Note: 
Special Accidentals 

 

 
 

Special Accidentals will add a list of microtonal accidental symbols to the Piano Window.  You 
can choose these symbols (and combinations of these symbols with standard accidental symbols) for 
notes in your piece.  If you make a mistake choosing symbols, click CLEAR.  If you want to apply 
the symbols to the note that is flashing, click APPLY.  (APPLY also works with Note Group 
Select.)  If you want to play a new note with a special accidental, select the special accidental, then 
play a white key on the music keyboard.  (When you use standard accidentals play black keys for 
sharps and flats; but with special accidentals, play the white key which corresponds to the pitch you 
want printed.) 

If you have set up your MIDI synthesizer properly, and if you have selected the proper options in 
Voice on Channel (under the Voice menu), then the special accidentals will affect the pitches you 
hear through your MIDI synthesizer.   

If you are interested in making up your own accidental symbols, you can design new symbols using a 
font editing application (which you purchase separately from Lime).  You can add these new 
symbols to the special accidentals choices using Parameters (under the Symbol menu).  You will 
need to supply both the new accidental symbol (the font, the font size, and the offsets) and its 
meaning (how many cents sharp or flat) in Parameters. 

An example using Special Accidentals is given in the back of this manual. 
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Note: 
Transpose 

Transpose is used to change individual notes or a group of selected notes and the playback pitch by 
any given number of half steps.  If you want to change the key of a part and also transpose the music 
that has already been entered to that key, you can do this using Key Signature (under the Symbol 
menu).  This is typically used when preparing a transposed score. 

Enter a negative value to transpose down.  Enter 12 (or -12) to transpose up (or down) an octave.  
Transpose is most commonly used with Note Group Select; then all the selected notes will be 
printed and played the given number of half steps up or down. 

Note: 
Note Head Color 

Note Head Color will change the color of a note displayed on the screen.  Select a note, or group of 
notes that are to be changed.  Choose Note Head Color and click on the color you want the notes to 
be.  You can customize any color by clicking on it while holding down the Shift key.  Windows 
users: When customizing colors, choose one of the solid colors.  Use a white window background 
when you work with colors.  You can choose the window background color in the Windows Control 
Panel. 

Note: 
Tablature String (Higher, Lower, Default) , Tablature Thumb 

Tablature String is only used with notes in guitar tablature notation.  Lime will automatically select 
a string for each note in tablature notation; Tablature String allows you to override Lime’s 
automatic algorithm and lets you select higher or lower string.  Tablature String; Default will 
return the note back to the string originally selected by Lime. 

Tablature notation can be selected for any voice by using Parts and Voices (under the Voice menu).  
The tuning for the strings can be changed using Parameters (under the Symbol menu).  An 
alternative to tablature notation is the guitar fret grid notation, as shown in the Guitar Chord Symbols 
example in the back of this manual. 

The Tablature Thumb is used with Note Group Select and allows you to point out notes on the 
tablature that are to be played with the thumb.  These notes will be printed differently (e.g.  
boldface).  Use Parameters (under the Symbol menu) to change the character of notes printed as 
Tablature Thumb. 

Note: 
Hide Tuplet 

Hide Tuplet is used to stop Lime from automatically printing a tuplet number above, below, or to 
the left of a note.  Hide Tuplet is used if you want to make your own tuplet bracket (using Tuplet 
Bracket under the Annotation, Line menu), or if you want to leave out Lime’s tuplet number for 
some other reason. 
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Hide Tuplet is often used with Note Group Select.  If you do not want Lime to print any tuplet 
numbers anywhere in your piece, you can do this using Options (under the Edit menu); you don’t 
need to use Hide Tuplet on every note. 

Note: 
Hide Rest 

Hide Rest is used to avoid printing the selected rest.  Sometimes it is preferable not to print certain 
rests; either the rests are implied by the music or they make the music more difficult to read.  Hide 
Rest is common when you have complex rhythmic patterns involving several voices on one staff. 

A hidden rest is not actually removed from the music; it is just no longer printed.  You can still select 
the rest by clicking where it would normally appear, or by clicking the note before the rest and then 
using Next Note (under the Voice menu). 

If you have chosen Hide Rest for a rest, there will be a checkmark indicating this in the menu.  
Selecting Hide Rest again will disable it; then the rest will plot normally (once the screen is up to 
date). 

In some situations Lime will automatically not print rests, even if you do not use Hide Rest.  For 
example, if two voices are printing with the same stem direction on one staff, and one voice has a 
quarter note while the other has a quarter rest, then the quarter rest will not be printed.  In this 
situation you have to use annotations to print the rest, if the rest is desired.  (The annotations 
associated with the rest will not be printed if the rest is not printed, so add the annotations to the 
quarter note.) 

Hide Rest can be used with Note Group Select.  Select a group of rests, and then select Hide Rest 
once to hide all the rests, and twice to show all the rests. 

Note: 
Don't Combine Rest 

Don't Combine Rest is used to avoid combining several rests into a whole measure rest, or 
combining several measures of rests into a multi-rest.  Lime will always avoid combining rests if the 
rests have annotations (rehearsal marks, for example), if there are measures which have a different 
number of beats than the time signature, or if there are time or key signature changes.  If none of 
these are present, Don't Combine Rest can be used to tell Lime not to combine the rests. 

Lime will normally notate a whole rest symbol in any measure that is filled with only rests and no 
notes or annotations, as long as the measure has the same number of beats as the time signature.  For 
example, Lime will automatically notate a whole rest symbol for a measure containing five eighth 
rests if there is a 5/8 time signature.  To avoid this convention, you can select the whole rest and use 
Don't Combine Rest; then five separate eighth rests will appear.  

In some time signatures, such as 1/8 time, any use of whole measure rest symbols may be 
undesirable.  You can avoid all whole measure rests by selecting No Whole Measure Rests in Time 
Signature (under the Symbol menu). 
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Lime will notate a multi-rest symbol if there are several complete measures of rests in a row.  Lime 
will not use this symbol if Don't Combine Rests was used on any of the rests, or if there are Parts 
and Voices specifications (under the Voice menu) in the measures, or if the staves have different 
time signatures. 

If you have chosen Don't Combine Rest for a rest, there will be a checkmark indicating this in the 
menu.  Selecting Don't Combine Rest again will remove the checkmark and (if possible) allow the 
rest to combine with other rests.  You must remove the Don't Combine Rest checkmark from all the 
rests that are to be combined. 

Don't Combine Rest can be used with Note Group Select.  Select a group of rests, then select 
Don't Combine Rest once to separate all combined rests, and once again to allow all the rests to 
combine. 

You do not need to use Don't Combine Rest if you want to replace a multi-rest with notes; simply 
select the rest, and start playing the notes which are to replace the rest.  Note replacement works the 
same way with combined rests as it does with any other notes or rests (see the introduction for more 
information on playing notes).   

Note: 
Chord Drag 

Chord Drag… allows you to choose between the two types of chord drag and vertical relocation of 
rests.  See the section above on Chord Drag for details. 

Clear Chord Drag (under the Edit menu) is used to undo the effects of previous Chord Drags, 
Vertical Rest Drag, and Accidental Drags on the chord with the selected (flashing) note.  If Clear 
Chord Drag is dimmed, then neither the chord nor the accidental has been dragged.  Clear Chord 
Drag may also be used with Group Select; this will remove the effects of Chord Drags, Vertical 
Rest Drags and Accidental Drags on all the selected notes.  
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Note: 
Internal Fields 

 

 

Internal Fields allows you to inspect or change many of the parameters that Lime stores for each 
note and rest.  Using Lime's various menu options normally changes these parameters; it should not 
be necessary to use Internal Fields to change them.  If you like, you can experiment with the 
parameters in Internal Fields, but save your piece before you start experimenting. 

The following paragraphs describe some of the information shown in Internal Fields; this 
information is included here for those Lime users who wish to experiment with Internal Fields.  

Lime keeps the playback duration of a note separately from the printed duration of the note.  In 
Internal Fields, the printed duration of the note is specified by lgval (log base two of the value, 
where 1 = whole note, 2 = half note, 3 = quarter note, etc.), by the number of dots, and by the two 
tuplet values.  The playback duration is given by length (10000 hex usually corresponds to a full-
length whole note) and ttn (time to the start of the next note on the voice, in the same units as 
length).  Staccato, tenuto, slur, and various options under the Hear menu affect the length and ttn 
values. 

Lime keeps the playback pitch of a note separately from the printed pitch of the note.  In Internal 
Fields, the printed pitch of the note is specified by mod7 (this is 7 times the octave plus 0 for c, 1 for 
d, 2 for e, 3 for f, 4 for g, 5 for a, and 6 for b) and acc (1 for double flat, 2 for flat, 3 for natural, 4 for 
sharp, 5 for double sharp).  A MIDI note number with a fractional part gives the playback pitch; 
pitches are kept to half-cent accuracy.  The playback pitch values are affected by Tuning and other 
options under the Hear menu. 
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Stem Menu 
The Stem menu gives you control over the stem direction and beaming of individual notes and rests. 

Stem: 
Stem Up, Stem Down, No Stem 

Stem Up and Stem Down are used to control the stem direction for the selected note, or the position 
of the selected rest.  No Stem is used to avoid plotting the stem and beam for the selected note. 

If you have chosen Stem Up, Stem Down, or No Stem for a note, there will be a check mark 
indicating this in the menu.  Selecting the stem control again will disable it; then stem direction will 
be decided automatically by Lime. 

Stem Up, Stem Down, and No Stem can be used with Note Group Select.  Select a group of notes, 
and then select Stem Up, Stem Down, or No Stem once to enable it on all the notes, and once again 
to disable it on all the notes. 

If all the stem directions on a voice are to be up or down, this can be specified with Parts and 
Voices (under the Voice menu); Stem Up and Stem Down need not be used. 

Stem: 
Slashed Stem 

Slashed Stem is used in conjunction with grace note to create acciaccaturas (grace notes with a slash 
through the stem).  You must first enter the grace note, then group select all grace notes that require a 
stem (select the first grace note of a grace note figure) and choose Slashed Stem. 

Stem: 
Stem Between Staves 

Stem Between Staves is used to make stems go between the two staves of a grand staff.  

A chord with a stem between two staves has some notes on the left-hand staff, and some on the right-
hand staff–but in Lime, the notes come from one voice.  If you have stem down chords, initially play 
the chords on the right-hand staff, then use Note Group Select to select the notes you want moved to 
the left-hand staff and use Stem Between Staves.  If you have stem up chords, initially play the 
chords on the left-hand staff, then use Note Group Select to select the notes you want moved to the 
right-hand staff and use Stem Between Staves. 

Before you use Stem Between Staves, you will want to study the example in the back of this 
manual. 
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Stem: 
Continue Beam, End Beam 
Continue Subbeam, End Subbeam 

Continue Beam and End Beam are used to control the beaming of individual notes.  Beaming Rule 
(under the Stem menu) is used to specify general rules for beaming; Continue Beam and End Beam 
are usually used in exceptional cases not covered by Beaming Rule. 

Continue Subbeam and End Subbeam are used to control subgroupings of notes under a main 
beam. 

These beaming controls affect the selected note; they may also be used on rests.  This allows you to 
start a sixteenth note beam over a sixteenth rest, or to beam over a sixteenth rest in the middle of a 
group of sixteenth notes.  Sometimes it is convenient to use Hide Rest (under the Note menu) 
together with beaming over rests.  For more information, see the examples in the back of this 
manual. 

You can use Continue Beam to ask Lime to beam over a bar line.  If you want a beam between the 
two staves on a grand staff, then the voice must jump between the two staves of the grand staff; see 
Parts and Voices (under the Voice menu). 

If you have chosen one of these beaming controls for a note, the beaming control will have a check 
mark next to it in the menu.  Selecting the beaming control again will disable it; then beaming will be 
decided solely by the beaming rule (see Beaming Rule below). 

Continue Beam, End Beam, Continue Sub-beam and End Sub-beam can be used with Note 
Group Select.  Select a group of notes, and then select the beaming control once to enable it on all 
the notes, and twice to disable it on all the notes. 

Stem: 
Default Beaming 

Default Beaming is used to reapply the default beaming to existing notes.  Use this feature to 
remove exceptions to the default beaming that are the result of using any of the menu items 
mentioned above. 

Stem: 
Beaming Rule 

Beaming Rule is used to specify a general rule for note beaming in a Lime piece.  Lime will 
automatically add a beaming rule for each time signature; you can edit this beaming rule by selecting 
the note immediately after the time signature and choosing Beaming Rule.  You may also change 
the beaming rule anywhere else in your piece, although it is most common to do so at the beginnings 
of measures. 
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Beaming Rule allows you to specify how many eighth-notes worth of notes are to be beamed 
together.  You can specify a pattern of eighth-note values; the pattern will repeat, starting over at 
each bar line.  For example, in 4/4 time, you would usually just type a single “2” for your beaming 
rule, indicating that groups of two eighth notes (or four sixteenths, or one eighth and two sixteenths, 
etc.) are beamed together.  In 7/8 time, you might type a “3” followed by a “4”, or a “4” followed by 
a “3”; it depends if you want each measure beamed in 3 eighths then 4, or 4 eighths then 3.  See the 
examples in the back of this manual. 

The beaming rule gives a general rule for beaming; exceptions can be handled using Continue Beam 
and End Beam (under the Stem menu). 

Note Group Select is not used with Beaming Rule.  Beaming Rule affects all notes on the voice (or 
on all parts and voices if you asked for All Parts and Voices) until the next Beaming Rule on that 
voice.  If you have two voices printing on one staff, one with stem up and one with stem down, you 
can have separate beaming rules for each voice. 

Stem: 
Tremolo Beam 

Tremolo Beam is used to make tremolos between two pitches.  If you want to make a tremolo on a 
single pitch, use the tremolo symbol in the Piano Window, not Tremolo Beam. 

It is a two-step process to make tremolos between two pitches.  First, you need to make two notes 
that are beamed together and have a special tuplet value.  Then you need to select Tremolo Beam. 

For example, if you want to indicate sixteenth notes alternating between two pitches for a half note 
duration:   

1) Play two sixteenth notes which have tuplet value “2 in the time of 8.”  (This value indicates that 
these two sixteenth notes actually take the place of 8 sixteenths.)  You may have to use Continue 
Beam and Continue Subbeam (under the Stem menu) on the first sixteenth note if it is not beamed 
to the second. 

2) Use Note Group Select to select the two sixteenth notes, and select Tremolo Beam.  This will 
change the appearance of the two beamed sixteenth notes to two beamed half notes.  

Stem: 
Swing Eighth Beam 

Swing Eighth Beam is used to make notes that appear as straight eighths, but play back as swing 
eighths.  In order to use this option, first enter your notes as quarter triplet followed by eighth triplet, 
or as straight eighth followed by straight eighth.  Either way it will work.  Then, Note Group Select 
the notes, and choose Swing Eighth Beam.  The notes will be notated as all straight eighths, but the 
playback durations (for the Hear option) will be quarter triplet followed by eighth triplet.   
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Stem: 
Modify Slur, Additional Slur, Modify Tie (On Top, On Bottom, Near Note Head, Hangs 
Right, Hangs Left, Only Left, Split, Dashed, With Pitch Bend, Grace Slur) 

Modify Slur/Tie is used to control the curvature direction for slurs and ties, create dashed slurs and 
ties, pitch bends, and hanging slurs and ties.  These only affect notes that are already slurred or tied 
(see the description of ties in the Piano Window section); notes that are not yet slurred or tied will 
not be affected by Modify Slur/Tie.  

Additional Slur allows you to include a second slur symbol for a note, e.g.  when a trill is within a 
long slur.  Use Additional Slur on notes that already have another slur. 

If you have chosen Modify Slur/Tie for a note, there will be a check mark indicating this in the 
menu.  Selecting the control again will disable it; then the slur/tie curvature direction will be decided 
automatically by Lime. 

Modify Slur/Tie can be used with Note Group Select.  Select a group of notes, and then select the 
slur/tie control once to enable it on all the notes, and twice to disable it on all the notes. 

Only use Modify Slur/Tie; On Bottom/Top if you do not like the default curvature direction of a 
slur or tie.  Use Modify Slur; Near Note Head for slurs ending at a stem, to have them drawn as 
near to the note head as possible.  Use Grace Slur to draw a slur appropriate for grace notes; this can 
be useful when slurring from a regular note to a nachschlag.  If required, detailed control over slur 
and tie location and shape can be achieved with Parameters (under the Symbol menu), or Allow 
Any Alt-Click (Windows) or Allow Any Option-Click (Macintosh) under the Edit menu.  

If necessary, the length of the dashes and the length of the gaps between the dashes for dashed slurs 
and ties can be changed with Parameters (under the Symbol menu). 

Modify Slur/Tie; With Pitch Bend is used to change standard slurs and ties into a pitch bend 
symbol.  This option is available with standard notation as well as tablature.  When pitch bend is 
used on guitar tablature, Lime follows guitar tablature convention and prints a special bend symbol 
to take the place of the ending note of the bend.  

Lime normally connects slurs to the first and last note in a slurred passage, and ties to both notes in a 
tie.  There are some situations (including first and second endings) where a slur or tie needs to extend 
left or right without connecting to a note.  Use Modify Slur/Tie; Hangs Right, Hangs Left, Only 
Left to create slurs and ties that extend to the left, or right, but are left hanging; unattached to the 
next or previous note.  

Use Modify Slur; Split to draw a slur over several notes from note to note, much like ties would be 
drawn.  This together with Modify Slur; Near Note Head can save space in crowded situations with 
stem-up and stem-down notes on one staff. 
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Hear Menu 
The Hear menu allows you to play back your music, and it allows you to modify how the music 
plays back.  You can make changes to the music, which do not affect the way it is printed, but affect 
how it is played. 

Some operations in the Hear menu are not available in Note Group Select or in Annotation Mode; 
click on the music symbol (the topmost symbol at the left of the Piano Window) to enable these 
Hear menu operations. 

Hear: 
Hear 

Hear allows you to listen to your piece.  You can specify the percentage of marked tempos, and 
which parts you would like to hear.  It will start playing at the selected (flashing) note.  While it is 
playing, you can scroll the display.  If you have saved any changes you made to the piece, and if you 
are playing through a MIDI synthesizer, you can display a new page while it is playing by pressing 
Control-[ or Control-] (Windows) or Command-[ or Command-] (Macintosh).  To stop playing, 
press Escape, or click the mouse on the menu bar, or use Control-period (Windows) or Command-
period (Macintosh). 

You have a choice of playing only one part, or playing any combination of parts active in your 
notation context.  (See the introduction for a discussion of notation contexts.)   

If you are using a MIDI synthesizer, your synthesizer can play the dynamics; see the section on 
annotations, Dynamic Levels (under the Hear menu), and Louder and Softer (under the Hear 
menu) for more information on controlling the dynamics of music.  

Your MIDI synthesizer will play dynamics you typed in the music.  See the section on annotations, 
Dynamic Levels (under the Hear menu), and Louder and Softer (under the Hear menu) for more 
information on controlling the dynamics of music.  

Some MIDI synthesizers can play special pitches, which you may adjust for each individual note.  
Lime keeps an exact pitch for each note; this pitch may be part of a scale, or it may be special for just 
that note.  For more information on controlling Lime's exact pitches for each note, see the sections on 
Tuning (under the Hear menu), and Higher and Lower (under the Hear menu).  Beware: Lime's 
exact pitch mechanism will not work with all MIDI synthesizers.  On some synthesizers, Lime 
playback is restricted to the standard equal-tempered scale.  See the section on Voice on Channel 
(under the Voice menu) for more information on playing special pitches on your MIDI synthesizer.  
Even if your MIDI synthesizer cannot play special pitches under Lime's control, many MIDI 
synthesizers will let you change their overall tuning by other means.  See the owner's manual of your 
MIDI synthesizer for more information. 
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Hear: 
Tuning 

 

 
 

Values for a Just Tuning 

Tuning allows you to specify exact pitches for each of the notes in an octave.  You can specify 
different pitches for each accidental (double flat, flat, natural, sharp, or double sharp) for each of the 
7 notes (c, d, e, f, g, a, and b).  You specify how many cents sharp or flat from the equal tempered 
scale the pitch should be.  One cent is one hundredth of a half step. 

Only notes added or modified after completing a Tuning change will be affected by it.  If you want 
to retune music that has already been entered in your piece before you used Tuning, Group Select 
the notes and use Recompute Playback.  This allows you to use different tuning values for different 
parts of your piece, or retune the piece to the same tuning. 

The Tuning values are used as the initial pitch for new notes.  If you have notes that have special 
pitches and are not part of your tuning, you can go back and change their pitches using Higher and 
Lower together with Default Playback  (under the Hear menu).  Alternatively, you can notate 
special accidental symbols for unusual pitches (see the section on Special Accidentals). 

You will hear all the special tuning pitches when you use the Hear option, if you have the right type 
of MIDI synthesizer and the proper selection in Voice on Channel", or if you play through the 
computer.  When you play on the music keyboard, Lime only uses 12 pitches per octave, since there 
are 12 MIDI notes per octave.  Lime uses your settings of Default Accidentals (under the Note 
menu) to decide which 12 pitches to use.  
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Hear: 
Dynamic Levels 

 

 

Dynamic Levels lets you specify the volume levels associated with the standard dynamic markings.  
These levels will be used when you add new dynamic markings. 

There are two ways you can use to add dynamic markings.  You can select the Marl font in Text 
Annotation Mode, and press a key on the bottom row of your computer keyboard.  When you use 
the Marl font, the “z” key is pppp, “x” is ppp, and so forth up to “/” for ffff.  Alternatively, you can 
use backslash characters to specify dynamics.  See the section on Control Annotations for more 
information. 

Dynamic markings will affect the volume of notes in all notation contexts; for this reason, the All 
Notation Contexts annotation control is usually used to print the dynamic marking in all notation 
contexts.  Sometimes the Hidden annotation control is used so that the Dynamic marking affects 
playback but not the printed output.  See the section on annotations for more information. 

Dynamic Levels does not affect existing dynamic markings; it does affect new dynamic markings 
you add.  If you want to affect the levels of music that has already been entered with dynamic 
markings, use Recompute Playback (under the Hear menu) after you set new levels in Dynamic 
Levels. 

You can use Louder and Softer (under the Hear menu) together with Default Playback  (also under 
the Hear menu) to change the loudness of individual notes without using dynamic markings.  Use 
Louder and Softer after you have typed in your dynamic markings: the changes you make using 
Louder and Softer are overridden when you add new dynamic markings or when you use 
Recompute Playback (under the Hear menu). 

If you do not want the dynamic markings to affect playback volumes, you can select this using 
Dynamic Levels.  
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Hear: 
Default Playback  

Default Playback is used to set various playback defaults.  For example, you can specify how slur, 
tenuto and staccato markings are to affect the playback duration of new notes; how long new grace 
notes are; and if the grace notes come before the beat or on the beat.  Default Playback does not 
affect the notation of the piece. 

If you specify that slurred notes are held for more than 100% of their notated note value, then any 
new slurred notes will overlap with the next note during playback.  

Changing values in Default Playback does not affect existing note durations; it does affect the 
durations of new notes you add, or notes which you change from legato to staccato, etc.  If you want 
to affect the durations of existing notes, use Recompute Playback (under the Hear menu) after you 
use Default Playback. 

Default Playback is also used to control the amount of change for each use of these Hear menu 
options: Softer, Louder, Lower, Higher, Shorter, Longer, Earlier, and Later.  Again, changing 
these values will not affect existing notes, but it will affect any future use of these Hear menu 
options.   

Hear: 
Modify Playback 
Softer, Louder Lower, Higher 
Shorter, Longer Earlier, Later 

The Modify Playback submenu options are used to affect playback of notes in your piece without 
affecting the notation of the piece.  It is often useful to use these options together with annotations; 
this is how you can make the notation indicate these playback changes.  Internal Fields (under the 
Note menu) can be used to see the numeric values of the field names affected by the Modify 
Playback submenu.  For example, if you have done many Softer and Louder operations, Internal 
Fields allows you to see precisely how much lower or higher a note is by now. 

The Modify Playback submenu options are usually used with Note Group Select; you select a 
group of notes, and then choose one of these options to modify those notes.  If you commonly use 
these options, you may prefer to use the Control (Window) or Command (Macintosh) key 
equivalents (Control-0 through Control-9 or Command-0 through Command-9) instead of using 
the mouse. 

Default Playback  (under the Hear menu) is used to set how much effect each of the Modify 
Playback submenu options has.  

If you use Softer and Louder, you should turn off the effects of dynamic markings using Set 
Dynamic Levels (under the Hear menu); otherwise dynamic markings may override your Softer 
and Louder operations when notes or annotations are edited. 
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See the section on Set Dynamic Levels (under the Hear menu) for other ways to affect playback 
volume, in addition to Softer and Louder.  See the section on Tuning (under the Hear menu) for 
other ways to affect playback pitch, in addition to Lower and Higher.  See the section on Default 
Playback  (under the Hear menu) and Hear (under the Hear menu) for other ways to affect 
playback durations, in addition to Shorter and Longer. 

Use Recompute Playback (under the Hear menu) to undo the effects of Modify Playback. 

Hear: 
Recompute Playback 

 

 

Recompute Playback is used to set playback parameters on notes to their default values; it is mainly 
used to undo the effects of these Hear menu options: Play Octave Higher, Play Octave Lower, 
Softer, Louder, Lower, Higher, Shorter, Longer, Earlier, and Later.  It is also used to update 
notes to reflect changes made with these Hear menu options: Tuning, Dynamic Levels, and Default 
Playback. 

Recompute Playback is normally used with Note Group Select.  Recompute Playback will not 
play the music or change the display; Hear (under the Hear menu) can be used after Recompute 
Playback to hear the music.  Remember that you need to end Note Group Select (by clicking 
somewhere on the screen) before you can use Hear. 

To compute the playback pitch for a note, Recompute Playback uses the tuning from Tuning 
(under the Hear menu) and the transposition from the Key Signature (under the Symbol menu).  To 
compute the playback dynamic level for a note, Recompute Playback uses the settings in Dynamic 
Levels (under the Hear menu) and the dynamic markings in the music.  To compute the playback 
timing for a grace note, staccato notes, or tenuto notes, Recompute Playback uses the settings in 
Default Playback  (under the Hear menu).  

Recompute Playback has two options for recomputing the playback timing of the group of notes 
you selected.  The total playback time of the group of notes will be retained if you select 
Redistribute Playback Timing.  Redistribute Playback Timing will use the notated lengths of the 
notes to decide how much of the total time belongs to each individual note.  If you select Playback 
Timing from Notated Durations, it will ignore the previous total playback time for the notes, and 
use a standardized playback time for all the note values.  These two options for recomputing the 
playback timing are usually equivalent (unless you made changes to the playback timing of notes 
using Internal Fields under the Note menu). 

Lime automatically checks a piece of music for duration playback integrity when the file is opened.  
If there are discrepancies, a dialog box will offer to apply Recompute Playback.  
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Hear: 
Play Octave Higher 
Play Octave Lower 

Play Octave Lower and Play Octave Higher are used to change the octave in which notes play; 
they do not change how the notes are notated.  Play Octave Lower and Play Octave Higher are 
usually used with Note Group Select when a group of notes are to be notated with 8va notation.  The 
8va symbol is printed using the Marl font in an annotation (see the font charts in the back of this 
manual). 

If a whole voice is to be notated in a different octave than it is to be played, a twelve-half-step 
transposition in Key Signature (under the Symbol menu) is normally used; Play Octave Lower and 
Play Octave Higher are not necessary for this.  

If you would like to enter the notes in a different octave as well as play them in a different octave, 
use Octave Lower and Octave Higher (under the Hear menu). 

You can use Recompute Playback (under the Hear menu) to undo the effects of Play Octave 
Lower and Play Octave Higher. 

Hear: 
Keyboard Shift 

The Keyboard Shift submenu is used to shift the pitches of notes as you input them from a MIDI 
keyboard.  This is convenient if you have a MIDI keyboard with a smaller pitch range than the music 
you are transcribing. 

Keyboard Shift is only used to help “extend” your MIDI keyboard.  If you would like to transpose 
notes so that they are not concert pitch, use the half-step transposition in Key Signature (under the 
Symbol menu).  If you would like to transpose notes for 8va notation, use Play Octave Higher or 
Play Octave Lower (under the Hear menu).  If you would like to print notes you already notated in 
a different octave, use Octave Lower and Octave Higher (under the Hear menu).  

Hear: 
MIDI Input/Output (Windows) or OMS MIDI Input/Output (Macintosh) 

MIDI Input and MIDI Output lets you choose which MIDI device driver supplies the MIDI input 
to Lime and which device will receive output from Lime.  The output can be an external unit (such as 
a synthesizer) or internal system (such as a soundcard for Windows or QuickTime for Macintosh).  
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Symbol Menu 
The Symbol menu allows you to change clefs, time signatures, and key signatures.  It also allows 
you to add and remove bar lines; it allows you to add blank space in the music and change various 
notation parameters.  With the use of Key Signature under the Symbol menu, you can transpose 
parts to different keys. 

Some operations in the Symbol menu are not available in Note Group Select or in Annotation 
Mode; click on the music symbol (the topmost symbol at the left of the Piano Window) to enable 
these Symbol menu operations. 

Symbol: 
Clef 

 

Clef is used to change or delete an existing clef, and to insert a new clef.  You have the choice of 
inserting the clef before the currently selected note or at the end of the system.  If you like, you can 
change the clef at the beginning of a system, but it is much more common to go to the preceding 
system and insert a clef change at the end of that system. 

You have the choice of several clefs; you can change the clef at any time, and all the existing notes 
will be properly notated in the new clef.  If you want an octave transposition in addition to your clef 
(e.g.  the tenor treble clef), you can specify the transposition with Key Signature (in the Symbol 
menu).  For example, check the box Transposing Instrument Sounds… and enter -12 for half steps 
below written pitch when using the treble tenor clef, and pitches will sound an octave lower.  

In some situations, it is not desirable to have any clef printed.  You can use Hide Clef to avoid 
printing the clef.  Then the clef will be used only to determine which pitch corresponds to the center 
staff line when you play the notes. 

If a system has no clef at the beginning (for example, if you delete the clef), then the most recent clef 
for any voice on the staff will be used.  If there are no preceding clefs at all, then treble clef will be 
assumed for notating the notes, although no clef will be displayed; if this is what you want, it is 
generally easier to use Hide Clef than it is to delete all the clefs. 
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Use this Clef for Remainder of Piece, when selected, will insert the clef you have chosen at that 
point in the music and remove all previously made subsequent clef changes from that point on.  

Lime automatically inserts clefs at the beginning of the new system when you use Split Systems 
(under the Page menu).  You can delete these clefs if you like; you can also keep Lime from 
inserting these clefs by using Options (under the Edit menu).  In any case, Lime deletes 
automatically inserted clefs when you Add to Next System using Page menu options. 

Graphic Change Only is for correcting clef errors in OMR of scanned music.  Lime will re-interpret 
the notes, taking the new clef into account. 

Be sure you select Current Staff Only or All Staves properly when you insert clef changes!  If you 
want to change clefs on some (but not all) of the staves in a score, use Note Group Select: select the 
first note on each of the staves you that want to change and use Clef with Current Staff Only. 

Symbol: 
Key Signature 

 

 

Key Signature is used to change or delete an existing key signature, or to insert a new key signature 
and to transpose an existing part to a new key.  Before you select Key Signature, make sure you 
have selected the proper note.  You have the choice of inserting the key signature before the 
currently selected note or at the end of the system.  You specify the written key signature for each 
staff; if you have transposing instruments, you will specify a different key signature than for non-
transposing instruments.  

Enter the number of flats or sharps, check the flat or sharp box, and indicate Major or Minor.  If you 
don't want any key signature to plot, enter 0.  

If a system has no key signature at the beginning (for example, if you delete the key signature), then 
the most recent key signature for any voice on the staff will be used.  If there are no preceding key 
signatures at all, then C Major will be assumed for notating the notes; if this is what you want, it is 
generally easier to select C Major in Key Signature than it is to delete all the key signatures. 
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If you want to print a score with transposing instruments, click on Current Staff Only so that you 
can specify a key signature individually for each staff.  For transposing instruments, you also have to 
specify how many half steps to transpose.  For example, an instrument in b flat has a concert pitch 
two half steps down from the printed pitch, so specify -2; an instrument in f plays 5 half steps above 
printed pitch or 7 half steps below printed pitch, depending on the octave of the instrument. 

Often it is desirable to print an orchestra score in concert pitch (no transposition), but to print the 
individual instrumental parts with transposition.  In this case, you will specify the same key for all 
parts (with 0 half steps transposition) when you create the score.  Later, when you are ready to print 
the parts notation contexts, you can change the key signature at the beginning of the piece and 
transpose all the notes.  When you change the key signature, you will also need to change the half 
step transposition (as discussed above) and check the Transpose Notes check box.  (If you want to 
reprint the score notation context, remember to change the key signatures back!)   

If you do not have any notes yet (if the staff has only rests after the key signature) then the 
Transpose Notes check box does not matter.  If you have existing notes and you want to transpose 
them to a different key, then you should check the Transpose Notes check box.  If you accidentally 
specified the wrong key signature when you first created the piece, and now you want the same notes 
with the same transposition written in a different key, then do not check the Transpose Notes check 
box. 

To transpose groups of notes using Note Group Select without changing keys, see the feature 
Transpose under the Note menu.  

Even if you do not have a transposing instrument, you may want to specify a transposition in half 
steps.  If the part is printed an octave higher than it sounds, specify -12 for the half step transposition; 
if it is printed an octave lower than it sounds, specify 12 for the half step transposition. 

Graphic Change Only is for correcting key signatures errors in OMR of scanned music.  Lime will 
re-interpret the notes, taking the new key signature into account. 

Use this Key for Remainder of Piece will remove any key changes on the voice in the remaining 
portion of the piece. 

Be sure you select Current Staff Only or All Staves properly when you insert key signatures!  If 
you want to change keys and transposition on some (but not all) of the staves in a score, use Note 
Group Select: Shift-click on a note on each of the staves you want to change, and use Key 
Signature with Current Staff Only. 
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Symbol: 
Time Signature 

 

 

Time Signature is used to change or delete an existing time signature, or to insert a new time 
signature.  You have the choice of inserting the time signature before the currently selected note or at 
the end of the system.  Changing the time signature does not change the actual number of beats per 
measure; the number of beats per measure is determined when you create the piece, when you insert 
new measures, and when you use Bar Line (under the Symbol menu).  If you want to change the 
number of beats in a measure, use Delete Measures (under the Page menu) to remove the measure, 
then use Insert Measures (under the Page menu) to insert a new measure with the new number of 
beats.  The time signature affects how rests are combined.  Rests are only combined if there are 
complete measures of rests; rests will not be combined in pickup measures or other partial measures.  
Lime uses the time signature to determine if rests should be combined.  For more details on 
combining rests, see Don't Combine Rest (under the Note menu). 

Whenever you add a time signature, Lime also adds a Beaming Rule.  The Beaming Rule is set up 
according to the time signature; you can change the Beaming Rule by selecting the first note after 
the time signature and using Beaming Rule (under the Note menu). 

Lime allows you to have different time signatures on different staves in a system.  You will need to 
use the Current Staff Only check box in Time Signature.  For more information, see the examples 
in the back of this manual. 

Choose Do not print whole measure rests to suppress whole measure rests in whole rest bars.  This 
is useful to avoid confusion in time signatures such as 1/8. 

Lime allows you to choose from the most common time signatures.  You can use annotations to 
create unusual time signatures that are not automatically provided by Lime; this is described in an 
example in the back of this manual. 
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Symbol: 
Bar Line 

 

Bar Line is used to change or delete an existing bar line or repeat sign, or to insert a new bar line.  
You have the choice of inserting the bar line or repeat sign before the currently selected note or at the 
end of the system.  Bar Line also allows you to change various attributes of the bar: make a bar 
unnumbered, control the bar numbers for the next system, declare first and second endings for 
playback, and declare dal segno instructions for playback. 

The Draw Bar Line On Staff button indicates that the bar line should be drawn on this staff, but not 
connected to the next staff in the system.  The Draw Bar Line On Staff and to Next Staff button 
draws the bar line both on this staff and between this staff and the next staff in the system.  This 
button is used to group together certain staves in an orchestra score.  The Draw Between Staff and 
Next button indicates that the bar line should not be drawn on the staff lines, it should only be drawn 
between this staff and the next staff in the system.  Make sure you use Current Staff Only 
appropriately when using these bar line drawing buttons. 

The Copy Bar Line Drawing to Remainder of Piece check box allows you to set the bar line 
drawing buttons for all following bar lines the same as this bar line.  If you do not check Copy Bar 
Line Drawing to Remainder of Piece, then the bar line drawing buttons will only affect this bar 
line.  

Lime will automatically print measure bar numbers at the beginnings of systems.  If you want to turn 
off the printing of bar numbers, deselect Print Bar Number at the Beginning of Next System; you 
can do this at any bar in your piece.  If you want a bar number printed at the first system of the piece, 
you specify this in Options (under the Edit menu).  

If you have a partial measure or have a measure which for some other reason should be ignored for 
bar numbering purposes, you can set the Don't Count This Bar in Bar Numbering check box in 
Bar Line.  Lime normally starts at 1 when it numbers bars; if you want to start with a different 
number, you can specify this using the Options dialog (under the Edit menu).  If you want to restart 
numbering in the middle of the piece, choose Restart Bar Number in the Bar Line option, and 
specify the new bar number. 
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If you specify first endings, second endings, or dal segno instructions in Bar Line, these only affect 
playback.  In addition to making these specifications in Bar Line, you must also use text and line 
annotations to add first and second ending markings, special coda symbols, and so forth.  See the 
section on annotations for more details. 

Lime will honor repeat signs during playback.  If you want a measure to be played only the first time 
on a repeat, check the first ending box.  Move to the next measure to declare the second ending.  If 
no second ending is declared, the first ending will be ignored.  If you want the playback to skip to 
another section (as with a third ending, or a dal segno), click Go To Bar and enter the measure 
number and the time through. 

Bar lines are not strictly required by Lime, and different staves in a system may have bar lines at 
different places.  If you have many measures where different staves have different time signatures, 
you might want to use Current Staff Only with Insert Measures (under the Page menu). 

Symbol: 
Align Bars 

Align Bars is used to line up the bar lines in successive systems on a page of music.  Normally Lime 
places notes and bar lines differently in each system, according to the density of notes on each 
system.  To line up bar lines, select the first note in the measure on several different systems using 
Note Group Select, and then select Align Bars.  

There are three types of Align Bars that require that you select the note after each of the bars to be 
relocated.  Once each note after the bars to be relocated are selected you can choose to align with the 
right most bar, left most bar, or top bar.  The fourth type of Align Bars forces all measures in all 
systems to be spaced equally, such that all bar lines are aligned.  The first bar in each system may be 
slightly shorter and/or more crowded, depending on the presence of key or time signatures.  

Align Bars adds Chord Drags to your music, and thereby aligns your bar lines.  To undo the effects 
of Align Bars, select the first notes in the measures using Note Group Select, then use Clear Chord 
Drag (under the Edit menu). 
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Symbol: 
System Bracket 

 

System Bracket is used to control the brackets and braces drawn at the beginning of each system. 

The Draw Bracket On Staff button indicates that the bracket should be drawn on this staff, but not 
connected to the next staff in the system.  The Draw Bracket On Staff and to Next Staff button 
draws the bracket both on this staff and between this staff and the next staff in the system.  This 
button is used to group together certain staves in an orchestra score.  The Don’t Draw Bracket for 
this Staff button indicates that the bracket should not be drawn on this staff; this is traditionally used 
for voice parts in an opera score.  Make sure you use Current Staff Only appropriately when using 
these bar line drawing buttons. 

The Draw Brace Between This Staff and Next check box is used to draw curly braces between two 
staves.  This is normally selected for the top staff of a piano grand staff. 

The Copy Bracket Drawing to Remainder of Piece check box allows you to set the bracket and 
brace drawing buttons for all following systems the same as this system.  If you do not check Copy 
Bracket Drawing to Remainder of Piece, then the bracket and brace drawing buttons will only 
affect this system.  After you use Copy Bracket Drawing to Remainder of Piece, you may still 
change system breaks using the options under the Page menu; Lime will automatically add and 
remove brackets as needed.   
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Symbol: 
Parameters 

 

 
 

Parameters allows you to change which symbols are used when music is printed, the exact 
positioning and spacing between symbols, the length and thickness of lines used in printing, and 
many other details of printing music.  You can make these changes at any point in the music, and the 
changes can be for one voice or for all voices, for one notation context or all notation contexts. 

Parameters gives you a list of parameter categories on the top left side of the screen.  Below the list 
of categories it gives you a list of all the parameter descriptions for the currently selected category.  
You can use the scroll bars to go through these lists.  You can select a new category by clicking in 
the top list, and you can select a new parameter by clicking in the bottom list.  On the right side of 
the screen you will see the parameter value.  If the parameter is a number, the value will be after 
Value; if the parameter is a symbol, then Character gives the character, X Offset and Y Offset give 
the exact positioning in points (72 points per inch).  Use the Font and Style menu  to see the font, 
boldface, underline, and point size.  You can type changes to the parameter or use the Font and Style 
menus; click the Save Change button to save the changes when you are done.  After you click Save 
Change, you can select another parameter, or click Quit to go back to editing music.  If you select 
another parameter or click Quit without first clicking Save Change, then your changes will not be 
stored. 

Sometimes it is valuable to know which parameters have been changed.  Holding down the Shift key 
while selecting Parameters will show only those parameters that have been changed at that note.  

Some parameters have two sets of values: one for normal size notes, and one for grace notes or cue 
notes.  You can select between the sets of values by clicking on the Normal Size and Cue/Grace 
Size buttons.  When you click on Save Change, Lime will store the parameter change only for the 
currently selected size; if you want to change the parameter for both sizes, you must use Save 
Change once with Normal Size selected and once again with Cue/Grace Size selected. 

If you use Parts and Voices (under the Voice menu) to change the point size of your staff, many of 
the parameters will automatically change to match the new staff size. 
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If you use Parameters when your selected note (the note which is flashing before you enter 
Parameters) is in a chord, and you have All Parts and Voices selected, then your Parameters 
change will be inserted before the first note in the chord on all parts and voices.  So if you have All 
Parts and Voices selected, it doesn't matter which note in the chord was flashing.  But if you have 
This Voice Only selected, you need to be careful which note in the chord is selected.  Most often 
you will want to select the voice's first note in the chord.  You can find the voice's first note in the 
chord by using Previous Note under the Voice menu (or the ← key) and Next Note (or →) to move 
forward and backward in the voice.  

Lime uses hidden text annotations to keep track of your Parameters changes.  If you display these 
hidden text annotations (using Hidden Text under the Symbol menu), you can Copy, Paste, and 
Clear them.  If you need to paste the Parameters change to many places on a page of music, this 
can easily be done with “Multiple Paste.”  See the section on Control Annotations for more 
information. 

Symbol: 
Hidden Text 

Hidden Text allows you to specify which types of Control Annotations (dynamic marks, tempo 
markings, MIDI messages, and parameter changes) or hidden text are displayed on the screen and 
which are printed.  If you display the hidden text annotations for Parameters on the screen, you can 
use Copy, Paste, or Clear on Parameter changes. 
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Annotation Menu 

Annotation: 
Previous Annotation, Next Annotation 

When either of these two menu items are selected, whether in annotation entry mode or note entry 
mode, the program moves to and selects the next or previous annotation.  If either item is chosen 
while in note entry or note edit mode, then the next annotation after that note will be selected. 

Annotation: 
Text Category 

Every text annotation has an associated text category.  When you select one of the categories in the 
Text Category menu, Lime will set all the annotation attributes to those appropriate for that 
annotation style. 

Each of the attributes for a Text Category can be set manually or changed after an annotation is 
created.  When an attribute is applied to an annotation a check mark will appear by each item in the 
Annotation menu.  To understand better how each menu item in the Annotation menu affects an 
annotation, first select an existing annotation, note which items are checked in the Annotation menu, 
then read the explanation for that item below. 

The last item in the Text Category menu, Model for Text Category, allows you to change the 
default attributes of the currently selected text category to match that of the currently selected 
annotation.  To use this feature, first create a new, or select an existing annotation of any given 
category (e.g.  Lyric).  Change the attributes for that annotation (e.g.  add bold).  While the 
annotation is still selected, choose Model for Text Category.  The next time you create an 
annotation with using this category (e.g.  Lyric), the new annotation will have all these attributes 
(e.g.  including bold). 

Annotation: 
Font, Size 

The Font and Size menu is used to choose the font and point size for text annotations.  The Font 
menu allows you to choose the point size, by choosing the size from the menu, or by choosing Point 
Size and typing a point size.  See the section on annotations for detailed information on typing text in 
your music. 

When you are typing an annotation, you may change your font with the Font menu at any time.  You 
may change the font of an existing text annotation by pressing Alt (Windows) or Option 
(Macintosh) and clicking near the right or left end of the text to select it and then using the Font 
menu.  You may change the font of several text annotations at once using Annotation Group Select; 
see the annotations section for more details. 
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If you want to change the font for some of the characters in an existing text annotation but not all, 
Alt or Option-click to select the annotation, then drag the mouse on the characters you want to 
change (make them black) and use the Font menu. 

In text annotations, typing “\” followed by certain characters can be used to print musical symbols.  
This is sometimes more convenient than changing to a musical font using the Font menu.  See the 
section on Backslash Characters for details. 

Lime uses the fonts Marl (usually using 12 Point) and Tufa (usually using 24 Point) for printing 
music, and Times and Symbol for printing text.  You can change the font and the point size which 
Lime uses; see Parameters under the Symbol menu, and the Sonata® option in Options (under the 
Edit menu). 

Annotation: 
Style 

When you are typing a text annotation, you may change your settings in the Style menu at any time.  
You may change the Style settings of an existing text annotation by selecting the text (Alt-click or 
Option-click) near the right or left end of the text) and then using the Style menu.  You may change 
the Style settings of several text annotations at once using Annotation Group Select; see the 
annotations section for more details. 

If you want to change the Style settings for some of the characters in an existing text annotation but 
not all, Alt-click or Option-click to select the annotation, then drag the mouse on the characters you 
want to change (make them black) and use the Style menu. Typing “\” followed by certain characters 
can be used to change between bold and italic, or to superscript.  This is sometimes more convenient 
than using the Style menu.  See the section on Backslash Characters for details. 

In general, it is best to select a Text Category (under the Annotation menu) when you wish to 
create a new annotation.  This will automatically select the Style options; you can then use the Style 
menu to deviate from the automatically selected options.  If you select the proper Text Category, 
that information can be useful for producing Braille music, or for the Export MusicXML and 
Export NIFF menu options. 

Annotation: 
Style (Plain, Bold, Italic, Underline) 

Use the Style menu to indicate if an annotation is bold, italic, underlined, or plain.  Any of these 
menu items can be applied to a group of annotations.  See Annotation Group Select for more 
details.  

Annotation: 
Style (Centered, Leave Space, Staff Size Adjust, Position Lock) 

The Centered item (under the Annotation menu) is used to automatically center text above or below 
notes.  If you wish to move text to the left or right, deselect this item.  If you use Centered with 
Horizontal Lock selected, then the text will be centered in the middle of the page; this is often used 
for the title of the piece. 
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If you select Leave Space (under the Annotation menu) for an annotation, extra space will be left in 
the music to avoid overlap with the annotation.  This is normally used with lyrics, but not used with 
tempo markings or crescendo hairpins that span several notes.  Leave Space is also useful for special 
time signature symbols (or other symbols that do not overlap with notes) which you might place 
before a note on the staff lines, but it would not normally be used with glissando indications.  Several 
other mechanisms are available for leaving extra space in the music.  For details, see the descriptions 
of Layout (under the File menu), Chord Drag, and Parameters (under the Symbol menu). 

Staff Size Adjust is used to change the size and positioning of text annotations according to the 
point size of the staff.  For example, if a text annotation is associated with a note on a cue-size staff 
(see the description of Parts and Voices under the Voice menu), and if Staff Size Adjust is check 
marked for the text annotation, then the text annotation will be printed in a reduced size.  Also, the 
text annotation will be moved slightly closer to the staff. 

Staff Size Adjust is useful in Part Extraction used for part extraction from scores.  The notation 
context may contain a cue staff with notes from another part.  See the example in the back of this 
manual for more information. 

Position Lock is used to lock the positioning of text annotations independent of the position or point 
size of the staff.  For example, a copyright message text annotation at the bottom of the page does 
not relocate even if the associated note’s staff moves up or down. 

Annotation: 
Style (Boxed, Center Hyphen, Extend Underline, Flat Underlines, Stack Vertically) 

The Boxed menu (under the Annotation menu) is used to draw a box around your text; this is 
common for rehearsal marks.  Boxed is usually used with Duplicate in Every Context (under the 
Edit menu).  

Center Hyphen is used with text annotations.  If a text annotation ends with a hyphen character, and 
if Center Hyphen is check marked for the text annotation, then the hyphen will be centered between 
this note and the next.  This is often used in voice music. 

The Center Hyphen check mark may be added or removed while you are typing the text annotation, 
when you have selected the annotation with Alt-click (Windows) or Option-click (Macintosh), or 
using Annotation Group Select.  In Annotation Group Select, you can remove the Center 
Hyphen check mark by selecting Center Hyphen twice. 

Extend Underline is used with text annotations.  If a text annotation ends within a single underscore 
character ("_"), and if Extend Underline is check marked for the text annotation, then a line will be 
drawn from the end of the text annotation to beneath the next note.  This is often used in voice music. 

If a line is to be drawn under several notes, a single underscore character is used under each note.  
The last note (the note at which the line ends) should have a text annotation that has either an 
underscore character followed by a punctuation mark (if there is to be a punctuation mark at the end 
of the line) or an underscore character followed by a space (if there is no punctuation mark at the end 
of the line).  See the example “Centered Hyphens and Extended Underlines in Lyrics” in the back of 
this manual. 
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The Extend Underline check mark may be added or removed while you are typing the text 
annotation, when you have selected the annotation with Alt-click (Windows) or Option-click 
(Macintosh), or using Annotation Group Select.  In Annotation Group Select, you can remove the 
Extend Underline check mark by selecting Extend Underline twice.   

Flat Underlines prevents underlines from being superscripted along with superscripted text (\u); this 
is an issue with chord symbols. 

Stack Vertically is used to stack elements of an annotation vertically.  This is useful for creating 
annotations for piano fingerings or theory figured bass symbols.  When selected each character 
(except those separated by a dash) is stacked vertically.  

Annotation: 
Style (Hidden, Do Not Interpret, Draw in White, Annotation Color) 

Hidden indicates that the text should not appear in the music, except when you specially ask to see it 
using Hidden Text (under the Symbol menu).  If you select the Hidden type a text annotation, the 
text will disappear when you are done typing–unless you ask to see it using the Hidden Text menu 
option, in which case it appears with a dashed underline.  The dashed underline is a reminder that it 
is Hidden text. 

Do Not Interpret indicates that a control annotation should not affect the music.  For example, if 
you select Do Not Interpret for a dynamic marking, the dynamic marking will have no effect when 
you use the Hear option. 

If you select Draw in White (under the Annotation menu) the annotation will be erased from the 
page rather than written onto the page.  If there are no staff lines, music, or previous annotations that 
overlap with the Draw in White annotation, then the Draw in White annotation will have no visible 
effect.  Draw In White annotations are sparingly used (see Cut and Paste Systems in the Hints and 
Examples section below).  For a related Lime feature, see the description of the Hidden text 
annotation control below. 

Annotation Color will change the color of an annotation displayed on the screen.  Select an 
annotation, or group of annotations that are to be changed.  Choose Annotation Color and click on 
the color you want the notes to be.  You can customize any color by clicking on it while holding 
down the Shift key. 

Windows users: When customizing colors, choose one of the solid colors.  Use a white window 
background when you work with colors.  You can choose the window background color in the 
Windows Control Panel. 

Annotation: 
Text Assistant 

Text Assistants help create title, tempo, dynamic, fret grid, chord symbol, and General MIDI 
annotations.  Some of these annotations (such as tempo and MIDI) can be used to control how Lime 
interprets the music, but they must be typed correctly.  All of these annotations can be created 
without using Text Assistants: The Text Assistant dialogs are a higher level interface that will help 
you learn how to create these annotations. 
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To create a title, tempo, dynamic, fret grid, chord symbol, or General MIDI; first enter Annotation 
Mode by selecting the text symbol at the left of the Piano Window.  Choose Text Assistants (under 
the Annotation menu) and choose Title, Composer, Tempo, Dynamic, Fret Grid, Chord Symbol, 
or General MIDI.  In each dialog choose a value for the components of the annotation.  Below the 
pull down menus is shown the text necessary to create the annotation if you type it without using the 
assistant dialog.  

Annotation: 
Text Assistant, Chord Symbol 

Chord Symbol is a useful illustration of how Text Assistants work.  To insert a guitar chord 
symbol, click on the text symbol in the Piano Window, select Chord Symbol under the Text 
Assistant (under the Annotation menu) to make chord symbols.  When you change keys the chord 
symbol will transpose to the new key (if the transpose notes and chords box is checked).  

In order for Lime to recognize an annotation as a chord symbol (in addition to selecting Chord 
Symbol from the Text Category menu), it must begin with a letter (A through G, upper or lower 
case) followed by an optional accidental.  

If in addition to the initial chord symbol the annotation contains a slash ("/") followed by a letter (A 
through G) and optional accidental, this symbol is also transposed.  The slash is a convention used to 
indicate a chord that is played over another chord or a chord with a specified bass.  All other text and 
spaces are ignored. 

For example, if a musical passage in the key of A is transposed to the key of B (up a whole step) 
with Transpose Notes and Chord Symbols to New Key checked in Key Signature, the chord 
symbol BMI7 (5)/D will be changed to CMI7 (5)/E. 

The optional accidental in a chord symbol may be entered as a backslash followed by “+” for sharp, 
“++” for superscripted sharp, “-” for flat, or “--” for superscripted flat.  When you have finished 
editing the + or - will be replaced with a superscript sharp or flat from the Marl font.  

Backslash followed by “u” is used to superscript numbers and letters.  If you type 
 C\u7\--9, it will convert to C7 9.  

Annotation: 
Line, Hairpin 

To draw a line, select Line from the Annotation menu, choose the line width from the Line and 
Curve Style menu, then move the mouse to the position on the page where you want to begin the 
line.  Press Control (Windows) or Command (Macintosh) and hold down the mouse button.  Move 
the mouse to the end point and let up the mouse button and the Control or Command key.  (This is 
called Control-drag, or Command-drag.) 
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Hairpin is used to create crescendo or diminuendo hairpins.  First select Hairpin from the Line 
menu (under the Annotation menu), and select the line width (usually Thin Line in the Line and 
Curve Style menu).  Now you are ready to create hairpins: select a note, and draw a hairpin just as 
you would normally create a line using Control-drag (Windows) or Command-drag (Macintosh).  
After you create a hairpin, you can drag it around by selecting it, and then pressing Alt (Windows) or 
Option (Macintosh) while dragging the mouse.  

Hairpins are often drawn using This Notation Context Only; this allows you to draw the hairpins 
separately for the score notation context and the parts notation contexts. 

You can use Extend Line to Here under the Edit menu to create hairpins and other lines that 
automatically resize if the position of the notes in the music changes, and hairpins that extend over 
page turns and multiple systems.  Such a line automatically resizes with the music as you make 
changes to the score.  First select the starting note and draw the line or hairpin.  Then select the note 
to which you want the end of the line extended and attached, then choose Extend Line to Here.  
You can use Extend Line to Here to extend a line across system breaks or page turns.  

In Lime, all lines have two clip points associated with them.  These clip points allow you to clip parts 
of the line; the clipped portions of the line will not be visible.  The initial positions of these clip 
points are chosen for you automatically, so that none of the line is clipped.  For instructions on 
moving the clip points, see the section on Moving and Editing Annotations below. 

Annotation: 
Line, Tuplet Bracket, Bracket 

Tuplet Bracket is used to create a triplet bracket, quintuplet bracket, or other tuplet brackets.  First 
select the line symbol at the bottom left of the screen, then select the line width (usually the Thin 
Line annotation control), then select Tuplet Bracket under the Style menu.  Now you are ready to 
create tuplet brackets: first select a note in the tuplet group, then draw a tuplet bracket just as you 
would normally create a line using Control-drag (Windows) or Command-drag (Macintosh), as 
described in the Annotations section.  After you create a tuplet bracket, you can drag it around by 
selecting the bracket, and then using Alt-drag (Windows) or Option-drag (Macintosh).  

Bracket is used to create brackets similar to tuplet brackets.  They can be used in first and second 
endings, to indicate groupings, Hauptstimme and Nebenstimme, and other twentieth century devices.  
First select the line symbol at the bottom left of the screen, then select the line width (usually the 
Thin Line annotation control), and then select the Bracket option.  Now you are ready to create 
brackets: first select a note associated with the bracket, then draw a bracket just as you would 
normally create a line using Control-drag (Windows) or Command-drag (Macintosh), as described 
in the Annotations section.  After you create a bracket, you can drag it around by selecting the 
bracket, and then using Alt-drag (Windows) or Option-drag (Macintosh).  

Tuplet brackets are often drawn using This Notation Context Only; this allows you to draw the 
tuplet brackets separately for the score notation context and the parts notation contexts. 
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Annotation: 
Line and Curve Style 

Three different widths of lines may be selected by clicking Thin, Regular, or Thick.  Line Width 
(under the Annotation, Line and Curve Style menu) can be used to specify any other line width.  A 
line width of 1 corresponds to one point (1/72 inch); a line width of 1.5 corresponds to one and a half 
points.  The fractional part of the line width makes a noticeable difference on high-resolution laser 
printers.  

Dashed… (under the Annotation, Line and Curve Style menu) is used to specify the dash length 
and the gap between dashes for dashed lines and curves.  To draw dashed lines, use Dashed…, and 
then draw the lines.  When you want to go back to drawing undashed lines, use Dashed… and 
specify a dash length of 0. 

To draw a curve, click the curve symbol, choose Curve Up or Curve Down (under the Annotation, 
Curve menu), and then press Control (Windows) or Command (Macintosh) as you drag the mouse.  
(This is called Control-drag or Command-drag.) 

Lime uses the Bezier method for drawing curves.  You change the shape of the curve by moving 
around the curve’s control points; the curve slope at each end point is in the direction of that end 
point's control point.  After you have created the curve, press Alt (Windows) or Option (Macintosh) 
and click on the curve to select it, and drag the curve's two control points.  The initial position of 
these control points was chosen for you automatically.  With practice you will be able to make many 
shapes of curves. 

Dashed… (under the Annotation, Line and Curve Style menu) is used to specify the dash length 
and the gap between dashes for dashed lines and curves.  To draw dashed curves, use Dashed…, and 
then draw the curves.  When you want to go back to drawing undashed curves, use Dashed… and 
specify a dash length of 0. 

Extend (under the Annotation, Line and Curve Style menu) indicates Extend Line to Here was 
used with the selected line.  You can use Extend Line to Here (under the Edit menu) to create lines 
that automatically resize if the position of the notes in the music changes, and lines that extend over 
page turns and multiple systems.  Such a line automatically resizes with the music as you make 
changes to the score.  First select the beginning note and draw the line or hairpin.  Then select the 
note to which you want the end of the line extended and attached, then choose Extend Line to Here.  
You can use Extend Line to Here to extend a line across system breaks or page turns.  

When copying and pasting a line that has been set to resize, the resizing feature will not be 
duplicated to the new position.  If you want the new line extended you must repeat the resizing 
commands right after pasting the new line.  

To extend and automatically resize a line that you previously created, first select the line, then click 
on the note to which you want the line extended and select Extend Line to Here. 
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Annotation: 
Horizontal Lock, Vertical Lock 

In Annotation Mode, you can select Horizontal Lock and Vertical Lock (under the Annotation 
menu) for your annotation.  These will be set automatically for you if you choose a Text Category 
(under the Annotation menu) for your annotation, but in some situations you will want to modify the 
automatically selected settings.  Horizontal Lock and Vertical Lock affect how the annotation 
moves if its associated note is moved to a different location on the page or if the annotation is pasted 
to another note.  Horizontal Lock, when checked, will prevent an annotation from moving to the left 
or right when the note it is associated with is moved.  Vertical Lock, when checked, will prevent an 
annotation from moving up or down when the note it is associated with is moved up or down.  

For example, a note might move to the right because you add new notes before it.  If you selected 
Horizontal Lock for the note’s annotation, the annotation will be locked in position and will not 
move to the right with the note (it is horizontally locked into position); the annotation will remain at 
its previous location.  If you did not select Horizontal Lock for the annotation, the annotation will 
move to the right with the note.  Horizontal Lock and Vertical Lock should be selected for piece 
titles and duplicate staff labels, but it should not be selected for lyrics or dynamic markings.  

Horizontal Lock and Vertical Lock are very important when you use Part Extraction, and when 
you use Multiple Paste to copy your annotations onto several notes at once.  For example, if you 
copy and paste annotations which have Vertical Lock selected, the pasted annotations will always 
appear the same distance from the middle staff line, no matter what pitch note you paste them to 
(they are vertically locked into position).  If Vertical Lock is not selected for the annotations, the 
vertical location of the pasted annotations will move up and down, depending on what pitch notes 
they are pasted to.  

Vertical Lock should be selected for lyrics, tempo markings, and rehearsal marks.  Horizontal Lock 
should not be selected for lyrics, tempo markings etc.  Otherwise, if they will not move to the left or 
right if the note moves. 

Vertical Lock and Horizontal Lock should be used for titles, author, instrument names, tempo 
markings, and copyright information. 

Neither Vertical Lock nor Horizontal Lock (both unchecked) should be used for accent marks, 8va 
symbols, and articulations.  

For text at the bottom of the page, such as copyright messages, use Position Lock (under Style in the 
Annotation menu).  
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Summary of Horizontal and Vertical Lock effects on annotation placement when the associated 
note is relocated or the annotation is pasted to a new note: 
 
Hor.  Lock off off on on 
Ver.  Lock off on off on 

 
                 ⇑ 
         ⇐    ⇒ 
                 ⇓ 

 
    

   ⇐    ⇒ 
          

 
           ⇑ 
         (5)+  
           ⇓ 

          

         = 100  
     (no motion) 

Annotation: 
All Notation Contexts, Only in Score, Not in Score, This Notation Context Only 

If you are working on an orchestra score (or any other kind of score), Lime allows you to edit and 
print out the score.  If you also want to print out individual parts, Lime has a mechanism called 
“notation contexts” for part extraction.  (See the introduction section on Part Extraction and 
Notation Contexts.)  All Notation Contexts, Only in Score, and Not in Score (under the 
Annotation menu) are part of the notation contexts mechanism.  They allow you to control if an 
annotation should be printed whenever the part is printed (independent of notation context), or only 
when this part is printed in the score notation context, or only when the part is printed in one of the 
other notation contexts.  

If you select an annotation while editing the score and you chose Not in Score, then the annotation 
will disappear from the screen: the annotation will only be visible when you edit the another notation 
context which includes the part.  Similarly, if you select an annotation while editing an individual 
part’s notation context, and you chose Only in Score, then the annotation will disappear from the 
screen: the annotation will only be visible when you edit the score.  

Care must be taken selecting attributes for any annotation if it is to be copied and pasted.  If, for 
example, you copy an annotation that has Only in Score selected and paste it into a notation context 
other than the score notation context, it will not appear in that notation context, but only in the score.  
For more details on these options, see the section on Part Extraction (under the File menu) and on 
Duplicate In Every Context (under the Edit menu). 

This Notation Context Only specifies that an annotation appear only in the current notation context; 
not in the score, or any other notation context. 
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What Every Lime User Should Know 
The next part of this manual shows examples of common notations in music and explains how they 
are created in Lime.  All of the Lime features used are described earlier in this manual.  These 
examples are to help new users of Lime.  You should try the Step-by-Step Example at the beginning 
of the manual before you look at the hints that follow. 

These examples show only a few of Lime’s capabilities.  If you do not see an example that shows 
how to solve your notational problem, please contact the Lime consultant.  If you don’t fully 
understand an example, look in the manual sections about the menu options and annotation controls 
mentioned in the example. 

Here are some general things to keep in mind: 

• You must have the notes symbol (the top symbol) at the left of the Piano Window selected before 
you can play notes or perform many other operations in Lime.  There are four symbols for four 
modes: Music Mode, Text Annotation Mode, Line Annotation Mode, and Curve Annotation 
Mode.  The music symbol is normally selected; the others are only for adding or editing 
annotations (lyrics, dynamics, crescendo marks, etc.). 

• Be sure to distinguish between the edit cursor and note entry cursor.  A single flashing note is an 
edit cursor; a group of shaded notes indicate Note Group Select in edit state.  A flashing box is the 
note entry cursor.  Click once to engage the edit cursor, click twice to engage the note entry cursor. 

• The note (or rest) that is flashing indicates the position of the edit cursor.  In this state all edits are 
applied to that note.  Gray notes indicate Note Group Select.  In this state all edits will be applied 
to all notes that are gray. 

• A flashing box indicates the position of the note entry cursor.  If you want to play new notes, you 
need to select a note first by double-clicking on it.  The selected note tells Lime where to put the 
new notes you are adding.  

• In some cases (e.g.  after using the Systems… menu option), no notes will be selected.  Because 
there is no cursor position many menu items will be gray.  To proceed, click, or double-click on the 
note where you would like to continue editing. 

• When you use Note Group Select or Annotation Group Select, many menu options are not 
available.  To get out of Group Select, just select a note (click on a note) or one of the symbols at 
the bottom left of the screen. 

• Users who are new to notation programs may find the Parts and Voices convention confusing.  Be 
sure to review these sections, and be careful which voice or part is selected before entering music, 
especially when there are several parts or voices on a single staff.  In this case both voices are often 
represented with a single rest.  When working with several parts or voices on a single staff you 
might find it useful to use Highlight Voice (under the Voice menu) or to temporarily turn Uniform 
Stem Directions on so that rests are not shared and stem directions for each voice are consistent.  
You can then turn Uniform Stem Directions off after entering all the music.  Another technique 
for clarifying parts and voices relationships is to begin by giving each part or voice its own staff 
even though they will eventually be combined in the final draft.  

And some things to keep in mind for annotations: 
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• In Annotation Mode, it is very important that you associate each annotation with the correct note.  
To do this you must have the proper note or rest selected when you add an annotation; the 
annotation will be associated with that note.  When you make changes in your piece or if you use 
Part Extraction to do part extractions, your annotations will correctly stay with their associated 
notes. 

• If you are adding lyrics, you can automatically select the next note by pressing Tab; this makes it 
easy to associate each lyric word or syllable with its note.  (The Options dialog allows you to 
switch the meaning of the Tab key and Space bar.  When selected, the Space bar will move to the 
next note and Tab will type a space.) When you first start typing your lyrics, carefully select the 
vertical positioning of your text below the staff; when you press Tab (or Space bar), the same 
vertical positioning will be used under the next note.  

• When you add annotations use the Text Category menu to set the correct type of annotation.  This 
will change the annotation controls under the Annotation menu.  Before you spend a lot of time 
adding annotations to your music, you should make sure you understand the annotation controls.  
Controls like Horizontal Lock and Vertical Lock may seem unimportant at first, but proper use 
will ensure that your annotations will plot correctly if you make changes to your piece, if you use 
Part Extraction to generate parts, or if you use Multiple Paste with your annotations. 

• An annotation may be selected by pressing Alt (Windows) or Option (Macintosh) and clicking 
with the mouse.  If you are not in Annotation Mode when you do this, you will be switched into 
Annotation Mode automatically.  The note associated with the annotation will be selected 
automatically and it will start flashing, and the annotation will have small squares plotted at the left 
and right ends to indicate that it is selected. 

• Annotations can be moved by pressing Alt (Windows) or Option (Macintosh) and dragging the 
mouse.  While you are dragging an annotation, its relative coordinates will be displayed at the 
bottom of the screen.  The horizontal coordinate is relative to the note associated with the 
annotation (if Horizontal Lock is not selected) or it is relative to the left margin (if Horizontal 
Lock is selected).  The vertical coordinate is relative to the note (if Vertical Lock is not selected) 
or relative to the staff (if Vertical Lock is selected).  The coordinates are given for the end of the 
annotation nearest the mouse.  The coordinates are in points units (1/72 inch); if you use reduction 
or enlargement when you print, the units may actually be smaller or larger than 1/72 inch.  If you 
want to check the coordinates of an annotation, press Alt (Windows) or Option (Macintosh) and 
then click the mouse button without moving the mouse. 
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Part III: Hints and Examples10

After You Have Entered All the Notes…  

 

Slurs, Ties 
 

 

If you have played several notes and you want them slurred together, you can do this using Note 
Group Select.  In this example: 

• Use Note Group Select to select the first four notes (not all five!) by dragging a rectangle around 
them. 

• Choose the Slur in the Piano Window. 
• Click on any note to end Note Group Select.  

To tie a note: 
• Position the edit cursor on the first note in the tie by clicking on it. 

• Choose the tie in the Piano Window. 

When using the note entry cursor (flashing box), you can select the Slur or Tie at the bottom of the 
screen before you play your notes.  But remember that the Slur and Tie indicates a note is slurred or 
tied to the next, so turn off the slur before you play the last note in the slur or tie. 

To remove slurs and ties using Note Group Select: 
• Use Note Group Select to select the notes by dragging a rectangle around them. 

• Click twice
• Click on any note to end Note Group Select.  

 on the Slur or Tie in the Piano Window. 

If a note is specified as tied, Lime expects a similar note in the following chord (same note name 
accidental and pitch).  If there is no such note, then the tie is treated as a split slur to the nearest note-
head in the next chord. 

                                                

10 Many of the examples in this section are taken from Stone, Kurt.  Music Notation in the Twentieth Century.  New 
York: W.  W.  Norton, 1980 
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Copy Rectangle, Music Examples for Other Applications 

Lime can be used to generate music examples for research papers, exams, articles, and flyers.  In 
fact, all of the examples in this manual were created in Lime and then pasted into Microsoft Word.  
Once you have created the example in Lime: 

• Press Alt, Control, and Shift (Windows) or Option, Command, and Shift (Macintosh) and 
define a rectangle by dragging the mouse. 

• Choose Copy from the Edit menu. 
• Switch to the destination application and use paste to insert the rectangle.  The destination 

application may have a number of options for text wrapping, or sizing.  
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Dynamics/Crescendo and Diminuendo Hairpins 
 
 

 

Lime allows you to enter musical symbols by typing the combination of a backslash and a text 
character; these are translated into a musical character when editing is complete.  See the section on 
Backslash Characters for a more detailed explanation.  To create the dynamic marking in the 
example above: 

 
• Select Dynamic under the Text Category and type “\mf".  When you are done editing and go on 

to another annotation or exit from edit mode the backslash will translate the mf into a Marl 
character mf. 

Second method: 
• Select Dynamic under the Text Assistant and choose a dynamic.  

• You can change location by pressing Alt (Windows) or Option (Macintosh) while dragging the 
dynamic with the mouse. 

If the score calls for additional dynamic markings, you can copy and paste them.  It is efficient to do 
one type of dynamic (e.g.  mf, mp, ff, and pp) as a group:  

• Press Alt (Windows) or Option (Macintosh) and click on a dynamic marking. 
• Use Copy Annotation (under the Edit menu).  

• Click on a note to select it (or Shift-click on several notes for Note Group Select). 
• Use Paste Annotation (under the Edit menu). 

See the section on Dynamic Levels (under the Hear menu) to see how you can change the effect of 
dynamic markings on playback volume.  

Crescendo hairpins are made in Line Annotation Mode.  To make a hairpin: 
• Select the line symbol in the Piano Window. 

• Select the note you want to associate with the hairpin (the note will flash–it is important that the 
hairpin is associated with the correct note). 

• Select Hairpin (under the Annotation, Line menu). 
• Draw the hairpin by pressing Control (Windows) or Command (Macintosh) as you drag the 

mouse from the start to the end of the hairpin. 
• Make a crescendo by moving the mouse up as you draw the hairpin; make a diminuendo by 

moving the mouse down as you draw the hairpin.  

 

         


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• For hairpins that automatically resize select the note to which you want the hairpin extended and 
select Extend Line to Here under the Edit menu.  

After you draw the first hairpin, you can copy and paste it to several places by first selecting the 
hairpin with Alt-click (Windows) or Option-click (Macintosh), copy, then paste. 
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 Beaming Over Bar Lines and Over System Breaks 
 

 
 

Beaming over bar lines and off the end of the system is accomplished using Continue Beam and 
End Beam (under the Stem menu).  Continue Beam and End Beam are usually used with Note 
Group Select.  Select all notes (using Shift-click) to which you want to apply an end beam and 
choose End Beam.  Then select all notes to which you want to apply a continue beam and select 
Continue Beam.  

 

Beaming Rule and Control of Main Beams 
 

 
 
To achieve the first beaming pattern: 

• Click on the first note of the first measure. 
• Use Beaming Rule (under the Stem menu) to specify a beam pattern of 1,0,0,0.  

 
To achieve the second beaming pattern: 

• Click on the first C4 of that pattern. 
• Use Beaming Rule to specify a beam pattern of 2,0,0,0.  Enter 2 for “Longest Subbeam.”  

 
To achieve the third beaming pattern: 

• Click on the first note of the second measure. 
• Use Beaming Rule to specify a beam pattern of 3,2,4,2. 

If your measure is longer than the beam pattern, the beaming pattern repeats. 
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Beaming Rule is used to specify the usual way notes are beamed.  You may change the beaming 
rule at the beginning of any measure in your piece; just select the first note in the measure before 
using Beaming Rule.  Use End Beam and Continue Beam to make exceptions to your default-
beaming rule.  Use Default Beaming with Note Group Select to reapply the default-beaming rule to 
passages that have been changed using End or Continue Beaming.  
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Grace Notes 
Changing Clefs  

 

 

To create the grace notes in this example:  

• First play the normal (non-grace) notes.  
• Select the note which will be preceded by the grace notes. 

• Click on the 32nd note value at the bottom of the screen (since these grace notes have three 
beams), then click on the grace note and the slur. 

• Play the three grace notes in order. 
• To create an acciaccatura, or grace note with a slash (not shown), select the grace note, or first note 

in a grace note figure and choose Slashed Stem (under the Stem menu). 

 
To remove a grace note, select the grace note (make it flash by clicking on it), then use Clear Note 
(under the Edit menu). 

You can change the playback characteristics of grace notes; for details, see the section on Defaults 
(under the Hear menu). 
 

To add a clef change: 
• Select the note or rest after the intended clef change. 

• Add the clef using Clef (under the Symbol menu), specifying This Staff Only. 

Note that clef changes will appear in all notation contexts; if you add a clef change in the notation 
context for a part, it will also appear in the score.  

Arpeggiation Symbol   

To add an arpeggiation symbol (  ) before a chord: 

• Click on any note in the chord and choose Articulation in the Text Category menu. 
• Choose the Tufa font and 24 Point (under the Font menu). 

• Select Leave Space (in the Style menu), select Vertical Lock, deselect Horizontal Lock. 
• Press Control (Windows) or Command (Macintosh) and click to the left of the chord and type 's' 

(an arpeggio in Tufa). 
 

 

              
         
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To copy an existing arpeggiation symbol to several chords: 

• Press Alt (Windows) or Option (Macintosh) and click on the arpeggiation and choose Copy 
Annotation (under the Edit menu). 

• Select one note in each chord with Note Group Select (by Shift-clicking on one note in each 
chord), then use Paste Annotation (under the Edit menu).  When you are done, exit Note Group 
Select by clicking somewhere on the screen. 
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Tuplets, Duples 
 
 

 

To specify tuplet notes from the piano keyboard:  
• Click on the 3 in the Piano Window.  (If the 3 is not visible, click on the notes symbol at the left 

of the Piano Window first.) 
• Play the triplet notes.  

 
To change the 3 to a different value for other types of tuplets (e.g.  7 in the space of 4): 

• Double-click on the symbol.  You will be able to choose any tuplet value, or nested tuplets; use 
Tuplet Bracket to draw the tuplet brackets. 

To play two notes in the time of a dotted quarter: 
• Double-click on the 3 at the bottom of the screen.  

• Specify “2 in the time of 3” and hit Return.  
• Click on the 2, and click on the eighth symbol. 

• Play the duple notes.  
 

If you do not want Lime to print a single occurrence of a triplet 3: 
• Select the note at or to the right of the triplet 3 and use Hide Tuplet (under the Note menu). 

 
If you do not want Lime to print any triplet 3’s (and other tuplets): 

• Use Options (under the Edit menu) and deselect Print Tuplet Numbers. 
• Add 3’s in the places you want them using text annotations, or add brackets using Tuplet Brackets 

(under the Annotation, Line menu) with the Line symbol selected. 

Dotted Triplets 
 

 

The first and second measures in this example sound the same.  The second measure has dotted 
triplets.  To make dotted triplets shown in this example: 

 

      
              

3 3

2

7

 


       


       3 3
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• Select dotted note values as well as the 3 in the Piano Window when you play the dotted notes. 
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Layout 

How to Add A Staff to Your Piece 

The number of staves per system can be changed at the beginning of any system in your piece.  The 
number of staves in a system is determined by the Parts and Voices option (under the Voice menu); 
see the description of Parts and Voices for more information. 

In many scores, every system in the score has the same number of staves.  (This is the result if you 
only use Parts and Voices at the beginning of your piece.) If you have completed such a score, but 
you decide you want to add another part throughout the piece, this is the procedure: 

• Click on the first note or rest in the piece. 
• Use Parts and Voices (under the Voice menu) to create a new part, and to specify where the part 

should be printed.  You can move it up or down, or print it on a staff together with an existing part.  

Reduced and Enlarged Page Sizes 

Lime will print on any page size available on your printer.  You can create large scores if you have 
access to a printer that will print large page sizes.  If you only have access to 8.5 x 11 or A4 paper, 
you can still represent large scores by printing at a reduction.  When you change the page size in 
Layout Lime will display a dialog suggesting the amount of reduction you would need for an 8.5 x 
11 or A4 page.  The chart below illustrates the page sizes (in Layout) and amount of reduction 
required for various paper sizes (in Page Setup) and orientations. 
 

Paper size and 
orientation (in 
Page Setup) 

Print 
% 

Page size (in 
Layout) 

Paper size and 
orientation (in 
Page Setup) 

Print 
% 

Page size (in 
Layout) 

     

US Letter 

Portrait     
 

165 
132 
124 
110 
100 
90 
83 
76 
71 
66 

4.6 x 6.1 
5.7 x 7.6 
6.0 x 8.1 
6.8 x 9.1 
7.6 x 10.1 
8.1 x 11.1 
9.1 x 12.1 
9.9 x 13.1 
10.6 x 14.1 
11.4 x 15.2 

     
 
US Legal 
 
Portrait 

165 
132 
124 
110 
100 
90 
83 
76 
71 
66 

4.6 x 7.7 
5.7 x 9.6 
6.0 x 10.3 
6.8 x 11.6 
7.6 x 12.8 
8.1 x 14.1 
9.1 x 15.4 
9.9 x 16.6 
10.6 x 17.9 
11.4 x 19.3 

     
US Letter 
 
Landscape 

165 
132 
124 
110 
etc. 

6.1 x 4.6 
7.6 x 5.7 
8.1 x 6.0 
9.1 x 6.8 
(etc.  reverse 
of  above) 

 
US Legal 
 
Landscape 

165 
132 
124 
110 
etc. 

7.7 x 4.6 
9.6 x 5.7 
10.3 x 6.0 
11.6 x 6.8 
(etc.  reverse 
of  above) 
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Staff Separation Greater Between Systems 
First Line Indented 
Theory Symbols 

 

 

To indent the first line of your piece:  
• Choose Layout under the File menu. 

• Set Points to Left of Staff Lines to 20, set For Start of Piece (directly below) to 60.  

In this example the space between systems is greater than the space between staves within the 
system.  
 

To change default staff separation: 
• Select the first note in the soprano part. 

• Choose Parameters under the Symbol menu.  Locate “default vertical separation between this 
voice's staff and the next” under the heading “STAFF LINES, MARGINS, NOTE SPACING"; set 
this value to 55.  Make sure you have All Parts and Voices selected when you set this value. 

• Click Save Change. 

• Locate “default vertical separation between systems.”  Set this value to 70.  
• Click Save Change, then Quit. 

 
Theory Symbols 

 

To create annotations that stack vertically below a chord: 
• Select the bass note in a chord, select the text symbol. 

• Make sure Fingering (under the Annotation, Text Category menu) is selected. 
• Press Control (Windows) or Command (Macintosh) and click below the chord to position the 

cursor under the staff. 

 

  

















 




















 

 















 

 







 






4















  

  



  

 




5
3
2

4
2

6
5

7
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• Type the theory symbol numbers horizontally without a space.  For the first annotation in the 
example above, type “532.”  When you tab to the next note, the annotation will automatically stack 
the fingering numbers vertically below the chord.  
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Cue Staves  
 

 
  

This is the violin part of a violin and soprano work.  The soprano part appears on cue staves above 
the violin part.  To make a cue staff: 
• Click on the first note on the staff (the note will flash). 

• Use Parts and Voices (under the Voice menu) and change Staff Size from 5 to 3.  You may 
choose a staff size anywhere between 1 and 12.  5 is the default staff size.  

You do not need to use the Cue symbol at the bottom of the screen when you make cue staves; the 
Cue symbol is used if you have cue size notes on a normal-size staff. 

The text annotations associated with notes on the soprano voice will automatically appear in a 
smaller font size in the violin notation context, since the soprano voice is being printed on a smaller 
staff.  In cases where this is not desired, select the text annotation and uncheck Staff Size Adjust 
(under the Annotation, Style menu).  Staff Size Adjust has effect only in notation contexts where 
the voice is printing on a cue-size staff, and only affects staff sizes smaller than 5.  

If you change the staff size in Parts and Voices but it does not work (the staff is not printed a 
smaller size), then you probably have conflicting Parts and Voices specifications on subsequent 
notes on the staff.  You need to correct their staff size values.  

Parts and Voices arrangements can be different for each Notation Context.  For example, one 
Notation Context may have the piano as normal size and the violin in cue size, while another may 
have both as normal size, and a third with piano in cue size and violin in normal size.  The 
information (notes, slurs, etc) is shared between each context.  Changes to notes in one will change 
in all other contexts.  

 
Transposing to a New Key  

One clear advantage to computer notation is the flexibility and versatility when preparing parts for 
performance.  It is often valuable to produce vocal parts in another key to accommodate a 
performer's ability.  To transpose an entire piece to a new key:  
• Click on the first note on the staff (the note will flash). 

• Use Key (under the Symbol menu) to indicate the new key.  Check the box Transpose Notes and 
Chord Symbols to the New Key. 

• To transpose a single part, follow the same steps and select Current Staff Only. 

 







  


 





   

 


   



   



3

 

soprano

The wa ter of the Nile turned in to blood!


violin

- -
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First and Second Endings 

First and Second Endings During Playback 
 

 
 

To produce first and second endings: 
• Use annotation mode to create a “1” and “2” above the first note of each measure.  After you type 

each number, you may need to Alt-drag (Windows) or Option-drag (Macintosh) it to the correct 
position. 

• Click the line symbol, select Bracket (under the Annotation, Style menu).  Select left only bracket 
for both lines.  Select the first note of each measure and draw the first and second ending brackets.  
Draw lines by Control-dragging (Windows) or Command-dragging (Macintosh) the mouse.  
Draw the first ending line beyond the beginning of the second ending bracket so that they overlap.  
You may want to use Align Annotations under the edit menu to make sure the two lines and the 1 
and 2 match.  (It is also possible to create these symbols using a normal bracket combined with a 
straight line.) 

 

The methods above produce printed first and second ending symbols only; they will not affect 
playback.  To declare a first and second ending that Lime will honor during playback: 

• Select the first note of the first ending.  Choose Bar Line from the Symbol menu. 
• Do not change the selected bar line unless you also want to change the type of bar. 

• Check Special For Hear Option and First ending. 
• Repeat for second ending. 

• You may also want to check Don't Count This Bar in Bar Numbering according to general copy 
convention. 

 

 

  

      
1 2
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Pallet Files 
Some users have found that with annotations that require some adjustment it is helpful to store them 
for reuse in a pallet file.  Pallet files are Lime files that contain all the annotations that you frequently 
use.  When you edit a Lime piece, open your pallet file at the same time.  Then when you need an 
annotation that you already have in your pallet file, you can copy it from the pallet file and paste it 
into your piece. 
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Spacing 
 

 
 

In this example, each staff has the same music, with different note spacing parameter values.  From 
top to bottom the note spacing parameter values are 0.1, 0.3, and 0.5.  The normal value is 0.3.  Note 
length is least important for spacing at the top, and most important at the bottom; note length has 
more effect on spacing as the note spacing parameter increases. 

To change the note spacing parameter for the whole piece: 
• Use Options (under the Edit menu). 

 
To leave extra blank space before a single chord: 

• Use text annotations with the Leave Space (under the Annotation, Style menu) text annotation 
control selected.  

 
To move one chord around with or without affecting placement of other notes: 

• Use Chord Drag.  (See the section on Chord Drag for details.) 
 

To change the note spacing parameter at some point in your piece: 
• Select the first note on the system. 

• Use Parameters (under the Symbol menu); select All Parts and Voices; then change Effect of 
Note Length on Spacing in the note spacing parameters. 

If you have few notes on a system, Lime can space them strictly according to their note values and 
your note spacing parameter.  If you have too many notes on a system, or if you have many lyrics 
with the Leave Space annotation control selected, Lime will not be able to place notes strictly by 
note value.  You can make your music less dense by having fewer measures per system or by 
selecting a larger page size. 
 

 

                

                

                
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Pickup Measures 
Brackets to Left of Staff 
Bar Lines Between Staves 

 

 

To make the pickup measure shown in this example: 

• Select the first note or rest in the piece. 
• Use Insert Measures (under the Page menu) 
to insert one measure of 1/8  
• This will not affect the time signature.  Time 
signatures are independent of the number of beats in 
any measure. 

These staves are grouped by the pattern of bar lines 
connected between the staves, and by brackets to the 
left of the system.  To set up this grouping: 
• Group Select the first note in the second 
measure of the clarinets, violin 1, and violin 2, and 
use Bar Line (under the Symbol menu).  Specify 
This Staff Only and Draw Bar Line on Staff and to 
Next Staff, and Copy Bar Line Drawing to 
Remainder of Piece. 
• Repeat this step for bassoons, horns, viola, and 
“BI”, then specify This Staff Only and Draw Bar 
Line on Staff, and Copy Bar Line Drawing to 
Remainder of Piece. 

 

 











































 















 







  

[Allegro  = 92]

Cl.I.II.

Bsn.I.II.

Hn.I.II.


Vln.I


Vln.II.


Vla.

Che

BI.

par

Vc. and Cb.
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• The brackets correspond with the bar line arrangement, so you can set the pattern of brackets drawn 
to the left of the system at the same time you use Bar Line for each staff.  After you have made your 
selections for bar, use System Bracket (under the Symbol menu), and specify This Staff Only and 
either Draw Bracket on Staff or Draw Bracket on Staff and to Next Staff.  The “BI” 
(BIONDELLO) staff has no bracket drawn at the left of the system, so specify Don’t Draw Bracket 
On Staff for the “BI” staff.  You will probably select Copy Bracket Drawing to Remainder of 
Piece every time you use System Bracket; for details see the description of System Bracket. 
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Widths of Systems and Margins 
 

  

This example shows systems that have varying widths.  Changes in system width are achieved by 
changing the size of the left and right margins: 

• Use Layout (under the File menu) to change the overall size of the margins.  The units are 
“points”; there are 72 points to the inch, so if you want a margin to be one inch wider, add 72 to the 
size of the margin.  Layout has a special margin for the first system; this is often used when 
labeling staves in an orchestra score. 

• To change the right margin size for individual systems, as in the example above, select the first 
note in the system, then use Parameters (under the Symbol menu) to change Margin Width on 
Right Side of Page in the margins parameters. 

In this example Insert Measures (under the Page menu) was used once to make the 4/4 measure, 
and again to make the 10/4 measures.  Parts and Voices (under the Voice menu) was used to print 
four voices in the first system (one stem up and one stem down on each staff) and one voice on the 
other systems. 

 







 















Lord,All: have mer cy.-

     
In peace let us pray to the Lord.

     
For the faithful who have gone
before us and are with you let us give thanks to the Lord.

    
Help, save, comfort and defend us, gra cious Lord.-
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Scores 

Part Extraction from a Score using Notation Contexts 
Note Head and Rests Shared Between Two Parts 

 
 

 
 

Clarinet Notation Context: 
 

 

This example shows a score (starting at measure number 7) and the first clarinet part (starting at 
measure number 1).  See the next page for a discussion of this example.  

Before extracting parts from a score, notate the whole score, keeping the following in mind: 

• When you have two instruments printing on one staff, use one part for each instrument, and print 
both parts on the same staff using Parts and Voices (under the Voice menu) to specify that parts 
print together on one staff.  Parts and Voices allows you to specify that a part is to print with 
stems up (like the first clarinet part) or with stems down (like the second clarinet part).  Use Parts 
and Voices to control stem directions –—if you use Stem Up and Stem Down (under the Stem 
menu) it will affect the stem direction in the extracted part as well as the score!  Remember to 
select a note (often the first note in the piece) before you use Parts and Voices. 
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[Allegro  = 92] dolce
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Part Extraction from a Score using Notation Contexts, continued 
Note Heads and Rests Shared Between Two Parts, continued 
 
• Use All Notation Contexts (under the Annotation menu) for annotations which are to appear in 

the score notation context and the parts notation contexts; use Only In Score for those which are to 
appear only in the score notation context.  Use Duplicate In Every Context for annotations (such 
as tempo markings) which appear only once in the score notation context but also in every part 
notation context (see the tempo marking example).  Use This Notation Context Only for 
annotations in that context only. 

• If you have a note head shared between two different parts or voices (see the first note for the 
horns), or if you have a rest shared between different parts or voices, clicking on the note or rest 
may not get you the part or voice you want.  The title bar at the top of the Lime window indicates 
which part and voice you have selected.  If you have the wrong part or voice selected use Next 
Part or Voice (under the Voice menu) or Previous Part or Voice, or the up or down-arrow key to 
get to the second part or voice. 

When you have completed the score, you can extract the parts: 

• Use Part Extraction (under the Context menu) to create new notation contexts, one for each part.  
• When you edit each notation context, use Only in This Context for annotations which appear in 

the part notation context and not in the score notation context.  
• If you created annotations in the score that erroneously have Only in Score selected, you can 

correct this by editing the score, selecting all the annotations with Annotation Group Select, and 
then choosing All Notation Contexts. 

• You can change system breaks and page turns in each notation context without affecting the other 
notation contexts, as shown in the example above.  If you change the notes in a notation context, 
they will also change the score. 

• Layout (under the File menu) and Options (under the Edit menu) keep separate information for 
the score notation context and the parts notation contexts.  This allows you to specify different 
margins and page sizes for the score and the parts. 

• Part Extraction allows great flexibility in arranging parts and scores.  Since note values and 
specified annotations are shared between the different notation contexts the score represents the 
“master” document and there is no limit to the number or variety of parts that can be extracted.  
Any combination of parts (including all parts for a second or third “score”) may be combined for 
an extracted part.  Each of these extractions, including second and third scores, can have their own 
layout, size of staves, options, etc.  

When you type an annotation in the score, keep in mind that the annotation will appear in the same 
relative location in the extracted part as in the score.  In the example above, “p” appears below the 
passage in the clarinet, but above the passage in the score.  If you want the score notation context and 
parts notation contexts to have the annotation at different locations, make one copy of the annotation 
just for the part (set Only in Part when you have it where you like it) and another just for the score 
(set Only In Score) as in the example above.  The “dolce” was entered using All Notation Contexts 
and appears both in the score and in the part at the same location.  Changes made to this annotation 
will be reflected both in the part and notation context in the score notation context.  
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Part Extraction from a Score using Notation Contexts, continued 
Note Heads and Rests Shared Between Two Parts, continued 
 
Some special comments about rests and extracting parts: 

• If you have several measures of rests in a row, they may appear separate in the score notation 
context, but combined into a single multi-rest in the parts notation contexts.  Use Don’t Combine 
Rest (under the Note menu) to avoid having the rests combined. 

• Rests will not be combined in any notation context if there are annotations associated with the 
rests.  This is very important: When you edit the score, avoid associating annotations with rests that 
you want combined in the parts notation contexts.  Or, you can use this effect to your advantage.  
In the part a group of rests should be split if there is a rehearsal number on a bar within the rest 
group.  To do this, assign the letter to the measure where it applies.  In the part the single combined 
rest will be split into two combined rests with the rehearsal letter at the bar where it was assigned. 

In this example, rests are shared between the two parts printing together on one staff.  To avoid 
sharing rests on a staff with two parts: 
• Select Highlight Voice (under the Voice menu); then select a note/rest from the upper voice on the 

staff on which you want to stop sharing rests. 
• Use Note Group Select to select all the rests, and select Stem Up (under the Stem menu). 

Here are some suggestions for scores with two voices printing together on one staff: 

• When you have two parts or voices printing on one staff, as on the first three staves in the score 
above, use Parts and Voices to specify that one part is all stems up, and the other is all stems 
down.  

• Keep one part with all stems up and the other with all stems down until you have transcribed all the 
notes.  When you have finished, you can go back and change the Parts and Voices settings for 
mixed stem directions, or you can stop printing one of the parts in certain places in the piece. 

As you are transcribing the notes, you will want to add text annotations.  Normally you want text 
annotations to appear only once in the score, but you want them to appear in both parts' notation 
contexts when you make notation contexts for the individual parts.  Here is a procedure you can 
follow: 

• Select a note on one of the voices, then type the text annotation. 
• Select the text annotation (Alt-click or Option-click); copy it (Control-c or Command-c); and 

select Not In Score (under the Annotation menu).  The text will disappear from the screen; it is no 
longer visible in the score, but it will be visible in the part's notation context. 

• Select a note from the other part, and paste (Control-v or Command-v).  Select All Notation 
Contexts (under the Annotation menu); this means the annotation will be visible in all notation 
contexts which have that part (in other words, it will be visible both in the score notation contexts 
as well as that part's notation contexts). 

If you plan to do part extraction, it is especially important to understand the Annotation controls at 
the bottom of the screen; see the section on Annotation Controls for more information. 
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Staff Labels 

 

Rulers and Grids are useful when doing annotations such as staff labels.  Turn on Rulers and 
Grids in the Layout dialog.  

Each staff in this score is labeled with the instrument names.  To adjust the left margins to make 
room for such labels: 

• Specify larger margins using Layout (under the File menu).  

To type a label for a staff: 

• Choose the text symbol at the bottom left of the screen. 

• Select Label (under the Annotation, Text Category menu) 
• Click on the first note on the staff (it will flash) and type your staff label.  

To change the location of a staff label: 
• Press Alt (Windows) or Option (Macintosh) and drag the staff label.  

To center all the staff labels under the topmost label (not in example): 

• Finish typing all the labels then select them using Annotation Group Select; Alt-Shift-drag 
(Windows) or Option-Shift-drag (Macintosh) around them. 

• Use Align (under the Edit menu) with Middle of Top Annotation. 

To make all the labels appear at the start of staves in all subsequent systems: 

• Use Annotation Group Select as described above to select all the labels and use Duplicate At 
Each System (under the Edit menu). 

To make the labels on your first system different from the labels on all subsequent systems: 

• Type the labels on your first system. 
• Type the labels on your second system. 

• Use Duplicate At Each System on the labels on your second system. 
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For more details, see the description of Duplicate At Each System. 



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 141 of 206 

Titles 
Titles Using Duplicate In Every Part 

 
 

 
 

Rulers and Grids are useful when doing annotations such as titles.  Turn on Rulers and Grids in 
the Layout dialog.  

The title for a piece is a text annotation.  To add a title: 
• Click on the first note/rest in the piece. 
• Choose the text symbol and select Title from the annotation Text Assistant. 

• Press Alt (Windows) or Option (Macintosh) to select and change or edit a title that has been 
created using the Text Assistant.  For example, you may not want the title centered.  You can 
uncheck Centered (under the Annotation, Style menu). 

If you plan to use Part Extraction to create notation contexts, you will probably want the title to 
appear in all the parts.  To do this: 
• Select the title (Alt-click or Option-click). 

• Use Duplicate In Every Context (under the Edit menu).  

When you use Duplicate In Every Context, the title is duplicated onto all parts.  Since you don’t 
want the title to print on every part in the score, the Not In Score attribute was automatically 
selected for each of the duplicate titles.  You will see the effect of Duplicate In Every Context 
when you create new notation contexts: the title will appear at the top of each part.  You will be able 
to move the title around in each notation context (or change the point size) without affecting the 
score notation context or the other parts notation contexts.  If you want to move or change all the 
titles: 

• Make the change to the title in the Score. 
• Alt-click (Windows) or Option-click (Macintosh) on the title and use Clear In Every Context 

and Duplicate In Every Context (under the Edit menu).  This clears out the old titles and 
duplicates your new titles. 
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For another use of Duplicate In Every Context, look at the Tempo markings example that follows.  
For more details, see the description of Part Extraction, Notation Contexts and Duplicate In 
Every Context. 
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Tempo Markings Using Duplicate In Every Context 
 

 

The tempo marking in this example was created using Duplicate In Every Context.  This tempo 
marking should appear only once in the score notation context, even though there are many parts and 
staves in the score.  However, the tempo marking should appear in each individual notation context 
when they are extracted and printed.  To type the tempo marking:   

• Select the first note of the first staff (click on the note/rest). 
• Select the text symbol at the left side of the Piano Window. 

• Select Tempo from the Text Assistant to create the tempo marking. 
• Press Alt (Windows) or Option (Macintosh) to select and change the location or edit a tempo that 

has been created using the Text Assistant.  

To make the tempo marking appear in all the notation contexts you will use for printing the 
individual parts: 
• Select the tempo marking;  (Alt-click or Option-click). 

• Use Duplicate In Every Context (under the Edit menu).  This will have no immediate visible 
effect in the score notation context, but it will make the tempo marking appear in all the individual 
parts notation contexts (by creating Not In Score annotations).  This can be done before the score 
is completed and before the individual parts notation contexts are created. 

For another use of Duplicate In Every Context, see Titles Using Duplicate In Every Context 
above.  For more details, see the description of Part Extraction, Notation Contexts and Duplicate 
In Every Context. 
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Tempo Markings That Affect Playback 

 

      

A tempo marking that will affect playback must contain ,  ,  ,  , or  (\w, \h, \q, \e, \s); this can 
be followed by a dot (i.e., \qd); then there must be a “=” followed by an number.  See the selected 
annotation above.  

When you press Alt (Windows) or Option (Macintosh) and click on a tempo marking which Lime 
will use for playback, the Annotation Window shows the tempo (see the bottom right of the 
Annotation Window above).  If you do not follow the correct format for playback tempo markings, 
the Annotation Window will not display the tempo.  You can use this to make sure you have typed 
your tempo correctly. 

 

 

 
In this example the “Andante” annotation 
affects playback because it contains the 
proper tempo marking characters.  

 

 

To indicate a tempo with a dotted value, 
type a “d” after the duration.  This tempo 
marking is typed as “\qd = 100.”  

A tempo marking on one part will affect all other parts.  Tempo markings only affect notation 
contexts in which they are visible.  Use Duplicate In Every Context to copy tempo markings to all 
notation contexts if you want them to appear (and affect playback tempo) in other notation contexts. 
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Scanned Music (Optical Music Recognition) 

Scanning Sheet Music and OMR  

The SharpEye Music Reader® is one of the most sophisticated OMR programs available, and it 
creates NIFF files that can be opened in Lime.  (OMR stands for Optical Music Recognition, 
technology used for interpreting scanned sheet music).  SharpEye is available from 
http://www.visiv.co.uk/SharpEye allows you to scan sheet music and correct scanning errors using 
SharpEye’s editor; then you can use SharpEye’s File menu option NIFF Save and open temp file; 
then you can then continue editing within the Lime program.  

If you like, you may purchase integrated OMR for Lime.  Without integrated OMR, you run 
SharpEye (or some other sheet music scanning program) separately from Lime, and then import the 
scan results into Lime.  If you use the integrated scanning feature, SharpEye Music Reader® OMR 
technology is directly integrated into Lime – you bypass the SharpEye editor and correct all scanning 
errors within Lime.  This is an advantage for blind users because SharpEye’s editor does not lend 
itself to use by the blind; blind and low vision users can purchase an accessible version of Lime 
(Lime Aloud or Lime Lighter, from Dancing Dots) and do all their scan editing within Lime.  
Integrated OMR capabilities are available through Dancing Dots  at http://www.dancingdots.com/; 
non-integrated SharpEye is available at http://www.visiv.co.uk/.  

Correcting OMR Results  

Editing scanned music in Lime, whether it comes from integrated OMR or SharpEye or another 
scanning program, is somewhat different from editing music you enter from the MIDI keyboard: 

If OMR misidentifies the clef, your notes may appear on the correct lines and spaces on the staff, but 
the pitches will be wrong.  When you use the Clef menu option to specify the correct the clef, select 
Graphic Change Only so that Lime re-interprets the notes in the same positions with the new clef. 

If OMR misidentifies the key, your notes may appear with the correct accidentals, but the pitches 
will be wrong.  When you use the Key Signature menu option to specify the correct the key, select 
Graphic Change Only so that Lime re-interprets the notes with the same accidentals with the new 
key. 

If OMR makes duration errors, the following section describes the procedure for correcting the 
errors.  Lime sometimes adds red rests to deal with duration errors; the red rests will disappear once 
you correct all the duration errors. 

Lime can be used for correcting OMR errors in scanned music, but some users find it most expedient 
to fix as many OMR errors as possible with the scanning program before editing within Lime.  

http://www.visiv.co.uk/�
http://www.dancingdots.com/�
http://www.visiv.co.uk/�
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Correcting Note Lengths  

 

     
 Error from scanned music Corrected version 

 

This music was made by scanning sheet music and OMR (Optical Music Recognition).  Note the 
incorrect duration in the left example, the sixteenth C5 should be a quarter.  

If there are incorrect note values in a measure, you can fix the problem by clicking at the beginning 
of the measure, and entering the correct notes over the old notes in the measure.  Alternatively, you 
can change the durations of individual notes.  To correct the example at the top of the page: 

• Select Allow Duration Edits from the Edit menu.  (This is done for you for scanned music.) 
• Click on the fifth note (the sixteenth note C5). 

• Click on the quarter note in the Piano Window. 

This method of changing note values, and the Kill symbol in the Piano Window, should not be used 
when doing standard copy since the length of the measure is changed when these operations are 
done.  Conflicting measure sizes will result, particularly in multiple voice works, if these features are 
used incorrectly.  However, errors in scanned music result in precisely this problem: incorrect 
measure sizes.  Using Kill or Enable Duration Edits will correct this problem.  
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Red Rests 
 

                      
 

When there are timing inconsistencies in a measure due to OMR scanning errors, Lime will generate 
red rests.  The purpose of the rests is only to make all the voices within a bar the same length.  Do 
not delete the red rests; instead, look for duration errors in the measure that has the red rests (on all 
staves within the system); correct the duration errors, then the red rests automatically disappear.  

The most common way to get rid of a red rests is to correct a duration error elsewhere in the bar 
(possibly on another voice); click on the incorrect note or rest once (so it flashes), then select the 
corrected note value in the Piano Window.  (This operation requires that you have Enable Duration 
Edits selected in the Edit menu.) On some occasions you need to insert new rests (as opposed to 
changing the durations of existing notes or rests); to insert a new rest select the note after the new 
rest, and click the rest icon in the Piano Window. 

Ignore any note beaming errors or other problems until all the red rests are gone.  Finish correcting 
duration errors in each measure before continuing to the next measure. 

In the left example above, a red sixteenth rest appears on the lower staff.  After the note duration is 
corrected on the upper staff, the red rest disappears, as shown in the right example above. 
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Splitting Voices 
 

 

This example was made by scanning sheet music, and importing into Lime (using Import NIFF 
under the File menu).  When Lime opens a NIFF file which has several voices of music on a single 
staff playing different rhythms, it will offer to split the music on the staff into two voices (keeping 
both voices on a single staff).  Some types of music will work best this way and some may not.  The 
example above was not split into two voices when Import NIFF was used.  A single Lime voice can 
be used for the bass staff, but the treble staff is too complex to be represented with a single Lime 
voice, and must be split into stem-up and stem-down voices to be notated properly.  Below is an 
example of the same music with voices split.  We suggest you try both methods 
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Percussion Music 

Percussion Staff 
 

 

This is part of an orchestral score.  The percussion part is printed with a single staff line.  

To specify the number of staff lines: 
• Select the first note on the staff. 

• Use Parts and Voices (under the Voice menu) and type the number of lines. 

If you set the number of staff lines to 1 in Parts and Voices but it does not work (the staff is still 
printed with 5 lines), then you probably have conflicting Parts and Voices instructions on 
subsequent notes on the staff.  You need to correct the number of staff lines they specify. 

To print a percussion clef on the percussion staff (not done in this example): 

• Select the first note. 
• Use Clef (under the Symbol menu) and select a percussion clef. 

To avoid printing any clef at all on the percussion staff (as in this example): 
• Select the first note on the staff. 

• Check the Hide Clef checkbox in Clef (under the Symbol menu).  This will avoid printing the clef, 
but the clef will still specify the pitch of your center staff line, so normally an alto clef is selected. 

To avoid printing a key signature: 
• Select the first note on the percussion staff. 

• Specify C Major and This Staff Only in Key Signature (under the Symbol menu).  

 





 



 

tuba

cymbals


 snare drum


cymbals

cresc.





Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 150 of 206 

Tremolo Between Two Pitches 
 

 a. b. c. 

  

This example indicates sixteenth notes alternating between two pitches for a half note duration.  To 
make this example:   
• Engage the note entry cursor by double-clicking on a note.  Double-click on the 3 in the Piano 

Window.  • Specify “2 in the time of 8” and hit Return.  (This indicates that these two sixteenth 
notes actually take the place of 8 sixteenths.) 

• Click on the 2 box, and click on the sixteenth box, play the two notes. 
• If the two notes are not beamed together (a), select Continue Beam and Continue Subbeam 

(under the Stem menu) for the first note (b). 
• Group Select both notes and select Hide Tuplet under the Note menu. 

• While the two notes are still shaded, select Tremolo Beam (under the Stem menu).  This will give 
you the result shown at the top of the page. 

Notice that tremolo beams always have tuplet values in the form of “2 in the time of x”, where x 
determines the total duration. 

 

 
To make the example on the left: 
• Follow the procedure above, but specify “2 in the time of 6” and use the eighth note value box. 

 
To make the example in the middle: 

• Follow the procedure above, but specify “2 in the time of 32” and use the thirty-second note value 
box. 

 
To make the example on the right: 

• Follow the procedure above, but specify “2 in the time of 8” and use the sixty-fourth note value 
box. 
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If Lime places the second note in the tremolo beam too close or too far from the first note, move the 
second note using the second type of Chord Drag.  (See the Chord Drag section for a discussion of 
the two types of Chord Drag.)  To change other aspects of the appearance of tremolo beams, use 
Parameters (under the Symbol menu).  
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Piano Music 

Two Voices on One Staff in a Piano Score 
 

 

Piano parts require at least two voices; one for the right-hand staff, and one for the left-hand staff.  
Often, the piano part uses several voices on each staff.  Parts and Voices (under the Voice menu) 
allows you to add another voice to a part, to start or end printing a voice at any point in the piece.  
Before you use Parts and Voices, be sure the note you have selected (the flashing note) is at the 
right point in the piece.  The example above involves four voices: 
• The stem-up notes on the right-hand staff of the first example are on one voice.  Stem Up (under 

the Stem menu) was not

• The stem-down notes on the right-hand staff of the first example are on another voice.  Stem 
Down (under the Stem menu) was 

 used to force stems up; rather, Parts and Voices was used to specify that 
the voice prints on staff 1, and that its stems are printed up. 

not

• All the notes on the left-hand part are on one voice.  Parts and Voices was used to specify that the 
voice prints on staff 2, without Uniform Stem Directions.  The other voice associated with the 
left-hand part does not print in this part of the piece, so End Voice was specified in Parts and 
Voices for that voice. 

 used to make the stems down; rather, Parts and Voices was 
used to specify that the voice prints on staff 1, and that its stems are printed down. 

 

 
 

• This second example shows the two voices in the right hand without Uniform Stem Direction 
selected under Parts and Voices.  Note that the stem directions are combined when the durations 
are the same.  They are separated when the durations are not the same.  Also, the rests are 
suppressed. 
 

 







 


   




 
 





    




   



 

     





 







 


    


 
 




    


    
 

  











Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 153 of 206 

Beaming Over Rests and Time Gaps 

 

 
 
To beam over a rest: 

• Use Note Group Select to select the note and the rest (by dragging the mouse), and use Continue 
Beam (under the Stem menu). 

 
To start a beam over a rest (not shown above): 

• Select the rest and use Continue Beam (under the Stem menu). 
 

To beam over a time gap, as shown above right, single voice method: 
• Use Note Group Select to select the stem-up notes (Shift-drag around them), and choose Stem Up 

(under the Stem menu). 
• Use Note Group Select to select the stem-down notes, and choose Stem Down (under the Stem 

menu). 
• Use Note Group Select to select all the notes except the last two chords, and choose Continue 

Beam (under the Stem menu). 
 

To beam over a time gap, as shown above right, two voice method: 
• Use Parts and Voices (under the Voice menu) to start a new voice on that part.  Specify that both 

voices print together on one staff, one with stems up, and the other with stems down. 
• Each voice has chords alternating with eighth rests.  Use Note Group Select to select all the notes 

and rests except the last two chords, and choose Continue Beam (under the Stem menu) and Hide 
Rests (under the Note menu). 

 

Piano Fingerings 
 

To create annotations that stack vertically above a chord: 
• Select any note in the chord, select the text symbol, press Control (Windows) or Command 

(Macintosh) and click above the chord. 
• Make sure Fingering (under the Annotation, Text Category menu) is selected. 
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• Type the fingering numbers horizontally without a space.  For the example above, type “521.”  
When you press TAB to move to the next note, the annotation will automatically stack the 
fingering numbers vertically above the chord. 
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Beaming Between Staves of a Grand Staff, Pedal and Pedal Release Marks 
 

 
 _________________  

This is an example of beaming between the two staves of a grand staff.  See a similar example 
below. 

Before you try beaming between staves, read the section on Parts and Voices, study the examples 
that have several voices on a two staff part, and experiment with Parts and Voices. 
Every staff must have a voice to maintain its position on the page.  When you do beaming between 
two staves, you must have one part with three voices on two staves.  Even if there is only one voice 
switching between staves and there are no notes in the upper or lower voice, they must be present as 
place holders: Voice one stays on the right-hand staff, voice two switches between the two staves, 
voice three stays on the left-hand staff.  

This is how three voices are used in this example: 
• The voice which stays on the right-hand staff has a dotted quarter chord at the beginning of the 

measure.  Parts and Voices (under the Voice menu) specifies this voice prints on the first staff 
with Stems Up.  This voice has a dotted quarter rest for the remainder of the measure, and this rest 
is hidden using Hide Rests (under the Note menu).  

• The voice that switches between the staves has an eighth rest followed by 8 thirty-second notes 
followed by a dotted quarter.  Initially, Parts and Voices specifies this voice is combined with the 
first voice and prints on the right-hand staff with Stems Down.  When the notes are first played, 
they all appear on the right-hand staff with stems down.  Select the 5th note, and use Voice to Staff 
Below to move the second voice to the left-hand staff. 

• The voice which stays on the left-hand staff has a dotted quarter chord at the beginning of the 
measure.  Parts and Voices (under the Voice menu) specifies this voice prints on staff 2 with 
Stems Down.  This voice has a dotted quarter rest for the remainder of the measure; this rest is 
hidden using Hide Rests (under the Note menu).  

Pedal and pedal release marks are annotations created using the Marl font.  They do affect playback 
but in order to be performed correctly they must be assigned to the correct notes.  

• Click on the note where you want the pedal sustain to begin, using annotation mode type "-" in the 
Marl font to create the Ped symbol.  Click on the note where the sustain should be released and 
type "=" in the Marl font to create the release symbol.  One release symbol and the next Ped 
symbol can be assigned to the same note. 
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Stems Across Staves of a Grand Staff 
 

 

This example shows chords with stems between the two staves of a grand staff.  This is different 
from the examples of beams between the staves of a grand staff shown earlier.  This example is a 
single part (e.g.  a piano part) containing three voices. 

To make this example: 
• Use Parts and Voices (under the Voice menu) to specify that two voices print on the right-hand 

staff, one voice with stems up and one voice with stems down.  Specify that a third voice prints on 
the left-hand staff. 

• Play all the notes for the two voices on the right-hand staff.  Now you should have the music 
shown below. 

• Use Hide Rests (under the Note menu) on the left-hand staff. 
• Use Note Group Select to select the notes you want moved to the left-hand staff (all the low notes 

on the stem down chords) and use Stem Between Staves (under the Stem menu). 
• Note that in order for this function to work the stems must be pointing in the direction of the 

destination staff. 
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Beaming Between Staves of a Grand Staff, Dashed 8va Line 
 

 

This is another example of beaming between the two staves of a grand staff.  This example is a single 
part (piano part) containing three voices as described above. 
• The voice which stays on the right-hand staff has the stem-up note chord at the beginning of the 

measure; it has rests for the remainder of the measure, and these rests are hidden using Hide Rests 
(under the Note menu).  

• The voice which switches between the staves has all the other notes.  Initially, the voice is on the 
left-hand staff along with the third voice (the third voice has rests only); when the notes are first 
played, they all appear on the left-hand staff.  Then Voice to Staff Above and Voice to Staff 
Below (under the Voice menu) is used to specify that voice two moves between the right and left-
hand staves.  Since the voice switches between the right hand and the left-hand staff 9 times, Voice 
to Staff Above/Below is used at 9 different chords.  

• The third voice, the one that remains on the left-hand staff, has no notes at all; it has only rests, 
which are hidden using Hide Rests.  

To create the 8va symbol with a dashed line 
 

• Select the first note in the measure and enter Text Annotation Mode.  Choose Marl font and type 
Shift-\.  Select the annotation using Alt-click (Windows) or Option-click (Macintosh) and drag it 
above the note to the correct position.  With the first note still selected, enter Line Draw mode.  
Press Control (Windows) or Command (Macintosh) and click at the point where you want the 
line to begin and (while holding down the Control key or Command key) drag the arrow to the 
point where you want the line to end.  

• Select the line with Alt-click or Option-click.  Select Dashed… under style.  Enter 2 for the dash 
and 4 for the gap. 

• To create an 8va line that automatically resizes, select the ending note, and use Extend Line to 
Here under the Edit menu.  
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Piano Tablature 
 

 

This is an example of piano tablature; a graphic representation of the piano keyboard using lines and 
spaces.  The spaces correspond to the white keys on the piano and the lines to the black keys.  

To convert traditional notation into piano tab: 

• Use Parts and Voices (under the Voice menu) to choose Piano Tab RH or LH.  Use Piano Tab 
RH for music that falls between C4 and E5 (the treble staff).  Use Piano Tab LH for music that 
falls between F2 and B3 (bass staff).  

• For sections of music where most of the notes fall outside the piano tablature, Transpose (under 
the Note menu) may be used to move the passage within the keyboard range.  

•  A similar arrangement to that used with guitar tablatures can be achieved using four staves per 
system, the upper two and lower two containing the same music.  The top two can be used for 
piano tablature and the bottom two for traditional notation.  In the example below the upper two 
staves have been set to Piano Tab RH and LH, with a point size of 3.  
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Vocal Music/Lyrics 

SATB Score 
Several Voices on One Staff in Vocal Music 

 

In this example all stems in the soprano and tenor are stem up and the alto and bass are stem down 
even when the value of the note is the same (i.e.  both parts have quarters).  This is standard notation 
practice for vocal parts 

 
To force stems up/down: 

• Set up a score with four parts and use Parts and Voices to set soprano and alto to print on the top 
staff.  Check Uniform Stem Direction and Stems Up on soprano and Stems Down on alto.  Set 
tenor and bass parts to print on the second staff.  Check Uniform Stem Direction and Stems Up 
on the tenor and Stems Down on the bass. 

• In this example the “normal length of stems” under “Note Stems” in Parameters has been set to 
12. 

 Repeating Lyrics in a Score 

 

Lyrics are usually added after all the notes have been transcribed.  If several parts have the same 
lyrics and rhythms but different pitches (as in the example above), an alternate procedure might be 
used: 
• Transcribe the notes for one of the parts. 

• Type the lyrics for that part. 
• Copy the notes and lyrics.  Use Copy Measures (under the Edit menu) if the measures line up; in 

the example above the measures do not line up, so select the notes you want to copy (using Note 
Group Select) and copy them with Control-Shift-c (Windows) or Command-Shift-c 
(Macintosh). 
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• Paste the notes and lyrics onto another part; then replay the notes for that part.  The lyrics for the 
old pitches will remain when you replay the new pitches. 
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Text Annotations on Variable Staff Sizes 
Centered Hyphens and Extended Underlines in Lyrics 

 
 

 
 

In part extraction, it is often useful to include cues.  This is an example of a violin notation context 
that has the soprano part on a cue staff.  To do this: 

• When you use Part Extraction to create the notation context for the violin, include both the 
soprano and the violin part. 

• Use Parts and Voices (under the Voice menu) to make the soprano part print on a smaller size 
staff.  You can select a value between 2 and 12 for staff size.  5 is the standard size staff, 3 is 
standard for cue size staves.  

• The text annotations associated with notes on the soprano part will automatically appear in a 
smaller font size in the violin notation context, since the soprano part is being printed on a smaller 
staff.  In cases where this is not desired, select the text annotation and uncheck Staff Size Adjust 
(under the Annotation, Style menu).  Staff Size Adjust has effect only in notation contexts where 
the part is printing on a cue-size staff, and only affects staff sizes smaller than 5.  

To make the centered hyphens and extended underline: 
• Select the first note, select the text symbol (the second symbol at the bottom left of the screen), 

then select Lyrics Settings at the bottom of the screen. 
• Make sure Center Hyphen and Extend Underline (under the Annotation, Style menu) are 

checked. 
• Type the following:  “The”, Tab, “wa-”, Tab, “ter”, Tab, “of”, Tab, “the”, Tab, “Nile_”, Tab, 

“_”, Tab, “_”, Tab, “turned,” etc.  (Leave out the quotes when you type the text.) 
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Chant11

  

 

Most of the techniques required for transcribing chant (such as cue notes, and parentheses) are 
treated elsewhere.  This example addresses the characteristics that most distinguish transcribed 
chant: mixed bar-line or phrase lengths, missing time signatures, and no stems.  

The primary difficulty with Chant is that phrase lengths or “bars” are inconsistent.  One phrase might 
be thirteen eighths, while the next might be nine eighths.  There are a number of methods for creating 
mixed bars or phrases.  Some users insert measures that are the same length as each phrase of music.  
For the example above you would insert three bars of 13/8 for the top line, then a bar of 15/8, then a 
bar of 19/8, then 10/8.  This method is safer, but slower.  
 

Here is the fastest method: 
• Begin with measures of whatever length is handy.  (This example was created in 4/4.)  

• Enter all pitches as quarter notes regardless of their actual length.  
• Choose Allow Duration Edits under the Edit menu. 

• Use the duration symbols in the Piano Window in conjunction with Note Group Select to change 
existing notes to the correct durations.  For example, Shift-click on all quarter notes that should be 
dotted quarters, then click on the Piano Window quarter note symbol to select a dotted quarter. 

• Delete unwanted bars using Note Group Select and Bar Line (under the Symbol menu). 

• Use Bar Line under the Symbol menu to add breath marks.  These are understood as bar lines by 
Lime and can be used with Copy Measures (under the Edit menu) or Go To Bar… (under the 
Page menu).  

To remove the time signature and stems: 

• Click on the note following any time signature and use Time Signature under the Symbol menu to 
delete the time signature. 

• Time signatures are not required for entering or playing music in Lime.  They affect measure 
groupings and spacing, but can be removed without affecting the size of the measures.  

 
To remove stems:  

• First enter all the music with stems.  

                                                

11 Stone, page 329. 
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• Select all notes on the page by dragging the mouse and choose No Stem from the Stem menu. 
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Guitar Music 

Guitar Music (More Than 2 Voices on a Single Staff) 
 

 

This type of operation requires some planning.  It may require Chord Drag (first select Only 
Dragged Chord Moves in the Chord Drag… menu option) and/or changing the default stem length 
(in Parameters under Symbol menu) to get everything to look right.  In the example above the 
bottom line has been located slightly to the right of the beat.  This is consistent with guitar literature. 
 

 
 

• Begin by constructing the music on two staves.  For the example above, use one part, three voices, 
the first and second voices should be assigned to staff one (use Parts and Voices), and the third 
voices assigned to staff two.  

• Enter the music and arrange it such that it will look correct when the two staves are combined 
(using Chord Drag… with Only Dragged Chord Moves selected – to arrange notes that occur on 
the same beat).  In this example, Chord Drag was used to relocate all the notes in the lower part 
slightly to the right. 

• Position the cursor on the first note of part one (staff one) and select Parameters.  Find “default 
vertical separation between this voices staff and the next” under STAFF LINES, MARGINS, 
NOTE SPACING and enter 0.  (It is also possible to drag one staff over the top of the other using 
Staff Drag, but the Parameters method is more practical.)    
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Guitar Chord Grids 

  
To make the first chord symbol using the annotation Text Assistant: 
• Choose the text symbol. 

• Use the Text Assistant (under the Annotation menu) to choose Chord Symbol. 
• Select G for chord and MA for quality. 

• The text below shows how you would create the chord by typing characters using the Tufa font.  
 

To make the second chord symbol manually: 
• Choose the text symbol. 

• Choose the Tufa font and 24 Point (under the Font menu). 
• Type the following: A``4`3``!2!`!  The “A” makes the fret grid without the nut.  This is followed 

by two characters for each guitar string.  The first character is a fret number for a dot (or ` to avoid 
printing a dot on that string).  The second character is a shifted number, which specifies the fret 
number for a bar (or ` to avoid printing a bar on that string).  Here the following pairs of characters 
were specified for each string: ``, 4`, 3`, `! , 2!, and `!. 

An alternative to fret grid notation is the tablature notation (see the example below, and the 
description of Tablature String under the Note menu).  

Guitar Tablature 

 

To make this example start with two voices, each assigned to its own staff.  Enter the music in the 
first staff.  Copy and paste the same music (using Copy Measures) into the second staff. 
 

• Open Parts and Voices in the Voice menu.  Select the second voice. 
• Check the box labeled Tab or Stem Tab. 

• You can specify the tuning of each open string in Parameters.  
• You can also force a particular note (or a group of selected notes) to a particular string using 

Tablature String… under the Note menu.  
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Unisons (played on separate strings) are possible in Guitar Tablature using Add in the Piano 
Window.  Click on the existing note or chord, choose Add and enter the pitch again.  The second 
pitch will appear on the next highest string, with the appropriate fret number.  
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Banjo, Lute, Mandolin Tablature 
Chapman Stick Notation 

 

 

Banjo, lute, mandolin, and Chapman Stick tablatures can be created using Parameters to change the 
base tuning for each tablature string and Parts and Voices to set the number of lines for the tablature 
staff.  The base pitch for each string is entered as an integer where 60 = C4 (middle C).  Each 
chromatic pitch increases or decreases this number by 1; 48 = C3, 72 = C5, 62 = D4, 64 = E4, etc.  

Chapman stick notation requires reverse tuning on the lower tablature staff.  In addition, the 
thickness of the lower tablature staff's lines decreases with each line.  This is possible in Lime using 
Parameters (under the Symbol menu).  

To create the example above.  
• Create a piece with four parts.  Enter the melody part in staff one and copy it to staff two (the same 

music, using Copy Measures under the Edit menu).  Enter the bass part in staves three and four. 
• Select the first note of staff two.  Use Parameters (under the Symbol menu) and find 

TABLATURE PITCHES AND SYMBOLS. 
• Change the “MIDI pitch for string…” values for each of the strings one through five, using This 

Voice Only, as follows; string 1 = MIDI pitch 62 (D4), 2 = 57 (A3), 3 = 52 (E3), 4 = 47 (B2), 5 = 
42 (G2). 

• Select the first note of staff three.  Repeat the step above using these values; string 1 = MIDI pitch 
24 (C1), 2 = 31 (G1), 3 = 38 (D2), 4 = 45 (A2), 5 = 52 (E3). 

• While still in parameters find STAFF LINES, MARGINS, AND NOTE SPACING.  Change the 
width of staff lines (This Voice Only) as follows; first staff line = 1, second = .8, third = .6, fourth 
= .4, fifth = .2 (no change). 

• Use Parts And Voices (under the Voice menu) to change staff two and staff three to tablature by 
checking Tab and enter 5 for the number of staff lines. 

To create a mandolin tablature:  

• Use Parts And Voices (under the Voice menu) to change a single staff into tablature with four 
staff lines. 

• Use Parameters (under the Symbol menu) to change “MIDI pitch for string…” values for strings 
one through four as follows; sting 1 = MIDI pitch 76 (E5), 2 = 69 (A4), 3 = 62 (D4), 4 = 55 (G3). 

• Check the box labeled Stem Tab. 
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Twentieth Century 

Schenker Analysis 
 

 
 

The success of a Schenker layout lies in good planning.  Before entering the music in Lime, create a 
sketch by hand to determine details such as how many notes you need in each measure.  In this 
example a measure of 15/8 was created to accommodate all the notes for the analysis.  There are 
many ways to modify the way Lime prints music to create non-standard scores.  For example, you 
can use Allow any Alt (Windows) or Option (Macintosh) Click under the edit menu to modify 
graphics generated by Lime.  (You will use it in the steps below.) But there are also creative ways of 
working with the standard Lime features for beaming, measure size, slurs, etc.  This is a more 
reliable method since Lime will make adjustments to the spacing automatically.  Here are the steps 
we took for this example.  
• After creating a measure large enough to accommodate all the notes you need, enter the notes 

without regard to cue size or stem.  For this example all music was entered as eighth notes or rests 
(for spacing). 

• Select all rests and choose Hide Rest from the Note menu. 
• Use chord drag as necessary to reposition any notes. 
• The beaming was achieved with a combination of stem direction changes and beaming commands.  

The rule for Continue Beaming is; the beam is extended to the next stem of similar direction.  The 
A, G, F, E-sharp, and E-natural in the upper staff are all stem up, so the beaming extends across 
those notes.  The same is true for the lower staff.  

• The slur lines can be done by selecting a group of notes and engaging the curved line symbol in the 
piano window, or by using the curved line tool to draw them by hand. 

• Alt (Windows) or Option (Macintosh) Click on the stems that need to be shortened and drag the 
mouse (while holding the Alt or Option key) to the correct length.  

• Select all notes that should not have a stem and choose No Stem from the Note menu.  
• Click on the line symbol in the piano window.  Select Line Width (under the Annotation, Line 

and Curve Style menu) and enter 2.5.  Then use Control (Windows) or Command (Macintosh) 
click-drag to draw the beam between the last C-sharp and A. 

• Enter the theory symbols as annotations.  (See a previous example for a detailed explanation of 
theory symbols.)  

 

  







   
 

      

      

    

       





D: I VI (IV VII) VII V I



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 169 of 206 

Clusters12

 

 

 

• Enter the pitches for the upper and lower limit of the cluster.  For this example the upper A-three-
quarter sharp was entered using Special Accidentals under the Note menu.  

• Click on the line symbol in the Piano Window.  Choose Line Width under the Annotation, Line 
and Curve Style menu and enter 15 for line thickness.  (Adjust this value depending on the size of 
the cluster.  It may be necessary to draw several lines if the cluster is thicker.) 

• Draw the cluster line by pressing Control (Windows) or Command (Macintosh) and dragging the 
mouse.  

Repeated Chords With Specific Rhythm13

 
: 

 
 

• Enter the first chord. 

• Click on the note head symbol in the Piano Window to select an invisible note head for the 
subsequent repeated chords.  

• In this example octave G's (G4 and G5) were entered in order to adjust the length of the stems and 
the position of the beams.  

 

 

                                                

12 Stone, page 59. 

13 Stone, page 33. 
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Proportional Notation14

 

 

Lime uses a spacing algorithm to position notes evenly in standard notation.  This spacing can be 
overridden using chord drag to achieve correct positions for proportional notation.  

• Drag each pitch or chord to the desired “proportional” position by pressing Control (Windows) or 
Command (Macintosh) while dragging the chord.  

Extended beams, first method: When Allow Any Alt/Option Click is selected you can select and 
modify any graphic symbol on the page by pressing Alt (Windows) Option (Macintosh) and clicking 
on the graphic.  
• With Allow Any Alt/Option Click on, click on any note with an existing beam.  

• Press Alt or Option and click on the beam for that note.  
• Select Horizontal and Vertical locks.  This will ensure consistency if you copy and paste the beam 

to other notes. 
• After modifying the length you can copy and paste the beam to other (quarter) notes.  The length of 

each of these copies can be modified using Alt or Option click. 

Extended beaming, second method: Hanging extended beams are used when a beam is extended over 
a rest.  This feature can be used in conjunction with Hide Rest under the note menu to automatically 
generate correct length of hanging beams for proportional notation.  Even though rests do not have 
stems they can be assigned a stem direction.  When Continue Beaming is chosen the beam is 
extended to the next note or rest with a similar stem direction to that of the original stem and beam.  
Below is an example of extended beams with rests.  This is an intermediate step to the example 
above.  Notice how rests are used to end beaming. 

 

 
• Enter pitches as eighth notes.  Enter eighth rests at each point where you want a beam to end.  

• Use Stem Up and Stem Down under the Stem menu to adjust the stem direction for notes and 
rests.  In this example the first three rests have a down stem command.  But the fourth rest has a 
stem up command to end the G-sharp beam.  The fifth rest is stem down, etc.  

• Use Continue Beaming to extend hanging beams. 

                                                

14 Stone, page 141.   
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• Adjust the proportional location of notes using Chord Drag.  Adjust the ending position of the 
beams using Rest Drag. 

Extended Stems Over Multiple Staves15

 
 

 
 
For the extended stem in the upper four parts: 

 
• Enter all the pitches in all the parts as eighth notes.  

• Select all pitches except the lowest part using Note Group Select and choose No Stem from the 
Stem menu. 

• Choose Allow Any Alt Click (Windows) or Allow Any Option Click (Macintosh) from the Edit 
menu.  

• Select the first B-flat in the lowest part.  
• Press Alt or Option and click near the first stem to select it.  (This may take some practice.)  

• Press Alt or Option and drag the top of the stem until it reaches the upper pitch.  The x, y, 
coordinates are visible in the Piano Window.  You should end your drag operation at a 0.0 Y 
location. 

 

                                                

15 Stone, page 163. 
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Indeterminate Repeated Material  
 

To create indeterminate repeats (shown in voice five above): 
 

• For this example the pitches were entered as sixteenth notes. 
• Insert repeat bar lines using Bar Line under the Edit menu.  

• Drag a box around all pitches in the repeats to select them and choose No Stem under the Stem 
menu. 

• To draw the extended beam use line draw mode (click the line symbol in the Piano Window).  
Press Control (Windows) or Command (Macintosh) and drag.  Adjust the thickness using Line 
Width… (under the Annotation, Style menu). 



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 173 of 206 

Boxed Elements16

 

 

To offset a section of the score with a large box: 
• Select the first note that will be contained in the box. 
• Click on the annotation symbol in the Piano Window.  Select Boxed (under the Annotation, Style 

menu).  
• Type a series of spaces.  The spaces will not print, but they will define the box.  Use the point size 

to increase the height of the box and additional spaces to increase the width of the box. 
• Change the thickness of the box using Parameters under the Symbol menu.  Locate “DEFAULTS 

FOR EDITING” in the upper window and “Boxed Text” in the lower window.  In this example the 
value is set to two. 

Mixed and Partial Tuplets17

 

 

Lime allows entry of both mixed tuplets and partial tuplets (e.g.  six parts of a septuplet18

• For the mixed tuplet: select the tuplet icon and enter a quarter then eighth note. 

).  The 
durations for playback are calculated by Lime (listed above for quarter = 60).  Each of these 
measures began as a normal 4/4 bar.  In most measures adding partial tuplets resulted in unwanted 
rests which were deleted using Kill with Allow Duration Edits selected from the Edit menu.  For 
this example the tuplet brackets were entered manually. 

• For the 6/7: double click on the tuplet icon, enter 7 in the space of 4, then enter a dotted quarter, 
quarter, then eighth.  Use Kill to remove unwanted rests. 

• For the 3/9: double click on the tuplet icon, enter 9 in the space of 8 and enter eighth notes. 

                                                

16 Stone, page 178 

17 The same effect could be notated as metric modulations using hidden tempo changes. 

18 Given a tempo of quarter = 60, each member of a septuplet (7 in the space of 8) would be 0.28". 
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• For the 1/3: double click on the tuplet icon, enter 3 in the space of 2 and enter one eighth. 
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Changing Time Signatures, Time Signatures Above the Staff19

 

, and Custom 
Time Signatures 

 
 

 

When you use Time Signature (under the Symbol menu) to add a time signature, this does nothing 
more than print a time signature and set a default beaming rule: it does not change the number of 
beats in a measure.  The time signature does not need to match the number of beats in a measure.  
While it is possible to create custom time signatures using annotation mode, it is more useful to 
modify Lime's own time signature feature.  This is faster, and the time signatures will be used to 
calculate note spacing and combined rests.  
 

To add the 7/8 measure as shown in the example above: 
• Select a note or rest in the measure that will follow the 7/8 measure. 

• Use Insert Measures (under the Page menu) to insert 1 measure of 7/8. 
• Select the first note in the 7/8 measure and use Time Signature (under the Symbol menu) to add a 

7/8 time signature.  Then play your notes. 
• Repeat these steps for the 6/8 measure. 

 

To create time signatures above the staff and centered over the bar line:  

• Click on the first note of the piece (or section where signatures above the staff begin). 
• Choose Parameters under the Stem menu and locate “TIME SIGNATURES” in the upper 

window.  Set “Y offset…” to 22.  Set “X offset” 11.  Set both "space for time signature width" and 
"space between signature and next object" to 0. 

• Insert the appropriate measures and time signatures. 
 

To make custom time signatures (ones which Time Signature cannot make for you):  
• Use text annotations to create the time signature.  In the above example the brackets and the “0” 

where created using the Symbol font at 32 points. 

                                                

19 Stone, p.178. 
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• Use Leave Space (under the Annotation, Style menu) so that Lime will automatically make room 
on the staff for your custom time signature. 

• Select Vertical Lock annotation control but do not select Horizontal Lock; then you can copy and 
paste the time signature to notes of different pitches without the time signature moving up and 
down.  See the section on Copy Annotations for more details. 
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Graphic Scores20

 

 

 

 

While Lime is a powerful music editor, it does not have all the features of a graphics or word 
processing application.  Depending on the amount of text or graphics required in your project, you 
may want to rely on a word processor or graphics program for the main document, and use Lime's 
copy and paste rectangle feature to generate and insert the musical sections. 
 

• Create each section of music in Lime.  
• Press Shift-Alt-Control (Windows) or Shift-Option-Command (Macintosh) and drag the mouse 

to define a rectangle. 
• Copy the example and paste it into a graphic editor.  Continue editing in the graphics program.  

(This example was created using the graphic features in MS Word.) 

                                                

20 Stone, p.  172.   
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Special Accidental Symbols, Customized Staff 

 

 

The number of staff lines in each staff can be set using Parts and Voices. 

This example uses some of the quarter tone accidentals suggested by Kurt Stone in Music Notation 
in the Twentieth Century.  These characters are available from the Tufa font.  The number of cents 
offset for each accidental can be set using Parameters.  

In this example,  would be set to -25 cents,  to +75 cents, etc. 

To make this example: 
• Select Special Accidentals (under the Note menu). 

• Enter all the notes.  For notes with special accidental symbols, select the appropriate special 
accidental symbol in the Piano Window, then play the white key on the music keyboard which 
corresponds to the pitch you want printed.  

Alternative method: 

• Enter the note values without special accidentals. 
• Select Special Accidentals (under the Note menu). 

• Select all the notes which need the same special accidental using Note Group Select, then select 
the special accidental in the Piano Window, and click APPLY. 

To set the number of cents pitch change caused by a special accidental: 
• Select the first note in the piece.  (This assumes you want to set the number of cents for the 

accidental symbol for the whole piece; alternatively you could have the accidental’s meaning 
change in the middle of the piece.) 

• Use the Parameter option (under the Symbol menu) to specify the number of cents sharp (a 
positive number) or the number of cents flat (a negative number).  Select All Staves and All 
Notation Contexts. 

• Any special accidentals you add will use the number of cents you specified in Parameters.  If you 
have old notes using the special accidental, you need to Note Group Select the notes and use 
Recompute Playback (under the Hear menu) to update their playback pitches. 

To hear the microtonal pitches in the Hear option: 
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• Use a microtonal synthesizer compatible with Lime.  (See the Voice on Channel description for 
more information.) 
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Special Accidentals, Continued 

To make new accidentals of your own: 
• Use a font editor (a program you purchase separately from Lime) to create the new symbols, or 

look for appropriate symbols in existing fonts. 
• Use the Parameters option (under the Symbol menu) to add your new symbols to Lime’s list of 

accidentals.  You will need to specify the font, font size, and character offsets so that Lime will use 
your symbol properly.  You will also need to specify the number of cents sharp or flat. 

• You can define up to 60 special accidentals in Parameters 
• Remember that you can Copy and Paste the Parameter definitions to new pieces (see Hidden 

Text under the Symbol menu). 

Modifying Graphics Generated by Lime  
 

 
 (a) (b) (c) 

When Allow Any Alt-Click or Allow Any Option-Click is active (under the Edit menu), Alt-click 
(Windows) or Option-click (Macintosh) can be used to modify graphics which were generated by 
Lime.  For details, see the section on Allow Any Alt/Option Click. 

In this example, (a) is the normal stem and beam appearance.  For all the examples below Allow Any 
Alt-Click or Allow Any Option-Click (under the Edit menu) must be checked. 

 
To make (b): 

• Press Alt (Windows) or Option (Macintosh) and click near the top of the stem connected to the f-
sharp and drag the top of the stem to the left.  Repeat for the a-flat. 

  
To make (c): 

• Press Alt or Option and click near the top of the a-flat's stem and use Clear Annotation (under the 
Edit menu) to delete it. 

• Use a curve annotation to create the new stem. 
• Press Alt or Option and click near the end of the lower beam and use Dashed… (under the 

Annotation, Line and Curve Style menu) to create a dashed beam.  In this example both the dash 
and gap are set to 4. 
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Be careful not to overuse Alt-click or Option-click.  It is better to let Lime generate as much of the 
music as possible.  The thickness of all beams could be changed by selecting each beam and 
selecting Line Width (under the Annotation, Line and Curve Style menu).  But using Parameters 
(under the Symbol menu) is faster and more efficient.  Before using this feature, look through the 
menu items to see if another feature will accomplish the same thing. 
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Quintuplets in 7/8 and Septuplets in 5/8 
 

 
 

The three examples above sound the same, but they are notated in different time signatures. 

To make the first example: 

• Double-click on the 3 box in the Piano Window, specify “7 in the time of 4”, and play notes in the 
first measure. 

• Double-click on the tuplet box in the Piano Window again, specify “5 in the time of 4”, and play 
the notes in the second measure. 

• To use quarter notes instead of eighths in the second measure, specify “5 in the time of 2” before 
you play the second measure. 

• Use Tuplet Brackets (under the Annotation, Line menu) in Line Annotation Mode to make the 
tuplet brackets.  For more information, see the description of Tuplet Brackets. 

To make the second example: 
• Play notes in the first measure normally, without selecting the tuplet box in the Piano Window. 

• Double-click on the tuplet box in the Piano Window again, specify “5 in the time of 7”, and play 
the notes in the second measure. 

• To use quarter notes instead of eighths in the second measure, specify “5 in the time of 3.5” before 
you play the second measure. 

To make the third example: 
• Double-click on the 3 box in the Piano Window, specify “7 in the time of 5”, and play notes in the 

first measure. 
• Play notes in the second measure normally, without selecting the tuplet box in the Piano Window. 
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Tuplets Within Tuplets 
 

 

This example has quintuplets within triplets.  To make this example: 

• Specify “15 in the time of 8” for the quarter notes, and “3 in the time of 2” for the whole notes.  To 
calculate the value of the nested tuplet one must ask what value would be entered if the entire 
measure were filled with that tuplet.  (Lime can do this calculation for you, if you use the Nested 
Tuplet feature in the tuplet dialog.) 

• Use Options (under the Edit menu) and deselect Print Tuplet Numbers. 
• Use Tuplet Brackets (under the Annotation, Line menu) in Line Annotation Mode to make the 

tuplet brackets.  You will need to change the tuplet number on the quarter note brackets from 15 to 
5.  For more information, see the description of Tuplet Brackets. 

3/4 Time Against 9/8 Time 

 

 
 
To print 3/4 time against 9/8 time with equal length measures: 

• Initially create your piece specifying 3 quarters per measure and 3/4 time. 
• Select the first note or rest in the 9/8 part, use Time Signature (under the Symbol menu) to print a 

9/8 time signature on This Staff Only.  This will not affect the number of beats in a measure: there 
are still 3 quarters per measure. 

• In Beaming Rule (under the Stem menu) specify a 2-eighth beam pattern. 
• Deselect Print Tuplet Numbers in Options (under the Edit menu). 

• You should play only triplets on the 9/8 part; since tuplet numbers are not being printed, they will 
look like normal eighths in 9/8 time. 
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4/4 Time Against 3/4 Time 
 

 
To print 4/4 time against 3/4 time with unequal length measures, first method: 
• Create your piece with 4/4 measures, 3 measures per system. 

• Select the first note or rest in the 3/4 part, use Time Signature (under the Symbol menu) to print a 
3/4 time signature on This Staff Only.  This will not affect the number of beats in a measure: so 
far there are still 4 quarters per measure. 

• Play the notes on the 3/4 part normally, ignoring the incorrect locations of the bar lines. 

• Use Bar Line (under the Symbol menu) with This Staff Only to delete the bar lines from the 
incorrect locations, and add bar lines in the correct locations. 

 
Second method: 

• Create your piece with a single 4/4 measure; this measure is temporary and can be deleted after you 
do the following steps. 

• Select the first note or rest on the 4/4 staff and use Insert Measures (under the Page menu).  
Select This Voice Only and At Current Note, and insert a multiple of 3 measures with 3 measures 
per system. 

• Select the first note or rest on the 3/4 staff and use Insert Measures.  Select This Voice Only and 
At Current Note, and insert a multiple of 4 measures with 4 measures per system. 

• When you insert measures using This Voice Only, Lime will not add page breaks automatically.  
If your page is too crowded, use Split Page or Add To Next Page (under the Page menu). 
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Aleatory Brackets 
 

  
 
 

To create this example (aleatory brackets): 
• Enter the notes in the score.  Group Select all the notes and use No Stem (under the Stem menu). 

• Enter Text Annotation Mode and select the Symbol font, 56 point size, Horizontal Lock off, and 
select Leave Space. 

• Type a left and right bracket ( [ ] ) where appropriate. 
• If you have additional aleatory brackets elsewhere in your piece, you can copy and paste these 

brackets. 
 

Hash Marks, Numbered Note Heads 
 

 
 

To create examples using unusual note heads.  
 

Annotation method: 
• Select all notes that are targeted for an unusual note head. 
• Continue clicking on the note symbol in the Piano Window (each click rotates through a selection 

of note heads) until the grayed note head (which indicates no note head) appears. 
• Use Text Annotation Mode to type a text symbol (such as a hash mark or a number) in place of a 

note head.  Be sure that the horizontal and vertical locks are off.  You may also want to use the 
“center” annotation control. 

• Copy the annotation, Group Select the other notes, and paste. 
 

Parameters method: 
• Each note head character may be changed using Parameters. 

• Choose a note head that you don't plan to use (such as a diamond note head) under Parameters. 

 


 


       0[ ]

 

⊕ ⊕ ⊕
⊕ / /


/ //     

2 5

7
9
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• Select the font and character for the special note head.  For the hash mark in the example above: 
use a slash character from the Courier font, font size 18, x = -1.5, y = -1.5 (Windows) or x = -2, y 
= 3 (Macintosh). 

• When notes are entered with the diamond head selected in the Piano Window, they will appear as 
slashes. 
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Cut and Paste Systems 
 

 
   

This effect requires that you first get the music to look right without the cut out sections.  Some of 
the options you may want to use include Hide Rest and non-standard bar lines.  To cut out sections: 

• Enter the Line Draw mode. 
• Select Line Width under the Annotation, Line and Curve Style menu and enter 25. 

• Select Draw In White (under the Annotation, Style menu). 
• Draw lines as you normally would over the sections of the score that are to be blocked out.  In this 

way the line draw becomes white tape and can be used to cover any item on the score. 

Accelerando Beam 
 
To make the example shown in the first measure of the first part above: 

• Enter the passage with the correct number of beams.  You may need to use the tuplet function to 
enter the correct number of notes.  For this example the first measure is a 3/4 bar; the first beat is a 
dotted eighth followed by a sixteenth; the accelerando beam takes up the last two beats.  Thirty-
second notes were played with tuplet value “8 in the time of 16” (so that the program generated 
three beams on eight notes placed in the space of sixteen).  

• If your Beaming Rule breaks the beam, you need to Group Select your notes and apply Continue 
Beam and Continue Subbeam. 

• Select the first note in the beamed passage, and use Parameters (under the Symbol menu) to 
change “offset between successive beams” (BEAMING heading) to 0. 

• Position the cursor on the last note in the accelerando passage, and change “offset between 
successive beams” to 4.  (Use 6 to exaggerate the effect.  If you do this you will have to move to 
the next note after the last note in the accelerando and change the parameter back to 4). 

• These parameter changes can then be copied and pasted to all appropriate passages. 
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Multiple Tempos and Time Signatures  (Mensuration) 
 

  
 

 
 

This example has different time signatures and tempos on simultaneous staves such that some bar 
lines coincide.  Before you create this kind of score, first work out and know ahead of time where 
you want system and page breaks and what multipliers are necessary for each tempo so that the 
durations in each part match.  If, for example, you want to use 2/4 for one part and 4/4 for the 
second, then the duration multiplier for 2/4 would be 1.0, and 2.0 for 4/4.  (A tempo of quarter = 100 
at 2/4 would result in a 4/4 tempo of quarter = 200.)   If you want to use 3/4 and 2/4, then the 
duration multiplier for 2/4 would be 1.0 and 1.5 for 3/4.  (A tempo of quarter = 100 in 2/4 would 
result in a 3/4 tempo of 150.)   

• Create an empty piece with the correct number of pages and parts, one measure per system, one 
system per page.  Use any number of beats per measure; right now you are just creating dummy 
measures to work from, and these dummy measures will be deleted later. 

• On the first page set the duration multiplier for each part.  Under the Parameter heading STAFF 
LINES, MARGINS, AND NOTE SPACING set the parameter “note duration multiplier” on the 
first rest in each part.  Be sure to choose Current Voice Only when you modify the “note duration 
multiplier” for each part.  

• Insert the number of measures for one page

• If the measures don't work out correctly for that page, recheck your multipliers.  Try also 
Recompute Playback under the Hear menu. 

 in each part (using Current Voice Only in Insert 
Measures) in the desired meter for each part.  After inserting measures on all parts for an entire 
page, delete the dummy measures. 

• Once the first page is correct, repeat for subsequent pages. 

 



















 





 







 

 

 



 







 























 ~ 150




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Polytempo Music 

 

 

In this example the top and bottom staves in the system are played at different tempos.  The top staff 
has 11 beats on the staff, and the bottom has 9 beats.  To create this example: 
• Create a “regular” system with three 4/4 measures. 

• Enter all the notes on the top and bottom staff.  The top staff will have an extra quarter rest at the 
end; the bottom will have 3 extra quarter rests. 

• Select Allow Duration Edits under the Edit menu. 
• Shift-click on the extra quarter rests and click Kill in the Piano Window.  Use Bar Line (under 

the Symbol menu) to delete the bar line at the end of the system. 
• Click on the first note of the bottom staff.  Use Time Signature (under the Symbol menu); specify 

Current Staff Only and Before Current Chord; click PolyTemporal21

• Click on the first note of the 

 then the Duration 
Multiplier button to bring up a sub-dialog; specify Decimal 1.1, or Fractional 11 over 10 (the 
number of beats on the top staff divided by 10).  Click OK then OK. 

top

• Shift-drag a rectangle around all the notes, and choose Recompute Playback (under the Hear 
menu) to update the playback durations. 

 staff.  Use Time Signature again, specifying Current Staff only 
and Before Current Chord; click PolyTemporal and specify Decimal 0.9, or Fractional 9 over 
1.  Click OK then OK. 

• One or other or both of the tempo annotations should have their style set to Do Not Interpret, as 
they are only indicative of the relative speeds.  Normally there will be at least one part that is not 
polytemporal and that should be used as the master and specify the tempo. 

More information on Polytemporal and Polymetric music can be found in the manual addendum. 

                                                

21 Note that before 9.15.9, the Polytempo Duration Multiplier was an obscure parameter in the staff section; after 9.15.9, 
it is an attribute of a time signature and properly integrated. 
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Occasional Un-pitched Notes22

 

 

 

• In Parts and Voices create one voice for the pitched material, one for spoken material, each voice 
must be on a separate staff.  

• Use Parts and Voices under the Voice menu and enter 1 for the number of lines staff two.  
• Click on the note head symbol in the Piano Window to select an “x” note head. 

• Use staff drag to Parameters (under the Symbol menu) to move the spoken staff close to the 
pitched staff. 

                                                

22 Stone, page 79. 
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Appendix A: Summary of Mouse Clicks, Keyboard Equivalents, 
Backslash Characters, Shortcuts, and Font Charts 

Summary of Mouse Clicks for Windows 
 
Selecting and Dragging Notes: 
 Position edit cursor Click on note 
 Position note entry cursor Double-click on note 
 Chord Drag Control-drag on a note in the chord 
 Accidental Drag Control-drag on a note's accidental 
 Rest Drag Control-drag a rest vertically 
 Note Group Select Drag a rectangle around several notes  

Add notes to Note Group Select Shift-click on notes 
 
Selecting and Dragging Annotations: 
 Select Annotation Alt-click annotation end point 
 Drag Annotation Alt-drag annotation end point 
 Annotation Group Select Alt-drag around several annotations or 
  Alt-Shift-click annotation end points  
 
Creating Annotations: 
 Select next or previous annotation Alt-left or right arrow 
 Begin editing a selected text annotation Return or Enter 
 Set Text Start Point Control-click (in text mode) 
 Draw a Line or Curve Control-drag (in line or curve mode) 
 Exit Annotation Mode Esc 
 
Modify an Annotation, after it has been selected with Alt-click: 
 Move Line or Curve End Point or Control Point  
  Drag end point or control point marker 
 Set Text Insertion Point Click in text 
 Select Range in Text Drag in text 
 
Staff Drag: 
 Drag Staff Control-drag on staff (not on a note) 
 
Magic Scroll: 
 Scroll Press Control-Alt and move the mouse 
 
Select a Rectangle for Copy Selection: 
 Select Control-Alt-Shift-drag a rectangle 
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Summary of Mouse Clicks for Macintosh 
 
Selecting and Dragging Notes: 
 Position edit cursor Click on note 
 Position note entry cursor Double-click on note 
 Chord Drag Command-drag on a note in the chord 
 Accidental Drag Command-drag on a note's accidental 
 Rest Drag Command-drag a rest vertically 
 Note Group Select Drag a rectangle around several notes 
 Add a note to Note Group Select Shift-click on notes 
 
Selecting and Dragging Annotations: 
 Select Annotation Option-click annotation end point 
 Drag Annotation Option-drag annotation end point 
 Annotation Group Select Option-drag around several annotations or 
 Add an annotation to Group Select Option-Shift-click annotation end points 
 
Creating Annotations: 
 Select next or previous annotation Option-left or right arrow 
 Begin editing a selected text annotation Return or Enter 
 Set Text Start Point Command-click (in text mode) 
 Draw a Line or Curve Command-drag (in line or curve mode) 
 Exit Annotation Mode Esc 
 
 
Modify an Annotation, after it has been selected with Option-click: 
 Move Line or Curve End Point or Control Point  
  Drag end point or control point marker 
 Set Text Insertion Point Click in text 
 Select Range in Text Drag in text 
 
Staff Drag: 
 Drag Staff Command-drag on staff (not on a note) 
 
Magic Scroll: 
 Scroll Press Command-Option and move the mouse 
 
Select a Rectangle for Copy Selection: 
 Select Command-Option-Shift-drag a rectangle 
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Default Control (Windows) or Command (Macintosh) keys:  
 
O Open [ Previous Page R Record 
W Close ] Next Page N Note Entry 
S Save G Go to Bar (or page) H Hear (obsolete, Windows only) 
P Print L Split Page F Clef 
Q Quit M Add to Next Page K Key Signature 
Z Undo  (shift Z  Redo) E Split System T Time Signature 
X Cut A Add to Next System B Bar Line 
C Copy U Systems Y Parameters 
V Paste I Insert Measures ; Switch Contexts (semi-colon)  
J Note internal fields D Delete Measures ' Special Accidentals (quote) 
. Hear (period)   , Anno Placement (comma) 

There are no (and never will be) predefined shortcuts using Control/Command-Alt. 

Backslash Equivalents 

Typing the following backslash combinations in any font will result in a substitution with the 
corresponding Marl character or format change.  More backslash characters may be found in the 
Annotation menu’s Text Assistant, or in the Appendix B below. 

\b = bold,    \i = italic,    \l = underline    \u = superscript,    \v = subscript 
\> = 1pt smaller,    \>> = 4pts smaller,    \< = 1pt larger,      \<< = 4pts larger 

\pppp \ppp \pp \p \mp \mf \f \ff \fff \ffff 
          
\w \h \q \e \s \t \n \+ \- \-- \++ \d \dd 
             

Piano Window Shortcuts 

Lime has the computer keyboard equivalents set to a visual representation of the piano keyboard.  
These are set up for a US Keyboard Layout.  They can be customized for other keyboard layouts or 
other functionality using Shortcut Keys under the Edit menu.  
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Font Charts 

Lime uses the Marl (12 Point) and Tufa (24 Point) fonts for printing music, and Times and Symbol 
for printing text and generating music symbols.  The Marl font contains the most common characters 
and is illustrated on the keyboard images below.  The extra key combinations (such as Shift, Alt, 
Alt-Shift, or none) required for each set are shaded. 
 

   
 

   

Useful characters available in the Tufa font are treated in the Hints and Examples section above.  
But the most common are q through i for clefs and s for an arpeggio symbol. 

Lime’s Parameters option (under the Symbol menu) allows you to change the font and point size 
for any symbol Lime uses.  This allows you to incorporate music symbols from other fonts into your 
Lime pieces; the charts on the following can help you in selecting symbols.  If you have a font editor 
(a program you purchase separately from Lime) you can create a new font, and then use Parameters 
to make Lime use your new symbols.  Lime’s Parameters option (under the Symbol menu) allows 
you to change the font and point size for any symbol Lime uses. 

Lime has special support for the Sonata music font.  The Sonata font is not distributed with Lime; if 
you want to use it, you must purchase it separately.  Sonata is completely optional; Sonata is not 
required to run Lime.  If you have installed the Sonata font on your computer, Lime will let you set 
your preference for those fonts in Options (under the Edit menu).  Lime will use the 20 Point and 
12 Point sizes of Sonata.  You can switch between Sonata and the Marl and Tufa fonts at any time 
without affecting your piece.  Some Lime users edit with the Marl and Tufa fonts, and switch to 
Sonata only when they are ready to print. 
Note that text annotations are not generated automatically by the program and switching to Sonata 
as the default font will not affect text annotations done in Marl or Tufa.  If you want to do text 
annotations in Sonata, choose these fonts when you enter the Text Annotation Mode. 
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Appendix B: List of Parameters 
Lime allows you to change which symbols are used when music is printed, the exact positioning and 
spacing between symbols, the length and thickness of lines used in printing, and many other details 
of printing music.  You can make these changes at any point in the music, and the changes can be for 
one voice or for all parts and voices, for one notation context or all notation contexts.  For more 
information, see the description of Parameters (under the Symbol menu). 

 
Parameters: 
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Accidentals, Key Signature 
(accidental characters and widths) 
double flat for chord symbols (\--) 
flat for chord symbols (\-) 
natural for chord symbols (\n) 
sharp for chord symbols (\+) 
double sharp for chord symbols (\++) 
flat for chord symbol alterations (\alt-) 
natural for chord symbol alterations (\alt+n) 
sharp for chord symbol alterations (\alt+) 
font information for numbers in extensions (\0-\9) 
space left between accidental and note  
space for second acc in chord at same notename 
sharps this many vert staff spaces apart don’t overlap 
flats this many vert staff spaces apart don’t overlap 
flats/naturals this many staff spaces apart partially overlap 
multiplier for extra space between notes for accidentals 
x space left between accidentals in keys and chords 
space left between key signature and next object 
additional space left before key signature 

Bar Lines,  Repeats  
space left between bar line and next object 
additional space left before bar line 
line width for bar lines 
line width for thicker line in double bar 
separation between lines in double bars 
repeat dots character 
distance between bar line and repeat dots 
space given for width of repeat dots character 
length of wing lines on repeats 
line width of wing lines on repeats 
dash length for dashed bar lines 
gap length for dashed bar lines 
length of rule (chant bar line) 
y offset for rule (chant bar line) 
minimum width of a bar containing only rests 
segno (\segno) 
coda symbol (\coda) 
repeat beat (\//) 
repeat bar (\/) 

Beaming  
stem connection beam line width 
offset between successive beams 
min.  distance from note heads under beams to beams 
min.  distance from rests under beams to beams 
multiplier to compute beam slope from note locations 
maximum slope for beam 
min.  slope for beam: use flat beam for lesser slope 
min.  change in y bet.  beam ends: flat beam for lesser 
y offset to add to final beam location 
offset to add to final beam slope 
length of partial beams between note stems 
extend beam lines this far past the note stem  
clip the main beam line this far from stem 

clip the sub beam lines this far from stem 
clip tremolo-between-pitches beams this far from 

quarter stem 
clip…  from half stem 
clip… from whole note 
beams off end of sys.  extend this far right of final 

stem 
beams onto start of sys.  extend this far left of first 

stem 
change in y bet.  ends of beams over switch to rh/lh 
minimum number of notes in a subbeam 

Brackets and Braces  
draw barline at left of single-staff system (1=yes) 
draw line between staves at left of system (1=yes) 
width of vertical bracket line at start of system 
x offset from start of staff to vertical bracket line 
width of diagonal bracket lines at start of system 
length of diagonal bracket lines 
top character making up a system brace 
middle character making up a system brace 
bottom character making up a system brace 
extension character making up a system brace 
height of one character making up a system brace 
x offset for system braces from left end of staff 
Sonata system brace: top part 
Sonata system brace: bottom part 
Sonata system brace: placement from staff spacing 
Sonata system brace: font size from staff spacing 
Sonata system brace: width from font size 
Sonata system brace: height from font size 

Clefs  
(clef characters at start of staff and middle of staff.  .  

) 
whole-step offset for (clefs…)  
space given for clef width 
width of clef change symbol 
additional space left before clef 
space left between clef and next object 
8va (\8va) 
8vb (\8vb) 

Defaults For Editing  
x offset for typing text if Horizontal Lock unchecked 
x offset from left margin if Horizontal Lock checked 
centering x offset if Centered checked 
y offset from note if Hor.  and Vert.  Lock unchecked 
y offset from staff if Vert.  Lock checked but not 

Hor. 
y offset from staff if Horizontal Lock checked 
font info for hidden text made by Parameters dialog 
x offset for hidden text made by Parameters dialog 
y offset for hidden text made by Parameters dialog 
boxed text: x distance from text to vertical box lines 
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boxed text: y distance from text to horizontal box lines 
boxed text: line width for box lines 
Record/Import MIDI: max arpeggiation (% shortest 

duration) 

Dots For Note Values  
dot character for dotted notes  
double dot character  
third dot for triple dotted notes 
dot for tempo markings (\qd)  
double dot for tempo markings (\qdd)  
dot kerned left for tempo markings (\ed) 
double dot kerned left for tempos (\edd) 
space given for width of dot  
space given for width of double dot  
space given for width of triple dot  
space left between note and its dot  
dots ok below line for notes on a line (1=yes) 
dot discrepancy ok for shared note heads (1=yes)  

Dynamic Markings  
pppp dynamic (\pppp) 
ppp dynamic (\ppp) 
pp dynamic (\pp) 
p dynamic (\p) 
mp dynamic (\mp) 
mf dynamic (\mf) 
f dynamic (\f) 
ff dynamic (\ff) 
fff dynamic (\fff) 
ffff dynamic (\ffff) 
x offset for clip hairpins/lines at right end of staff 
x offset for clip hairpins/lines at left end of staff 
amount to extend clipped hairpins/lines beyond staff 

Fingerings  
default font info for fingerings 
default x offset from note for fingering numbers 
default y offset from staff for closest fing.  number 
adjustment to vert spacing between fing.  numbers 

Ledger Lines  
ledger line length to left of note  
ledger line length to right of note head  
ledger line width  

Lyrics and Text Annotations  
centered hyphens: max distance for each hyphen 
line width of extended underline 
x offset from end of text to start of underline 
right end of underline extends this far under end note 
x offset from end of underline to punctuation  
length of underline onto system 
y offset from text to underline 

Note Heads  
(note head characters…)  
parenthesis to left of standard notation note head 
parenthesis to right of standard notation note head 
width of note head parentheses characters 
suppress double note heads from one voice (1=yes) 
suppress … from multiple voices (1=yes) 
piano roll indicator 
(note head character widths…) 

Note Flags 
(flag characters…) 
space given for width of flag character 
y offset from end of stem for stem-up flags 
grace note slash line width 
(grace note slash x,y offsets) 

Note Stems 
normal length of note-stems 
normal length of note-stems in beams 
min.  length of note-stems in beams 
stem line width 
x offset added to normal up-stem position 
x offset added to normal down-stem position 
(y offsets for up/down stems on various heads…) 

Notes With Stems For Tempo 
Markings 

whole note for tempo markings (\w) 
half note for tempo markings (\h) 
quarter note for tempo markings (\q) 
eighth note for tempo markings (\e) 
16th note for tempo markings (\s) 
32nd note for tempo markings (\t) 

Page Numbers, Bar Numbers, 
Tuplets 

font information for page numbers 
page number y offset from bottom of page 
font information for bar numbers 
bar.  number x offset from start of 1st staff in system 
bar number y offset from 1st staff in system 
font information for tuplet (triplets, etc.) numbers 
space given for height of tuplet number 
space given for width of tuplet number 
space left between the note and the tuplet number 
x offset for tuplet number at end of up-stem 
x offset for tuplet number at end of down-stem 
x offset for tuplet by note head 
line width for lines in tuplet brackets 
length of small vertical lines at ends of tuplet 

brackets 
distance between either side of tuplet number and 

tuplet bracket 
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Pedal Markings, Breath Marks, and 
Bowing 

pedal marking (\ped)  
pedal up marking (\*) 
breath mark (single) (\') 
breath mark (double) (\″) 
up bow (\upbow) 
down bow (\downbow) 

Rests 
(rest characters and widths…) 
space given for width of multi-rest symbol 
space given for width of multi-rest number  
x offset: multi-rest origin to number of bars 
y offset: top staff line to number of rest bars 
staff spaces to offset rests for multiple voices 
min.  space left between chord rests and notes 
(rests asc../desc.  above/below its y location…) 

Single Pitch Tremolo Marks 
single-slash tremolo mark 
double-slash tremolo mark 
triple-slash tremolo mark 
extend stem length for tremolo on flagged notes 
extend stem length for tremolo on un-flagged notes 
extend stem length for tremolo on beamed notes 
x offset for centering tremolo mark around stem 
y offset from stem end for tremolo on flagged notes 
y offset from stem end for tremolo on un-flagged notes 
y offset from beam for tremolo on beamed notes 
y offset from note for tremolo on notes without stems 
height given for tremolo characters 

Special Accidentals (1-60) 
(special accidental 1-60) 
(cents offset for special accidental 1-60) 

Staccato, Tenuto, Accents 
staccato mark 
staccatissimo mark below note 
staccatissimo mark above note 
tenuto mark 
space given for height of staccato/tenuto 
space left between staccato/tenuto and note/staff line 
fermata above note 
fermata below note 
space given for height of fermata character 
space left between fermata and note 
accent horizontal 
accent above 
accent below 
space given for height of accent character 
space left between accent and note 
+ (\+) 

turn (\turn) 
tr (\tr) 
trill extension segment (\~) 
upward mordent (\mordent) 
downward mordent (\mordent2) 
swing eighth duration proportion for first eighth in 

pair 

Staff Lines, Margins, Note 
Spacing 

(width of each staff line, specified separately) 
margin width on left of page (add value in Layout) 
margin width on right of page (add Layout value) 
margin width at top of page (add Layout value) 
margin width at bottom of page (add Layout value) 
system separator symbol (left side of page) 
system separator symbol (right side of page) 
default vertical separation between systems 
distance between systems with separator symbols 
default vert.  separation bet.  this voice's staff and 

next 
additional space bet.  key/time and first note on staff 
min.  space between grace note and next chord 
min.  space between normal note and next chord 
min.  space bet.  grace note and next note's accidental 
min.  space between normal note and note's 

accidental 
min.  space between chords in staff switch to right-

hand 
min.  space between chords in staff switch to left-

hand 
x offset for half step overlap in stem-up & stem-

down 
x offset for complete overlap in stem-up & -down 
x offset for chords with multiple stems up/down 
effect of note spacing (overrides value in layout) 
space given to an eighth note before justification 
polytempo note duration multiplier (obsolete normally 

1.0) 

Tablature Pitches and Symbols 
(midi pitches for strings in tablature…) 
font information for tablature numbers 
font for thumb's guitar tablature number 
x adjust for single digit stem-up guitar tab # 
x adjust for two digit stem-up guitar tab # 
x adjust for single digit stemless guitar tab # 
x adjust for two digit stemless guitar tab # 
parenthesis to left of guitar tablature note 
parenthesis to right of guitar tablature note 
length of white keys at start of piano tab (0 for none) 
length of black keys at start of piano tab 
line width of black keys at start of piano tab 
line width outlining white keys at start of piano tab 
MIDI pitch shift for piano tablature (+12=octave up) 
font/size/offset for superscript for fret number on fret 

grid (\g) 
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Ties And Slurs 
shortest tie or slur symbol 
ties and slurs off the system extend this far past staff 
ties and slurs onto the system extend this far to left 
maximum slope for slurs 
space left betw.  tie end and staff line (y direction) 
space left betw.  tie end and note head (x direction) 
space left betw.  slur end and note head (y direction) 
x offset (from note) to slur end above end of up-stem 
x offset (from note) to slur end above note head 
x offset to slur end below end of down-stem 
x offset to slur end below note head 
amount to shorten slur when it ends beside a stem 
amount to shorten each end of a raised slur 
extra space bet.  slur end and accent/fermata symbols 
min.  slur length for applying the next parameter below 
start long, raised slurs closer to first note (0=no, 1=yes) 
first slur length (for next two parameters below) 
slur control point x offset at first slur length 
slur control point y offset at first slur length 
second slur length (for next two parameters below) 
slur control point x offset at second slur length 
slur control point y offset at second slur length 
length of slur with 'hang right' selected 
length of slur with 'hang left' selected 
length of tie with 'hang right' selected 
length of tie with 'hang left' selected 
dash length in dashed ties and slurs 
length of gap between dashes in dashed slurs 
1 if dashed ties/slurs have Thicker Center, else 0 
tie/slur thickness control (value for whole page) 
width for curves without Thicker Center (for page) 
width for lines in tie-with-pitch-bend marks 
height of tie-with-pitch-bend marks 
symbol for bend to higher pitch on tablature staff 
symbol for bend to lower pitch on tablature staff 
font and x y offset for bend range on tablature staff 
width of glissando line 
distance from note to clip glissando line 
distance from accidental or dot to clip gliss line 
minimum horizontal length of a glissando line 
vertical offset for gliss line ends in tablature 

Time Signature, Rest Number 
cut time character 
common time character 
(time signature/rest number characters…) 
space left between time signature and next object 
space given for time signature width 
additional space left before time signature 
x offset for time signature 
y offset from staff line to time signature 
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Index 
8va, 95 
Accelerando Beam, 187 
accent, 31 
Accessible Lime, 54 
acciaccatura, 86, 122 
Accidental Drag, 45 
accidentals, 30, 32, 80, 81, 198 

microtonal symbols, 81 
new symbols, 178 
reminder, 31, 56 
special symbols, 81, 178 

add, 32 
Add to Next Page, 69 
Aleatory Brackets, 185 
Align 

annotations, 58 
Bars, 101 

All Notation Contexts, 34, 113 
Allow Any Alt-click, 62, 180 
Allow Any Option-click, 62, 180 
Alt-click, 36, 37, 62 
Annotation Menu, 105 
Annotation Mode, 34 
annotations 

align, 58 
Alt-click, 36, 37 
change font and style, 37, 105 
control annotations, 38 
controls, 112 
coordinates, 115 
Copy and Paste, 41 
curves, 34, 35, 111 
delete, 36 
dynamic markings, 38 
general hints, 114 
Group Select, 42 
line, 34, 35, 109 
modifying lines and curves, 37 
notation contexts, 34, 41, 113 
Option-click, 36, 37 
pallet files, 131 
tempo markings, 39 
text, 34 

Annotations, 199 
arpeggiation, 122 
arrow keys, 73, 80 
automatic transcription, 73 
backslash 

accidentals, 109 
chord symbol, 109 
dynamic markings, 38 
tempo markings, 39 

backslash characters, 38, 118, 195 
Bar Line, 100, 198 
bar line aligning, 101 

bar numbering, 65 
bar numbers, 100 
beaming, 87, 120, 153 

between staves, 155, 157 
over bar lines, 120 

Beaming, 198 
Beaming Rule, 87, 99, 120 
binary format, 85 
Blind Lime users, 54 
Bold, 106 
Boxed, 107 
boxed music, 173 
braces, 102, 133 
brackets, 102, 110, 133, 198 
Braille, 54, 106 
Center Hyphen, 107, 161 
Centered, 106 
channel, 78 
chant, 162 
Chord Drag, 44, 132, 164 
chord symbol, 109 
chords, 19, 32, 109 
Clear 

At Each System, 59 
Chord Drag, 84 
Graphical Alignment, 57 
On Each Page, 60 
Part Labels, 61 
Staff Drag, 78 

Clear…, 57 
Clef, 96, 122, 198 
Clef Menu, 96 
Close, 49 
clusters, 169 
Color, 82, 108 
combined rests, 83 
Command Keys, 63 
Command-click, 62 
concert pitch, 98 
Context Menu, 67 
Continue Beam, 87 
Continue Subbeam, 87 
control annotations, 38 

Do Not Interpret, 108 
Control Key, 63 
Control Keys, 63 
coordinates, 115 
copy, 23 
Copy 

Annotation, 41 
Measures, 58 
MIDI, 56 
Music, 55 
Parameter, 56 
rectangle, 116 
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Rectangle, 56 
to other applications, 56, 116 

crescendos, 118 
cue notes, 31 
cue staff, 75, 129, 161 
Curve Down, 35, 111 
Curve Up, 35, 111 
curves, 34 
Cut and Paste Systems, 187 
Dancing Dots LLC, 54 
dashed curves, 36, 111 
dashed line, 155, 157 
Dashed Line, 35, 36, 111 
Dashed Slur, 89 
Dashed Tie, 89 
Default Accidentals, 81 
Default Beaming, 87 
Default Playback, 93 
Delete 

Measures, 72 
Voice, 75 

deleting notes, 19 
Do Not Interpret, 108 
Dolet® Plugin, 47 
Don't Combine Rest, 83 
Don't Combine Rest;, 99 
Don't Print Voice;, 75 
dots, 51 
dotted line, 155, 157 
dotted notes, 30, 124 
double bar, 100 
Draw in White, 108 
drawing lines, 35, 109 
duples, 124 
Duplicate Annotation At Each System, 59 
Duplicate Annotation In Every Part, 61 
Duplicate Annotation On Each Page, 60 
Duplicate At Each System, 70, 139 
Duplicate In Every Part, 141, 143 
Dynamic Levels, 92 
dynamic markings, 38, 110, 118 
Dynamic Markings, 199 
edit cursor, 29 
Edit Menu, 55 
Editing notes, 20 
Editing Zoom, 51 
empty staff, 77 
Enable Duration Edits, 147 
End Beam, 87 
End Subbeam, 87 
examples, 114 
Exit, 54 
expanded Shift-click, 62 
Export 

MIDI, 51 
MusicXML, 50 

Export MusicXML, 106 
Export NIFF, 106 
Extend lines, 61 

Extend Underline, 107, 161 
fermata, 31 
file format, 85 
File Menu, 46 
File Name on Each Page, 65 
Finale®, 47 
Fingerings, 199 
First and Second Endings, 130 
first line indent, 127 
Flags, 199 
Flat Underlines, 108 
font, 37 

changes in text, 106 
layouts, 196 

Font Menu, 105 
footers, 60 
fret grids, 165 
Go To Bar, 69 
Go To Page, 69 
Goodfeel®, 54 
grace notes, 31, 93, 122 
grand staff, 83, 86, 155, 156, 157 
Graphic Save, 50 
Group Select 

annotations, 42 
notes, 20 

Guides, 37 
guitar, 76, 82, 165 
Guitar 

notation, 164, 165, 167 
guitar tablature, 76 
hairpin, 118 
Hairpin, 110 
hairpins 

resize, 61 
Hanging Slur, 89 
Hanging Tie, 89 
hardcopy, 53 
hash marks, 185 
headers, 60 
Hear, 90 

Switching Pages, 69 
help, 114 
Hide 

Clef, 96 
Rest, 77, 83, 87 
text, 39, 104, 108 
Tuplet, 65, 82 

Highlight Voice, 78 
hints, 114 
Horizontal Lock, 112, 115 
Import 

MIDI, 48 
MusicXML, 47 
NIFF, 47, 146 
NIFF, 148 

inches, 51 
Insert Measures, 71, 184 
instrument names, 59 



Lime™ User’s Manual (9.05) 
 

© 2012 Lippold Haken L915-7 Page 204 of 206 

Internal Fields, 85 
Italic, 106 
Key Signature, 27, 97, 198 
keyboard 

equivalents, 63, 195 
MIDI, 18 

Keyboard shift, 32 
Keyboard Shift, 95 
labeling pages, 60 
labeling staves, 59, 139 
Launch Goodfeel, 54 
Launchg in Manual Mode, 54 
Layout, 51 
Leave Space, 107 
Ledger Lines, 199 
Lime Aloud®, 49, 54, 145 
line, 34, 35, 109, 155, 157 
Line Width, 35, 111 
lines 

resize, 61 
local control off, 65 
Louder, 92 
lyrics, 36 
Lyrics, 159, 199 
magic scrolling, 23, 28 
margins, 51, 66, 135 
Marl, 15, 106, 196 
measure numbering, 65 
measure numbers, 100 
memory usage, 52 
mensuration, 188 
MIDI, 19, 40, 65, 73, 78 

channel, 78 
Channel, 40 
connections, 16 
Control, 40 
files, 48 
Input, 95 
Messages, 40 
Note mapping, 40 
Program, 40 

MIDI Input, 95 
MIDI Manager™, 15 
Model for Text Category, 105 
Modify Playback, 93 
Modify Slur, 89 
Modify Tie, 89 
mouse click summary, 193 
multiple paste, 23 
Multiple Paste, 41 
MusicXML, 47 
New, 46 
New Voice, 75 
Next Annotation, 105 
Next Note, 80 
Next Page…, 69 
Next Part Or Voice, 73 
NIFF, 47, 146, 148 
No Stem, 86 

Not in Score, 34, 113 
Note Entry, 74 
note entry cursor, 29 
Note Entry Cursor, 74 
Note Menu, 80 
Noteheads, 199 
notes 

accidental stacking, 45 
accidentals, 30 
add notes to a chord, 32 
beaming, 87, 120, 153 
beaming between staves, 155, 157 
changing lengths, 21 
changing note lengths, 146 
correcting note lengths, 146 
cues, 31 
deleting, 19 
dotted, 30 
duples, 124 
grace notes, 31, 122 
grace notes, 93 
Group Select, 20, 41 
internal fields, 85 
lengths, 30 
new symbols, 32 
playback timing, 90, 93 
playback volumes, 92, 93 
quintuplet, 30 
relocation, 44 
replacing rests, 84 
selecting, 36 
slur, 31, 93 
slurs, 116 
spacing, 44, 51, 132 
special noteheads, 31 
staccato, 31, 93 
stems, 86 
tenuto, 31, 93 
ties, 116 
ties, 31 
triplet, 30, 124 
tuplets, 30, 82, 124, 182, 183 
tuplets, 110 

Numbers 
Page, Bar, Tuplets, 199 

occasional unpitched material, 189 
octave transposition, 95 
OMR 

clef errors, 97 
corrections, 145, 146, 148 
integrated into Lime, 49, 145 
key signature errors, 98 
Next Rhythm Error, 69 
red rests, 57, 145, 147 
Show OMR Image, 72 

OMR of Image File, 49 
OMR of Scanner, 49 
Only in Score, 34, 113 
Open, 46 
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Optical Music Recognition, 47, 49, 145 
Option-click, 36, 37 
Options, 64 
page 

numbering, 65 
size, 51 
turns, 69 

Page 
new page, 71 

Page Menu, 69 
Page Setup, 53 
pallet files, 131 
Parameters, 40, 81, 103, 197 
Part extraction, 41, 67, 70, 136, 141 
part names, 59 
Parts and Voices, 27, 75, 126, 129, 155, 157 
paste, 23 

multiple paste, 23 
Paste 

Annotation, 41 
Multiple Paste, 41 
Music, 55 

percussion staff, 75, 96 
piano fingerings, 153 
piano music, 122, 152, 155 
piano tablature, 77, 158 
Piano Window, 18, 29 

keyboard equivalents, 63, 195 
moving, 33 

Piano Window Keys, 195 
pickup measures, 133 
pitch bend, 78 
Pitch Bend, 89 
Play Octave Higher, 95 
Play Octave Lower, 95 
playback, 90 
Playback 

Earlier, 93 
Higher, 93 
Later, 93 
Longer, 93 
Louder, 93 
Lower, 93 
Shorter, 93 
Softer, 93 

points, 51 
polytempo music, 189 
Position Lock, 107 
Previous Annotation, 105 
Previous Note, 80 
Previous Part Or Voice, 73 
Print, 53 

Rectangle, 53 
to postscript, 53 

Print Multiple, 54 
Print Setup, 53 
printing scores, 75 
problems with MIDI, 16 
Proportional Notation, 170 

quintuplets, 30, 124 
Quit, 54 
real-time input, 73 
Recompute Playback, 94 
Record, 73 
Recordare®, 47 
red rests, 69, 147 
rehearsal marks, 61, 65, 107 
reminder accidentals, 31, 56, 80 
repeated chords, 169 
repeats, 100, 171 
Repeats, 198 
Rest, 200 
Rest Drag, 44 
Rest Number, 201 
rests, 30 

beaming over, 153 
combine, 30, 138 
combine, 99 
Don't Combine Rest, 83 
hide, 83 
multi-rest, 83 
not printed, 83 
red rests, 145, 147 
red rests, 57 
Vert. placement, 44 
whole, 30, 83 
whole, 99 

Revert, 51 
Rulers, 37 
SATB system, 127, 159 
Save, 50 

Graphic, 50 
Previous Version, 50 

Save As, 50 
Template, 50 

scannd music 
red rests, 57 

scanned music, 47, 49, 145 
clef errors, 97 
corrections, 145, 146, 148 
integrated into Lime, 49, 145 
key signature errors, 98 
Next Rhytm Error, 69 
red rests, 145, 147 
Show OMR Image, 72 

Schenker, 168 
scores, 43, 75, 139, 143 
screen 

magic scrolling, 23, 28 
music keyboard, 29 
not up-to-date, 18 
options, 29 

Select Twain Source, 49 
selecting annotations, 36 

summary, 193 
selecting notes, 36, 80 

summary, 193 
SharpEye Music Reader®, 47, 49, 57, 145, 146 
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sheet music, 53 
Shift key, 19 
Shift-click, 62 
Shift-Copy Music, 56 
Shortcut Keys, 63 
shortcuts, 24, 195 
Show Accidental, 80 
Sibelius®, 47 
slur, 21, 31, 89, 93, 116 
Slur 

Hanging, 89 
Slurs, 201 
Softer, 92 
Sonata, 66, 196 
space/tab option, 22 
spacing, 51, 132 
Spacing, 200 
Special Accidentals, 81 
Split Page, 69 
staccato, 20, 31, 93 
Stack Vertically, 108 
staff 

cue, 75, 129, 161 
empty, 77 
number of staff lines, 149 
Parts and Voices, 75 
percussion, 149 
percussion, 96 

Staff Drag, 43, 77 
Staff Labels, 139 
Staff Lines, 200 
Staff Size Adjust, 107, 161 
Stem, 199 

Between Staves, 86 
Down, 86 
Menu, 86 
Slashed, 86 
Up, 86 

Stem Between Staves, 156 
Stems 

extended, 171 
stretching lines and curves, 37 
style, 37 
Styles, 105 
summary, 193 
swing eighth, 88 
symbols 

changing Lime’s symbols, 103 
examples for creating, 122 
finding symbols in fonts, 143 

synthesizer connections, 16 
System Bracket, 102 
Tab, 36 
tab/space option, 22 
tablature 

guitar, 76 
piano, 77, 158 

Tablature, 200 
Tablature String, 82 
tempo, 90, 188 
tempo markings, 39, 61, 143, 144 
tenuto, 31, 93 
text, 34 
Text Category, 106 
theory symbols, 127 
Thicker Middle, 35, 111 
tie, 89 
Tie 

Hanging, 89 
ties, 31, 116 
Ties, 201 
time signature, 188 
Time Signature, 71, 83, 99, 175, 177, 183, 184, 201 

above staff, 173 
above staff, 175 
changing, 175 
custom, 175 

Times, 106 
timing, 90, 93 
titles, 141 
Titles, 106 
Transpose Existing Notes, 98 
transposition, 27, 95, 97 
tremolo, 31, 88, 150 
Tremolo, 200 
Tremolo Beam, 88, 150 
triplets, 30, 65, 124 
Tufa, 15, 106, 196 
Tuning, 91 
tunings, 78, 90, 91 
Tuplet Bracket, 110 
tuplets, 65, 124 
Tuplets 

partial, 173 
tuplets within tuplets, 183 
TWAIN, 49 
Underlined, 106 
Unsighted Lime users, 54 
Vertical Lock, 112, 115 
voice 

highlight, 78 
selecting notes, 80, 137 
splitting voices, 148 
staff to print on, 75 

Voice 
Voice to Staff Above/Below, 77 

Voice Menu, 73 
Voice on Channel, 78 
Voice to Staff Above, 77 
Voice to Staff Below, 77 
whole rest, 30, 99 
word processors, 56 
zoom, 51 
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